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Introduction
EFI Technique software offers an end-to-end software solution from the point of sales through production to the
shipment of goods. It has the comprehensive capabilities of a world-class MIS software system, while fitting the
unique business processes of publication and commercial print companies. The solution’s comprehensive
capabilities are able to address the needs of print companies with complex operating environments such as
multi-site, multi-currency, multi-language and multi-product production processes.

Contact Information
EFI Support
Web Site:

https://customer.efi.com/support

UK Phone:

+ 44 (0) 1246-298085

US Phone:

+1-855-EFI-4HLP

E-mail: technique.support@efi.com
Regular USA Service Desk hours are 8:30 AM to 5:00 PM Eastern Time, Monday – Friday.
Regular European Service Desk hours are 8:30 AM to 5:00 PM Greenwich Mean Time (British Summer Time
during summer), Monday – Friday.
Note

For problems involving infrastructure (i.e., computers, networks, operating systems, backup software,
printers, third-party software, etc.), contact the appropriate vendor. EFI cannot support these types of
issues.

EFI Professional Services
UK Phone: + 44 (0) 113 3836000
EFI Professional Services can help you perform EFI software installations, upgrades, and updates. This group
can also help you implement, customize, and optimize your EFI software plus offer a range of training option.
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About This Guide
The EFI Technique Estimating system has the ability to provide quotations for Web Offset, Coldset, Sheetfed,
Gravure and Digital print, virtually any piece of finishing equipment as well as Print and Finishing outwork. The
complexity of the enquiry can range from a simple single style single quantity component to a multi-site, multistyle, multi-quantity, multi-product version quotation. All of this is encased in a truly unique and revolutionary
Route Based Estimating system that, after some initial configuration, makes the production of quotations fast and
accurate.
Estimates can be created directly in the application or in the Sales Enquiries application, and can be produced
for one off work (commercial), or from an agreed contract price list. When used as the basis for subsequent
order creation, it provides a base estimate to be able to compare to planned and actual costs.
The configuration of the data within the Maintenance application supports Estimating, Order Management,
Inventory and Production Scheduling applications.
This User Guide will provide details on:
•
•
•

Creating Sales Enquiries in MIS Console
Creation and calculation of estimates within the Estimating application (one off and from contract)
Creating estimates using Quick Pricer (commercial and contract)

This guide will not include configuration of the Estimating data. This information is included in the System Admin
for Estimating 5.4 User Guide.
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Workflow
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About the Estimating Setup in Technique
To set up Estimating, you need to configure settings located in several modules in EFI Technique:
•

Information Console > Tools > Application & Languages > Application settings

•

Information Console > Tools > Users & Profiles > Profile Groups

•

Estimating Maintenance

•

Estimating > Tools > Options

•

MIS Console

Set Up Sales Enquiries and Estimating
The following section provides details on the set up and configuration of Sales Enquiries and Estimating:
•

Configure the User Profiles for user access

•

Configure the Application Settings per site

•

Configure the Site, Resources, Outworkers, Locations, Materials and Miscellaneous content within
Estimating Maintenance

•

Tools > Options in Estimating

•

Customizing the display in Estimating

•

MIS Console > Maintenance > Enquiry Template

User Profiles
There are multiple profile options, which need to be considered when deciding the roles of users who will access
the application. Full lists of options are included within the System Admin for Estimating 5.4 User Guide.
Reference to specific profile options will be included throughout this guide when explaining the different
scenarios available to you.

Application Settings
Estimating has a number of Application Settings that control various aspects of the module’s operation. The
system administrator can maintain application Settings within either Information Console or MIS Console. Full
lists of the settings are included within the System Admin for Estimating 5.4 User Guide.
Reference to specific application settings will be included throughout this guide when explaining the different
scenarios available to you.

Estimating Maintenance
The Estimating application has a separate maintenance application for configuration purposes. The application
provides the means to configure Estimating in its environment to work with the Estimating, Order Management
and Planning, and Job Costing. For further information see the System Admin for Estimating 5.4 User Guide.
Note

The values and specific configurations set in the application should follow careful consideration of the
business process and workflows used in the company implementing the system. The decisions taken in
this part of the set-up process are key to the successful use of the associated applications and the
availability of meaningful information.
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Estimating > Tools > Options
You can define additional options from the Tools > Options menu. Options available enable you choose if you
want the application to prompt you when exiting the application.

Customizing the display in Estimating
You have the ability to customize the display by configuring certain profile options and tools within the orders list
views.

Adding columns to the enquiry list
You can customize your own display of the enquiry list, choosing which columns you wish to see, and any
filtering options you wish to apply. Any changes you make are saved against the your login.
To choose columns in the enquiry list
1.

With the cursor anywhere in the column headings, right click to open the shortcut menu:

2.

Click Field Chooser.

3.

A list of fields not currently displaying will appear.
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4.

Note

Click on the required column name and drag it into the heading toolbar. Insert arrows appear, to
indicate where the column will be placed.

The columns available for selection are pre-defined.

Removing columns from the enquiry list
To remove columns from the enquiry list
1.

With the cursor anywhere in the column headings, right click the mouse. A shortcut menu will appear:

2.

Select Field Chooser

3.

Select the column heading you wish to remove and drag it into the Field Chooser window.

Sorting columns
Sometimes you may want to see information sorted a particular way, for example, by estimator name or date
required.
To sort columns
1.

Click a column heading to sort information in the list by that column in ascending order. For example,
you may want the information sorted by the date the quotation letter is required.

2.

Click a column heading a second time to reverse the sort order.
Tip

A triangle in the column heading indicates whether the sort is ascending (a to z) or descending
(z to a).
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Changing the sequence of columns
You can move the columns to display in the order that is most useful to you.
To change the column sequence
1.

Select the column and drag to its new location within the enquiry list.

Using Group by
The enquiry list can be utilized as a To Do list by grouping by the column headings.
To group by a column heading
1.

With the cursor anywhere in the column headings, right click the mouse. A shortcut menu will appear:

2.

Select Toggle Group By. A gap will appear above the orders list.

3.

Drag the column heading into the gap.

4.

The enquiry list will now display based on the group. In the example below is grouped by Estimator.

5.

You can choose to expand or collapse the groups as required.

Adding Multiple Group by column headings
Following the process detailed above, continue selecting the column headings and drag into the group by
area.
In the example below the orders Estimator and then Date Required have grouped list.
The Group By Estimator has been collapsed and the date required of Last Week has been expanded.
As an estimator you can then view your own list of active orders based on when the quotation letter is
required.
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You are also able to sort the list when the column headings are placed in the group by area.

Collapse/Expand All
To expand or collapse the group options in one go
1.

With the cursor anywhere in the column headings, right click the mouse. A shortcut menu will appear:

2.

Select Expand All Groups to show the full list of orders, or,

3.

Select Collapse All Groups to hide the orders list per group.

Removing Group by column headings
To clear any group settings simply select the groups defined within the group by area and drag and position back
in the main column list where you now want the column to display.
Note

You can set whether to open the order list in collapsed view via an application setting (id 67) when

grouping is invoked.

Views
When you open Estimating there are four possible Views available.

An enquiry is either Active or Complete. An enquiry will appear in the Complete Enquiries view when it has been
entered as Complete. For further details, see the Marking an Enquiry as Complete chapter later in this guide.
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To navigate from one view to another, simply make the required selection.
Note

When using Search to find an enquiry, it will look through both views to find the results.

Active Enquiries will present a list of enquiries that are either being worked upon by an Estimator or have just
been received and no work has been done as yet.
Completed Enquiries will present a list of enquiries where prices have been produced and a quotation sent to the
client and the enquiry has been entered as complete.
Active RFQ’s will show a list of the current outstanding Outsource Procurement Enquiries where feedback and
pricing for print or finishing operations from Suppliers has not been received. For further details see the
Outsource Procurement chapter of this User Guide.
Complete RFQ’s will show a list of Outsource Procurement Enquiries where prices have been received from
suppliers and accepted by the Estimator for use within the estimate.
Note

Active and Complete RFQ’s is a licensed module.

Company indicators
The enquiry list can also display whether the customer is marked as a Gold, Silver or Bronze (as entered within
Company Management) account and this indicated by the appropriate color of star which appears next to the
customer name.
If the star is red this indicates that the customer is In Dispute (a check box is ticked against the company record
in Company Management). It does not prevent creation of an enquiry but the presence of the red star is a
constant alert to the you.

Terminology
To clarify the terminology used throughout this guide please note the following terminology:
•

Enquiry – is the specification of the product

•

Estimate – is the calculation of the specification

•

Revision Number – the estimate revision number

•

Quotation Letter – is the document that contains the pricing to be generated to be issued to the
customer

•

BOR – Bill of Routing

•

Commercial – a one off publication

•

Contract – an agreed set of prices for a set of agreed specifications

MIS Console
MIS Console provides you with the ability to create Sales Enquiries that are submitted to Estimating and the
configuration of the enquiry template and the ability to generate a Quick Price either based on the Estimating
standards or from a Contract Price List.

Creating a Sales Enquiry
A request for a quotation may come in several forms:
•

Direct from the customer to the Salesperson
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•

Direct from the customer to the Estimating team

•

Direct from the customer to the Production team (if they are already in contact for existing orders)

Once the enquiry detail has been received from the customer there are various methods that the enquiry can be
created:
•

As a one off (commercial) enquiry in MIS Console using the standard enquiry form

•

As a one off (commercial) enquiry in MIS Console using the RFE Template and Bill of Routing (BOR)

•

As an enquiry from a contract in MIS Console using the standard enquiry form

•

As an enquiry from a contract in MIS Console using the RFE Template and BOR

•

As a one off (commercial) enquiry in Estimating

•

As an enquiry from a contract in Estimating

In general, an enquiry received by the Salesperson is entered in MIS Console, however when the Estimating
team receives this, it is often entered directly in the Estimating application.
Note

New enquiries entered directly in the Estimating application will automatically populate the Sales
Enquiries module so that the salesperson can track progress and update the enquiry status as
appropriate.

Commercial Enquiry in Sales Enquiries, MIS Console
There are various ways an enquiry can be entered in MIS Console.
•

Quick menu toolbar that is available regardless of the page you are currently on.

•

Sales Enquiries > New > Commercial Enquiry

•

Company Management > Companies > Company record selected > New > New Enquiry
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•

Within the Enquiries section of a company record

•

Within the Enquiries section of a contact record

You then have the choice to enter the enquiry using either the Standard Enquiry form or using the Enquiry
template.

Standard Enquiry Form
After selecting to create a Commercial Enquiry the Enquiry Form New Enquiry Revision: 1 page will open.
The enquiry information entered is very similar regardless of the pricing (commercial or contract), but a one-off
enquiry will be used to explain the various elements of the enquiry form.
This page presents 7 tabs so that you can enter the enquiry specification. Dependent on the method chosen to
create the enquiry form above was selected, will have an effect of data that is automatically populated. For
example, if I create the enquiry with a contact record, the Salesperson, Company and Contact name will be
populated and the Company and Contact name will not be available for change. However, if I create the enquiry
from the quick menu toolbar, these fields will be blank for entry.
Note

Fields that are highlighted yellow require information to be entered and you will not be able to submit he
enquiry to Estimating if these are left blank.
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Enquiry Detail
The first set of information to be entered is referred to as the Enquiry Detail and contains the Customer detail and
Title of the product along with general information regarding the enquiry.

You enter the sector name for the enquiry in the Submit To field. This is particularly useful for multi-site users as
it ensures that the appropriate sector calculates the estimate and generates the quotation and there is no
duplication of quotations. This will default to the sector to which you belong as part of your user detail. If you
belong to a profile group that has access to all sectors, then you will be able to change this selection.
The Quote Required Date/Time, Follow Up Date, Finished Width and Finished Depth fields can be
populated with default data and entered within Application Settings for Sales Enquiries. Also, you have the ability
to state whether the Delivery Date for an enquiry is required by default. Dependent on how the Estimating
Standards are set up, the delivery date of a product may have pricing implications and therefore it may be
fundamental to any pricing policy as to the date that you enter.
It is also possible to define where the quotation is to be sent, for example, whether it is to be sent to the
Salesperson, the Customer or both and how it is to be sent, for example, via email, post or fax.
Note

This is for information purposes only.

If your organization wishes to know where the enquiry came from, you will need to enter the Source field. The
options available from the Source drop down field are maintained within the Maintenance in MIS Console.
You can enter the Currency for the enquiry. By default this will populate with the currency entered for application
setting id 11 for Sales Enquiries.
You can enter a user name in the Follow Up By field. This is particularly useful if a Customer Services
Representative enters the sales enquiry as it allows them to identify who should contact the customer once the
quotation has been sent to discuss further with the customer.
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The Request for Quote date can be entered that allows you to see when the enquiry was entered. It can be
different for each enquiry revision.
The Salesperson can be entered from a drop down list, however if the your user detail has been entered as a
salesperson, then your name will automatically appear within this field.
The Company name is available for selection from the drop down list and is dependent on the salesperson
selected. The Contact name is also dependent on who the salesperson is and they need to be linked within the
company and contact record within Company Management.
If the enquiry is for a new company who is not currently entered within Company Management, the Company
and Contact fields can be left as above with New Company and New contact entered. This allows you to submit
an enquiry without having to enter the details into Company Management and this is especially useful if the
quotation is needed urgently (for example the product is due to be delivered within a week). When no current
company or contact record is selected from the drop down list you are forced to enter this information and hence
record the information. The details can then be added to the Company Management system at a later date.

Note

This does not create a new contact in Company Management and a record will need to be entered prior
to the estimate being calculated.

The Finished Width and Depth are mandatory fields and should be the dimensions of the finished product. If,
for example, the product is 96pp + 4pp cover + 2pp order form and the 96pp + 4pp cover are 297 x 210mm but
the order form is 210 x 148mm, you should enter 297 x 210mm on the Enquiry Detail screen. Upon revising or
editing the enquiry and the production dimension changes, when the width and depth dimensions are changed
within the Enquiry Detail tab the Update Component Dimensions button becomes available. This is available
to enable the update of the individual component dimensions in one click.

Creating a Sales Enquiry | Estimating User Guide 5.4 l 21

The Title is a mandatory field, and the amount of header information provided is a policy decision, however all
the information entered within the enquiry is passed to the Estimator and therefore if more detailed information is
provided this ensures that a more accurate quotation can be generated. For example, if the product has a
Frequency of greater than one per year, it is useful for this information to be passed to the Estimator as it may
have a bearing on any pricing policy.
The Product Type and Product Code provides you with the ability to establish the type of work available in the
market place, whereas if the Data Available date is known this could have a bearing on the priority of the
enquiry and pricing decisions made.
The Further Information is a text box which provides you with the opportunity to elaborate any of the details
already defined, or allows you the ability to provide more information not included by the system fields provided.
Each of the tabs contains an area for Further Information and you can choose to have these pre-populated using
application setting ids 33, 34, 35, 36 for Sales Enquiries.

Quantities & Finishing
You need to enter the finishing style and quantity for the enquiry and this is done on the Qty & Fin tab.
The Technique system is not restricted to one finishing style and quantity per enquiry; in fact the number of
styles available is dependent on the Estimating Standards defined within Estimating Maintenance, but the
number of quantities which can be entered is not restricted.

To enter the Finishing Style for an enquiry, you need to select the Finishing Style and click Add. For the
Quantity, you need to enter a value and appropriate Run On and click Add.
Note

Default Quantity, Finishing Style and Packing can be entered within the application settings for Sales
Enquiries. Default settings are intended to make the number of duplicate entries reduced and hence
ease the speed of entry of an enquiry detail.
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Components
For each component you need to specify the pagination, ink, paper, pre press and press extra detail, however
only the paper detail is mandatory. An enquiry may consist of a single component and also multiple components,
however these can be managed within a single enquiry form.

The component Title should be a description of the Pagination and allows you to provide a more informative
description. If multiple components are to be added, the more descriptive the title, the more useful this will be for
the estimators when calculating the quotation.
The Process can be selected and can also be set as a default within application setting id 1 for Sales Enquiries.
If the component is to be supplied by the customer users can select the Supplied field. This ensures that the
correct number of sections is included in the finishing calculation when the enquiry is converted to an estimate
and also helps to determine the product weight for delivery calculations to be accurate.
The Width and Depth fields will populate with the data entered within the enquiry detail tab, however they can
be changed at component level, for example, if an order form is to be included within the product but it is not the
same as the enquiry trim size, A5 rather than A4.
Note

If the enquiry detail trim size is changed you will receive a prompt to either accept the changes to the
component trim size or keep them as originally entered.

If the component is a Cover then this needs to be selected as this can be crucial when calculating finishing
operations.
You also have the ability to state the type of cover Fold required so that the appropriate costs can be included in
the calculation in Estimating.
You can enter whether the component is to be Sheeted and you also have the ability to select a Finishing Style
for the component rather than using the finishing style entered on the Qty and Fin tab.
You can select the Bleed as this filters the possible configurations that become available within the Estimating
module.
If the enquiry is for a direct mail product, you can enter the number of Cells required for the component, or if the
component is based on Leaves of a page, you should select this field and then enter the Leaf Paginations.
If a particular component is to include plate changes you will need to select Versions. An additional text field will
open enabling you to enter the plate change requirement, for example, requires one 4/4 plate change.
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The Add and Copy buttons create multiple components. However, you need to be aware that when defining the
ink and paper for a component, that the appropriate component (tab) is highlighted to ensure that the correct ink
or paper is entered.

In the above example, the 4pp cover is the component highlighted and any ink, paper and/or pre-press details
etc., added will be attributed to this component (component 1). Within the component section each of the areas
includes a component column enabling you to ensure that the correct attributes are added to the appropriate
component.

Web Details
You must specify at least one web of paper for each component. If a component has multiple paper options
then a component must be created for each. You can, however, enter multiple web papers against a component
using Add or Copy.

To add a paper type to a component, select the Grade and subsequent Brand and Weight. If the customer is to
supply the paper then Supplied needs to be selected. This ensures that no paper cost is included in the
component calculation within Estimating, however the type and grammage is required as this is part of the
determining factor that selects and calculates the configurations for the component within the Estimating module.
If the customer has requested a custom paper type, that is not available for selection, you must select Custom.
This will convert both the Brand and Weight fields to be text fields so that you can enter the custom paper name
and grammage.
The Grades, Brands and Weights available for selection are maintained within Estimating Maintenance.
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Ink Details
You must enter the ink usage on a component-by-component basis. Defaults can be set up and maintained
within application setting ids 9 and 12 for Sales Enquiries regarding both the percentage coverage and Types
and Items.

You can Delete the ink types and amend the coverage from the default or add additional ink colors to be
included in the component calculation. To add additional ink, select the Type and Item and enter whether the
coverage is on the front or back of the page and the percentage coverage and then click Add.
The Component tab confirms which component the detail is being entered for.

Pre Press Operations
This section of the Components tab allows you to enter the required pre-press operation, for example, scanning,
proofing, etc.). The options available are based on the entry within Estimating Maintenance.

To ensure any prepress operation is included in the estimate calculation, you must select an Operation and its
Size. The pagination of the component will appear by default, however this can be amended if, for example,
proofs are only required for one of the Pages. You also have the ability to state the Quantity of proofs per page
are required. Once selected, you need to click Add to ensure the detail is saved for the component.

Press Extra Details
You can enter additional press extras such as perforating, scoring, personalization, coating, etc. The Press Extra
can be selected and the list of options is based on those entered in Estimating Maintenance. Click Add to save
the requirement to the component.
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Additional Finishing
This tab allows you to enter the information relating to Inserts, Delivery, Packing and any Additional Finishing.

You can enter the type and quantity of inserts. The list of inserts available is entered within Estimating
Maintenance.
You can enter the different delivery locations and percentage of the order for each location. Application setting id
14 for Sales Enquiries allows a delivery location to automatically populate this field.
You can enter the different packing types, materials and percentage of the order for each to be included in the
enquiry calculation. The list of packing types available is entered in Estimating Maintenance.
You can enter Additional Finishing operations for the order, for example, UV coating. The options available
are entered in Estimating Maintenance.
For each of the elements select the appropriate option and click Add to include in the enquiry.
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Custom Information
It is possible to enter custom information into the enquiry. For the Custom Info tab to be available, you must
create Custom fields within Estimating Maintenance and for the individual fields to be visible within the Custom
Info tab that the properties for the custom fields have Show in MIS Console selected.

Attachments
It is possible to add attachments to an enquiry, for example, the customer has sent an enquiry specification via a
document, and therefore you may prefer to enter the basic information into the enquiry form and attach the more
detailed requirements to the enquiry.

To attach a document, click Select, browse and to the where the document is currently saved and select and
then click Attach.

Generate Enquiry
When all the known enquiry details have been entered, click Submit to Estimating.
Mandatory fields are highlighted yellow. When you submit the enquiry to Estimating, if any of the mandatory
fields have not been completed you will be presented with a list of the fields missing and also a red * will appear
by the field where the data is missing.
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When the enquiry has been created the Enquiry Detail window will open on the page. You can choose to Edit,
Copy or Print from this page, or click Back to open the Enquiries page.
Note

Once a member of the Estimating team has opened the enquiry within the Estimating application, you
will only be able to Revise the enquiry.

RFE Template and Bill of Routing (BOR)
This functionality provides more advanced and quicker methods to create enquiries and is used to generate an
online Quick Price.
In order to use the more advanced capabilities, some configuration is required within Estimating Maintenance.
The functions are based around pre-defined templates using Product Templates that are configured in
Estimating Maintenance. For further details see the System Admin Guide for Estimating 5.4 User Guide.

Creating a Commercial Enquiry
Click New Enquiry and the various product templates that have been configured in your system will be
presented for you to make your selection.

The scroll bar at the bottom of the window allows you to view all product templates so that you can make your
selection.
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Click on the product required and the image will expand for you to make your product style selection. In the
example below, the Wire Stitched (separate cover) product template has been selected and we are now required
to choose a Style.

The Site will default to the site that your login profile is linked, to and, based on permissions you may be able to
select an alternative site. You are required to select the site that you wish for the quotation calculations to be
based upon.
You can choose to force calculations to be based on the Site selected, but if you have no preference ensure that
the Limit routing to site checkbox remains clear.
Note

If the enquiry is to be priced based on Contract pricing, rather than commercial standards, then you
must select the Price from contract check box. Based on system configuration this check box may or
may not be selected by default.

When you’ve made your selection, click Continue.
The enquiry will open on screen with any default information such as papers, inks, quantity etc., already entered.
The enquiry is split into three areas:
•

Header

•

Component and Web

•

Footer
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Header
The header information includes the overall enquiry specification such as the description, size, quantity and
dates. Any of these default values can be change at this point if required. In most cases, all that is required for
editing is the enquiry title.

Quantity
A key area for the enquiry is the ability to define the quantities requested by the customer. Click Define
Quantities to enter any additional customer requested quantities.

Enter additional Quantity and Run On and click Add.

The additional quantity will appear at the top with a Quantity No (number) of 2. Click Delete if you wish to remove
the additional quantity.
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Component and Web
The component information includes the pagination, trim size, ink and paper requirements for each component.

Further options may be made available within the enquiry depending on the selections entered with RFE
Template Maintenance, such as Press Extras, multiple webs etc.

Footer
The footer information contains options where you can enter additional information, such as packing, delivery
and ancillary information.

Packing
Click Define Packing to open a separate window for you to enter the customer’s requirements. Any default
packing requirements will already be included, however you can Delete these if necessary or add further
requirements.
Select the Packing and subsequent Item, ensuring that you also enter a Percentage value to be packed, click
Add to include the option in the calculation.
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Delivery
Click Define Deliveries to review or amend the delivery requirements to be included in the estimate calculation.

Enter the Delivery location, Percentage or Actual Qty (quantity) to be delivered to the location.
If your delivery calculations are based on Freight Rates, enter the number of Drops and Transport Type. The
Fuel Levy field will automatically populate, however you can amend this if required. If you wish to enter the IncoTerms for the delivery click on the Inco-Terms field and select the appropriate option.
Click Add to include the delivery to the enquiry.
If there are multiple quantities associated with the enquiry, by default, the delivery requirements will be set for All
quantities. However, if you have different delivery locations based on the quantity, select the For Qty field and
choose the quantity the delivery location is valid for. For example, if the enquiry contains two quantities, but
delivery to London is only required for the second quantity, enter London as the delivery location, enter the
percentage or actual quantity to be delivered. Click For Qty and choose the quantity for which the delivery
calculation is to be included.

Ancillaries
Another common option when entering an enquiry is the ability to include ancillary items. Click Define
Ancillaries to add any ancillary items that you wish to be included in the calculation. The ancillaries available will
be from a contract and so the options available to you will be based on the contract that has been entered as the
option for this product template.
In the following example, an ancillary has been added for a pattern perforation.

You can also choose to have the ancillary item included within the sell price, either as part of the Print, Finish
and Delivery values, or broken out on the quote letter (select the Separate check box), or as an extra in addition
to the total sell price (select the Optional check box). If you wish the ancillary item to be included more than
once, then enter the number of times it is to automatically be included within the No Of (number of) field.
Click Add to include the ancillary item within the enquiry.
The options available within the Enquiry can be configured by your system administrator to a certain extent and
may differ to the examples shown above. For further details see the System Admin for Estimating 5.4 User
Guide.

Submit to Estimating
Once the enquiry detail has been entered, there are two possible next steps.
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•

Submit to Estimating for calculation

•

Generate a Quick Pricer estimate (for further details see the Quick Pricer chapter later in this guide)

Note

The Quick Pricer option may not be available because you do not have the license, you belong to a
profile group that does not have the permission to create Quick Pricer estimates, or the enquiry content
may not fall within the parameters configured to enable a Quick Price calculation.

Should the Quick Price option not be available for calculation, click Submit to send the enquiry to the Estimating
department for price calculation.

Click Company and start typing in the name of the company record and select from the options presented to you,
click Contact, and Salesperson (if there is more than one associated with the contact) and click Submit.
The Enquiry Detail window will open providing a confirmation of the details entered and the enquiry number. You
can choose to Print or Copy the enquiry from this window if required.
After the enquiry has entered, click Revise and the custom enquiry form will open for you to make any necessary
changes.

Enquiry from a Contract in Sales Enquiries, MIS Console
There are various ways an enquiry from a contract can be entered in MIS Console.
•

Sales Enquiries > New > Contract Enquiry

•

Company Management > Companies > Company record selected > New > New Contract Enquiry
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•

Within the Enquiries section of a company record

•

Within the Enquiries section of a contact record

Dependent on where the enquiry has been created (in the above example this was created from the Companies
list) you will need to enter the Salesperson, (if you are entered into the system as a salesperson this field will be
populated with your name by default), and the Company for whom the enquiry is for.
Select whether the contract is a Standard or Custom. A standard contract is one that is available for all
customers. A custom contract is specifically available for the customer for which it has been entered within the
Contract Management module.
Select the Contract name and Contract Title from the options available.
Note

The Contract Title option is dependent on the Contract selected

Click Next to continue or Cancel to close the window and not save the changes. The standard Enquiry Form
window will open.
The standard enquiry form is the same format whether the enquiry is a one-off product or to be based upon a
contract price. However, for an enquiry based on a contract there are limitations on the options available as
entered within the contract.
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The first restriction is the enquiry trim size. The Width and Depth fields are unavailable to change as the
information is being entered is based on the contract title.
The second restriction is the finishing styles available for selection. You wil only be able to select finishing styles
that have been included in the contract.
The quantity is automatically populated from the contract title with the aim to assist the user in selecting the
number of copies that the enquiry is to be based upon.
A further restriction is apparent on the Components tab. Rather than being able to enter the pagination, ink,
paper details and pre press operations, you can only select the options available as they have been entered
within the contract.

You have to enter whether the component is a Cover or Text, whether the component is supplied to you preprinted, and then select the Component Title accordingly. You then enter the NLT (Number Like This), to
construct the total pagination.
Note

Pricing is based on how the product is constructed rather than on how it is produced, for example, if you
select to produce a 96pp product and select 3 x 32pps at the point of creation, the pricing will be based
upon this. However, if you choose to print it (at the point of selecting the route options in Estimating) as
6 x 16pps, it is only the cost that is being affected. The price will remain calculated at the 3 x 32pp’s
pricing.

Once the component title is added, you can then change the Title name and specify whether the component
includes versions etc.
Fields not available for editing will be greyed out.
Finally, the remaining options; packing, delivery, etc., are sourced from the contract pricing and hence any
additional requirements which are not included within the contract would need to be entered within the Further
Information text boxes.
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RFE Template
The easiest way to create an enquiry based on a contract using the RFE template and Product Templates, is to
select new enquiry from the quick access toolbar.

However, you can choose to create a new enquiry from a contract using the same methods as a commercial
enquiry, and select commercial enquiry rather than contract enquiry.
Click New Enquiry and the various product templates that have been configured in your system will be
presented for you to make your selection.

The scroll bar at the bottom of the window allows you to view all product templates so that you can make your
selection.
Click on the product required and the image will expand for you to make your product style selection. In the
example below, the Wire Stitched (separate cover) product template has been selected and we are now required
to choose a Style.

The Site will default to the site that your login profile is linked, to and, based on permissions you may be able to
select an alternative site. You are required to select the site that you wish for the quotation calculations to be
based upon.
You can choose to force calculations to be based on the Site selected, but if you have no preference ensure that
the Limit routing to site checkbox remains clear.
Ensure that the Price from contract checkbox is selected.
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When you’ve made your selection, click Continue.
Initially the application will display Contracts that have been entered in Contract Management as Standard Price
List, in other words they are available to all customers.

Field Name

Description

Show Standard
Contracts

If selected, you have the option to select from those contracts entered
as Standard Price List.

Show Company
Contracts

Enables you to select a customer who has a contract entered
specifically for them.

List of Contracts

Based on the parameters of the Enquiry Template chosen, lists the
possible contract title options for selection

Thumbnail of contract
title

Enables you to select the contract title upon which the enquiry is to be
created.

The finishing style of the chosen title must match the main style of the RFE template and BOR. If not then a
message will be displayed warning you that the title style does not match and that a matching title must be
chosen.
Upon choosing a valid title a check will be made to ensure all of the BOR finishing steps are covered in the
contract. If not a message will be displayed warning you that not all of the finishing steps exist in the contract and
that this must be resolved before the contract can be used.
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A warning message will also display if the contract has expired.
Note

It will be up to the system administrator to ensure BOR and Contract options are covered.

Choose the Contract Title (in the above example this Weekly Magazine), the enquiry form will open.

Component Selection Screen
You can now define the components.
For every component identified in the supporting BOR the system presents the selection form for the user to
match the contract print entries.
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For example: The supporting BOR has 2 components entered. One Cover and one Text.

Cover Selection
To display the selection screen click No. Pages.
Note

The label for the pagination field on your enquiry form may be different to this example.

Click No. Pages and the following window will open.

In the above example, there is only one option for a cover component.
Field Name
Include

Description
Select the required cover option. One option must be chosen. Only one option can
be checked.

Description

Read only description of the component in the contract.

pp

Read only pagination of the component in the contract.

Setup/Schedule

Read only Setup or Schedule price of the component.

Add’l set up

Read only Additional set up price of the component.

‘000/Run-on

Read only The price per ‘000 or Run-On price of the component.
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Text Selection
To display the component selection screen click No. Pages.

A list of contract text print entries are displayed ready for you to choose the required option or combination of
options. The number of text entries can be mixed and matched to create the required pagination. The chosen
entries will control the pricing of the quotation.

The chosen pagination does not have to match the BOR template.
Note

If no contract text print entries exist then a message is displayed explaining the Enquiry BOR cannot be
matched and the enquiry input is cancelled and you will be directed to the Enquiry Selection form.

The pricing columns displayed are dependent on whether the chosen title is priced as a MR/’000 or
Schedule/Run-On. If MR/’000 then the Setup and per ‘000 values are shown. If the pricing is based on
Schedule/Run-On then the Schedule and Run-On values are shown. If the title is entered as using Book Price
then no values are shown.
There are other differences between using the custom template form to create a commercial enquiry as opposed
to a contract enquiry.

Field Name
Pages
Supplied
Depth/Width
Define Pre Press

Description
Both the cover and text pagination values are unavailable and are set based on the
contract pagination options chosen.
The Supplied checkbox will be entered according to the related BOR.
The component trim size is set to the size entered against the chosen title.
If you wish to include pre press activities within the enquiry, the list presented to you
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will be limited to the pre-press options entered within the contract.
Note
Cover

The standard enquiry defaults set for commercial enquiries are only
added if they exist within the contract.

Cover check box entered according to the related BOR.

Fold

Entered according to the chosen contract print components.

Finishing Style

Entered according to the chosen contract print components.

Press Extras
Version Details
Ink

If you wish to include press extras within the enquiry, the list presented to you will
be limited to the press extra options entered within the contract.
This is only available if plate change options exist within the contract.
If you wish to amend ink within the enquiry, the list presented to you will be limited
to the ink options entered within the contract.

Paper Grade

If you wish to amend the paper grade for an enquiry, the list presented to you will be
limited to the paper grade options entered within the contract.

Paper Brand

If you wish to amend the paper brand within the enquiry, the list presented to you
will be limited to the paper brand options entered within the contract.

Paper GSM

If you wish to amend the paper grammage within the enquiry, the list presented to
you will be limited to the grammage options entered within the contract.

Paper Supplied
Paper Custom

This will be entered according to the chosen print component from the contract.
This will always be set to False. Custom paper entry is not permitted for contract
quotes.

Submit to Estimating
Once the enquiry detail has been entered, there are two possible next steps.
•

Submit to Estimating for calculation

•

Generate a Quick Pricer estimate (for further details see the Quick Pricer chapter later in this guide)

Click Submit to send the enquiry to the Estimating department for price calculation.

The Company and Contact name will be pre-selected as this has already been entered as part of the enquiry
creation process. However, if there is more than one salesperson associated to a contact you may need to select
the appropriate salesperson.
Click Submit to send the enquiry to the Estimating application.
The Enquiry Detail window will open providing a confirmation of the details entered and the enquiry number. You
can choose to Print or Copy the enquiry from this window if required.
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After the enquiry has entered, click Revise and the custom enquiry form will open for you to make any necessary
changes.

Commercial Enquiry in Estimating
As an alternative to creating an enquiry from MIS Console, you can also create an enquiry directly in Estimating.
This is usually the method adopted when a member of the Estimating team enters the enquiry. Any enquiry
created in Estimating will also appear in the Enquiry lists in MIS Console and can be managed via MIS Console.
There are three methods to create the enquiry:
•

New > Blank Enquiry

•

New > From Enquiry

•

New > From Contract

•

Copy

Create a Blank Enquiry
This method is used when no similar enquiry has been created previously. This method will create a new, empty
estimate record that will require you to enter all of the detail.

Create from Enquiry
This method is used when the estimate you wish to create is very similar to an estimate that has been created
previously, as it creates the new estimate based on the original estimate. This option can be used as an
alternative to searching and identifying a particular estimate and then selecting the Copy icon on the toolbar.
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Click New > From Enquiry and the Enquiry Search window will open.

You can search for an estimate based on Number, Customer or Title and when the original estimate was created
using the Date Created Filter options.
In the following example, the customer name has been entered and within the Search Results the list of
estimates created (in Date Created order) is displayed. The Date will default to two months previous to today’s
date. If you want to change the date filter, select either Before or Between. Enter the date filter (if you select
between a second date range will appear for you to enter), and click Refresh. The Search Results will update
accordingly.

Choose the Search Criteria.

Select the date range of
when the enquiry was
created.

Select the enquiry from the
Search Results.

When you have found the enquiry that you wish to use as a template for the new enquiry, you can either select
the enquiry from the Search Results window, and click OK, or double click the enquiry from the Search Results
window.
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The Copy Enquiry window will now open. You can now choose which elements of the original enquiry you wish
to copy to the new enquiry you are creating. By default all of the options will be selected. You can click Select
None to clear all selections and then select each individual option.

When you have made your selection, click Create to add the new enquiry. All selected detail will be copied and
the new enquiry will open so that you can begin the estimating process.
Note

You can create from Enquiry irrespective of how the original estimate was created. If the original
estimate was created from a contract, the newly created estimate will be based on the same contract,
therefore you will need to ensure that the contract pricing is still valid.

Click Cancel at any point to stop the creation process.

Create from Contract
This method is to be chosen when the estimate pricing is based on agreed Contract pricing rather than
calculating the sell price based on your estimating standards. For example, you may have an agreed contract
with a particular customer, and they’ve requested a quotation for an anniversary edition, that has a greater
pagination content that the regular edition, but the price is still to be calculated based on their agreed contract.
Obviously, this option can only be selected if the contract supports the specification of the enquiry.
When creating an estimate based upon a contract, the costs for the operations are calculated based on your
Estimating Maintenance standards.
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The Create Estimate From Contract window will open.

Enter the Contract and
corresponding Title.
This is no longer used and
can be ignored.

Select whether the estimate is to conform
to Standard or BOR finishing style.

By default, the Standard finishing style option will be selected and the finishing style entered within the contract
title will be included here. Any additional finishing operations that may be required will have to be entered
manually by the Estimator.
When the Contract Title is entered and the Standard style is selected, the Finishing Style, Product Template and
Style fields will auto-populate, however these are ignored.
If the BOR option is selected, the Finishing Style will populate with the Finishing Style, Product Template and
Style that has been entered in the contract title. The Product Template and Product Style selections are available
for you to change the Product Template and Style that you wish to employ for the calculation of this estimate.
Note

Using BOR allows for popular production methods to be entered with all the required Finishing
operations and materials already set within the Estimate that results in faster estimate calculations.

When you have finished making your selections, click Create to add the enquiry and the Enquiry Details window
will open.

Copy
You can create a new enquiry using the Copy option. The Copy icon is available on the toolbar when an existing
enquiry has been selected from the enquiry list. You can use the copy function for any enquiry that has already
been created, regardless of the status of the estimate.
The copy option will copy the estimate in the exact same state as the estimate from which it is being copied.
Select the enquiry that is to be used as a template for your new enquiry and click the Copy icon from the toolbar.
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You can now choose which elements of the original enquiry you wish to copy to the new enquiry you are
creating. By default all of the options will be selected. You can click Select None to clear all selections and then
select each individual option.

When you have made your selection, click Create to add the new enquiry. All selected detail will be copied and
the new enquiry will open so that you can begin the estimating process.
Note

You can create from Enquiry irrespective of how the original estimate was created. If the original
estimate was created from a contract, the newly created estimate will be based on the same contract,
therefore you will need to ensure that the contract pricing is still valid.

Click Cancel at any point to stop the creation process.

Enquiry List Views
Once the enquiry has been created, whether in MIS Console or Estimating, it is visible within the Sales Enquiries
module in MIS Console.
In MIS Console, click Sales Enquiries. There are two possible view lists that are available and these are based
on your user details.
If you are entered as a user who is not a salesperson, you will have three options: New, Pending and Complete.

Field Name
New
Pending
Complete

Description
Enquiries that have been submitted to Estimating.
Enquiries that have been submitted to Estimating and have been entered as
Complete by the estimator but the order is still available to be won.
Enquiries that have a status of either an order, dead or declined.
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If you are entered as a user who is a salesperson, you will have two options: Active and Complete.

Field Name
Active
Complete

Description
Either New or Pending Enquiries. Enquiries that have been submitted to Estimating
and the order is still available to be won.
Enquiries that have a status of either an order, dead or declined.

To view any of the enquiry lists, click either of the options. The list is ordered by the enquiry number with the
newest number at the top of the list.
You are able to group the list based on any of the column headings. Click the column heading and drag the field
into the area at the top of the list.

You can also filter the enquiries displayed by Salesperson, Company, Follow Up By, CSR (application setting id
21 for Sales Enquiries determines the visibility of this option), Status and Language. The speaking language of
the contact for who the enquiry is created determines the language option.
You can also search for an enquiry number, but the results returned will be dependent on the list that you are
currently viewing.
Finally, the lists can also be ordered in either ascending or descending order by clicking the column headings.
You can also access the Company and Contact record by clicking on the link on the enquiry list screen. It is also
possible to create an email by clicking the Salesperson or Estimator link.

Field Name
Check Box
Paperclip

Description
Enables you to select an enquiry for editing or revision as appropriate.
If an attachment has been added to the enquiry the paperclip icon will appear.

Creating a Sales Enquiry | Estimating User Guide 5.4 l 47

Priority

This allows users with appropriate permissions to be able to order the list of
enquiries so that those with a higher priority are dealt with first. All new enquiries
are created with a priority of NA and the priority can be updated after creation.
Click the Priority field and the Priority Form will open.

Enter the new priority and click Update to save the change and close the window.
Enq No
Revision

A system generated unique enquiry number. Click the enquiry number to view the
enquiry entered. The enquiry number cannot be changed.
Displays the revision number of the enquiry. When an enquiry is created, it will
automatically be assigned revision 1. Each time a new revision of the enquiry is
created this value will increment.

Submitted

The date the enquiry was submitted to the Estimating application.

Customer

The name of the company record entered for the enquiry.

Publication
Title
Contact
Salesperson
Delivery Date
Required
Completion
Date
Estimator

The title entered in the enquiry.
The contact name entered for the enquiry.
The name of the salesperson entered for the enquiry.
The date that the enquiry, if converted to an order, would be expected to be
delivered.
The date that the quotation letter needs to be sent to the customer.
The date that the enquiry was entered as complete within the Estimating
application.
The name of the estimator who has opened the enquiry within the Estimating
application.

Est No

The estimate number. This is a construction of the Enquiry number plus Revision
number. Click the estimate number to view the quotation letter. Based on the
permissions granted within your User Profile, you may only be able to view the
quotation when the enquiry has been entered as complete in the Estimating
application.

Status

The current status of the enquiry. For further details, see Changing the Status of an
Enquiry later in this chapter.

48 l EFI Technique 5.4 | Estimating User Guide

When you view either the New, Active or Pending views, you will notice that some of the fields are highlighted
with different colors. This is a visual aid to highlight the current position of the enquiry within its life cycle.
•

Red: Enquiry has been entered using the standard enquiry form and has not been converted to an
estimate.

•

Amber: Enquiry has been entered using the enquiry custom template form, or has been entered using
the standard enquiry form and has been converted to an estimate but has not been entered as
complete by the estimator.

•

Green: Enquiry has been converted to an estimate and has been entered as complete by the estimator.

Within the New or Active view, if the Delivery Date or Required dates entered are older than today’s date, these
fields will also be highlighted in red.

Changing the Status of an Enquiry
As mentioned above, the final column with an enquiry list view is Status and it is from here that you can enter
the status of an enquiry.

There are two methods to change the status of an enquiry:
1.

Click on the status field of the enquiry.

2.

Select the enquiry from the list and click Update Status from the toolbar.

For either process, the Update Status window will open

When a new enquiry is created the default status is Live, however this can be changed to a variety of status from
percentage of conversion to an order, to the reason why the enquiry did not convert to an order and even in
some cases declined, maybe because the product mix did not match the capabilities of the resources.
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The status of an enquiry is useful to maintain as it provides an indication of the type of work available for placing
in the marketplace and also allows commercial decisions to be made regarding pricing. For example, if all
enquiries have a status of Live when the information is viewed to see if there is any potential work available for a
date when current print capacity is low it is not possible to identify either potential orders or discount enquiries
which have a low probability of conversion to an order. By keeping the status of enquiries updated you have the
ability to target particular enquiries for conversion to orders and booked capacity.
As an alternative to the Live status, you can select a status that confirms the percentage chance of conversion to
an order. The options available are 25% Chance of conversion, 50% Chance of conversion and 90% Chance of
conversion.
Dependent on the new status selected a variety of additional information can be entered.

Enquiry
Status
Dead

Options
You can enter a Reason. Reason choices include:
Could not produce required specification
Lost to Competitor
Missed Tender Date
No agreement on payment terms
No Capacity
Not printed at all
Other
Out on Price
If the enquiry is lost to a competitor you can enter the name of the competitor (if
known). The list will be populated with company records that have been entered as
a competitor.
When the Dead status is selected, the enquiry will automatically move to the
Complete Enquiries view.

Declined

You can enter a Reason. Reason choices include:
Insufficient Capacity
Non Preferred Product
Previous Bad Customer
Too Large Print Run
Too Small Print Run
When the Declined status is selected, the enquiry will automatically move to the
Complete Enquiries view.

Order

For users who do not have the Technique Order Management module it is possible
to change the status of an enquiry to Order. If you do have the Order Management
module, then changing the status will open the Create Order window. For more
details see the Order Management 5.4 User Guide.
If the order is created in Order Management from the enquiry, the status of the
enquiry will automatically update to Order.
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Multiple Enquiry Status Update
You can also multi-select enquiries and change the status of the enquiries in one go.
Updating multiple enquiry status
1.

Select the enquiries that you wish to change the status for.

2.

Click Update Status on the toolbar.

3.

This following window will open.

4.

From within the above window you can amend your selection (or retain), and select the new Status to
be applied to the enquiries.

5.

Once the selection is complete, click Update and the status of the enquiries will update accordingly.

Assigning an Estimator
There are three ways that an enquiry is assigned to an estimator.
1.

A user opens the enquiry in the Estimating application

2.

An estimator is assigned to an enquiry

3.

An estimator is entered as the Default Estimator for the company record

Note

For the second and third option you have to be entered as an Estimator. Your system administrator will
need to adjust your User Details if your name does not appear in the list of options.

You can assign an estimator in either MIS Console or Estimating. To be able to assign an estimator to an enquiry
you need to have the appropriate permission within your user profile group, Members can assign estimators.

Assigning an Estimator in MIS Console
You can either assign the estimator on an enquiry-by-enquiry basis, or as the default estimator for a company
record.
Assigning an estimator to an enquiry
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1.

Open Enquiries (MIS Console > Sales Enquiries > New Enquiries).

2.

Click on the Estimator field.

3.

The Estimator window will open.

4.

Enter the Estimator name and click Update.

Assigning an estimator to a company record
1.

Open Companies (MIS Console > Company Management > Companies).

2.

Open the Company record.

3.

Click Edit and enter the Default Estimator.

4.

Save the changes to the company record.

5.

When a new enquiry is entered in MIS Console, the Default Estimator will automatically be assigned to
the enquiry.

Searching for an Enquiry in MIS Console
To search for an enquiry, enter the enquiry number in the Search field on the toolbar.

Click Exact Match if you only want the results to be available for that specific enquiry number. The Exact Match
button will remain available until you click it again to clear the filter. Press Enter if you want the results that
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contain the values entered. The results will be available within the Enquiries (Filtered) window regardless of the
enquiries view.
To clear the search, click in the Search field, click x and Press Enter.

Copying an Enquiry in MIS Console
It is possible to copy an existing enquiry (from any of the enquiry lists) to create a new enquiry. Select the
enquiry to be copied and click Copy from the toolbar. When the enquiry is submitted it will be generated with its
own unique enquiry number.

Editing / Revising an Enquiry in MIS Console
It is only possible to edit an enquiry if it has not been converted to an estimate and is only possible to revise an
enquiry if it has been converted to an estimate. The Edit or Revise buttons will automatically become available
dependent on whether the enquiry has been converted or not.
In both instances the enquiry will be available for amending however when revising there is an additional
requirement to enter details at the bottom of the enquiry form summarizing why the revision is required.

Changing the date of an enquiry in MIS Console
It is possible to change the dates of an enquiry if you have the appropriate permissions saved against the profile
group to which your user detail is entered. This allows you to change the dates without having to revise the
enquiry.
Select the enquiry from any of the enquiry views, and click Dates from the toolbar.
The Edit Dates window will open.

Change the dates as required and click OK to save the change and close the window.

Deleting an enquiry in MIS Console
It is possible to delete an enquiry if you have the appropriate permissions saved against the profile group to
which your user detail is entered.
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If permission is granted, then you can remove an enquiry (and any estimate calculations, quotations etc.)
regardless of its status, for example, there may be an order created from the estimate generated.
Removing an enquiry
Select the enquiry from any of the Enquiries view and click delete from the toolbar.

You will be asked to confirm the removal.
Important

Caution is advised when using this function, as you should not delete an enquiry that has a status
of Order as this will invalidate the order created from it.

Exporting an enquiry in MIS Console
You can export the list of enquiries within the application, if you have the appropriate permissions saved against
the profile group to which your user detail is entered, based on the view or any filters that you may have applied.
The data will be exported into Excel. For example, you may wish to export the list of enquiries per salesperson
that have a status of Live. Apply the filters and click Export from the toolbar.

Opening an Enquiry in Estimating
Dependent on how the enquiry was created, either from MIS Console or in Estimating, when the enquiry is
opened in Estimating, the content of the enquiry may differ. One major difference is that when you open an
enquiry that has been created in MIS Console or has been created in Estimating using the copy routine, the
enquiry information will automatically be entered.
The other major difference will be whether the enquiry has been created using the standard style or BOR format.
You can open an enquiry from either the Active or Completed Enquiries view in Estimating.
To open an existing enquiry you can either double click the enquiry number, or, select the enquiry and click
Open from the toolbar.
If an estimator has not been assigned, your user name will be entered as the Estimator.
Note

You do not need to be assigned as an Estimator within your User Details to open an enquiry.

The enquiry will open in a new tab.

Assigning an Estimator in Estimating
You can either assign the estimator on an enquiry-by-enquiry basis, or as the default estimator for a company
record.
Assigning an estimator to an enquiry
1.

Open Estimating and the Active Enquiries window will open.

2.

Select the Enquiry from the list and click Estimator from the toolbar.
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3.

The Assign Estimator window will open. Enter the Estimator name in the New field.

4.

Click OK to save the changes.

5.

The Estimator name will be updated in the Active Enquiries list.

Locked
When an estimator opens an enquiry it is locked by the system to prevent other estimators working on the
enquiry at the same time. When the estimator closes the enquiry the lock is removed. If the enquiry has not
been closed in the normal manner the lock will be left in place thus preventing the enquiry being opened by any
estimator other than the holder. Locks can happen from time to time such as network failures, PC crashes etc.
Should an enquiry be locked, you can use this option to un-lock an enquiry to allow other estimator to process it.

To unlock an enquiry you must have the appropriate permission. Select the required enquiry and click OK. This
will remove the lock against the enquiry.
The Unlock All can be used to release all listed enquiries.
Note

Caution should be used if unlocking enquiries that are actually open.

Assigning a contract to an Enquiry
When a commercial enquiry has been created it is still possible for you to assign a contract so that the pricing is
calculated based on a previously agreed set of prices. Usually this would be performed prior to calculation, but
this can also be done after an initial calculation.
Note

If you are changing the contract assigned to the estimate and the estimate has already been calculated,
the estimate version will need to be recalculated to include the pricing from the contract and title
entered.
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Select the enquiry from the enquiry list and click Assign Contract from the toolbar.

This will open the Assign Contract window.

Field Name
Current

Description
If a contract has already been assigned to the enquiry this will display the Contract
Name. If no contract has already been assigned this will display None. This field
cannot be changed.

New

Enter the name of the contract that is to be linked to the enquiry.

Title

Enter the title associated with the contract selected above.

Deleting an enquiry in Estimating
It is possible to delete an enquiry if you have the appropriate permissions saved against the profile group to
which your user detail is entered.
If permission is granted, then you can remove an enquiry (and any estimate calculations, quotations etc.)
regardless of its status, for example, there may be an order created from the estimate generated.
Removing an enquiry
Select the enquiry from the Active or Completed Enquiries view and click delete from the toolbar.

You will be asked to confirm the removal.
Important

Caution is advised when using this function, as you should not delete an enquiry that has a status
of Order as this will invalidate the order created from it.

Opening an enquiry created in MIS Console or using Copy
When the enquiry has been created in MIS Console, or has been created in Estimating using Copy (or New >
From Enquiry), the enquiry information will already be entered.
You can still amend the data entered, or add to it, indeed the enquiry may have been populated with the
minimum data, and the further notes fields within the enquiry have data entered informing you of additional
options, paginations etc., that the customer wants to be included in the quotation letter.
Note

Creating an enquiry in the Estimating application using Copy of New > From Enquiry, all information
from the source estimate will be copied and therefore, all calculations (if they’ve been performed) will
also be copied. However, if you change any of the elements, this will require a re-calculation.
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Before you can progress further, if any comments have been entered in the company record in MIS Console, the
Company Comments window will open.

By default, No will be highlighted, so Press Enter if you do not wish to view the comments at this time.
Note

You can view the comments associated with the company record at any time whilst the Enquiry is open.

Opening an enquiry from blank
Click New > From Blank.
The Enquiry Detail window will open.
Enquiry Header

Finishing Style

Quantity

Navigation bar

Component
Estimate Version

The Enquiry Detail window can be divided into six different areas to aid the input process:
•

Enquiry Header

•

Finishing Style

•

Quantity

•

Component

•

Navigation bar

•

Estimate Version
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Estimate Process Flow
The following diagram offers an example of how the estimate life cycle can progress through to the generation of
the quotation letter that can be sent to the customer.

Entering the Enquiry Details
The Enquiry Header information is where you enter the title of the product, and to whom the eventual quotation
letter is to be sent, the product trim size and delivery date. All of these entries may have an affect on pricing but
only some are mandatory fields.

Field Name
Title
Classificatio
n

Description
Enter the enquiry name.
Enter the product type and code for the enquiry. This may or may not be a mandatory
field based on whether application setting id 56 for Estimating is entered as 1 (True) or
0 (False). This is generally used for marketing and reporting purposes.
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Field Name
Customer

Description
Start typing the company name and the list will start to populate so that you can select
the appropriate record. For it to appear the company name needs to be entered within
the Company Management application as a customer or prospect and have a status of
Live.
When the company record has been entered, the contact and discount fields may
automatically populate, plus checks are made for company comments and whether the
company entered generally supplies paper. If the latter is true, the following Paper
Supplied window will open.

You can adjust the components, if, on this occasion and for this product the paper is to
be supplied by the printer.
If any comments have been entered in the company record in MIS Console, the
Company Comments window will open.

By default, No will be highlighted, so Press Enter if you do not wish to view the
comments at this time.
Note
Contact

You can view the comments associated with the company record at any
time whilst the Enquiry is open.

Enter the contact name from the list of available contacts, based on the company record
entered above.

Sales Rep

If only one salesperson is associated with the contact this field will automatically
populate upon selection of the contact. However, if more than one salesperson is
associated with the contact you will need to choose the appropriate representative.

Currency

By default your local currency will already be populated in this field. This is used in
conjunction with application setting id 3 for Estimating.
If you wish for the quotation letter to output prices based on a different currency then
the alternative currency should be entered in this field, along with the exchange rate.
Note

Your quotation letter template will need to support this option.

Rate

Enter the exchange rate if the currency selected in the field before is not your local
currency.

Frequency

By default this will be entered with Once Only. However, if you wish to amend the
frequency of the publication you can select an alternative but this is for information
purposes only and has not effect on the calculation.

Issues

Enter the number of issues for the chosen frequency. This will default to 1.
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Field Name
Depth /
Width /
(Height)

Description
By default the fields will automatically be populated with the values entered in
application setting ids 7 and 8 for Sales Enquiries. Also, if you have application setting
id 5 for Estimating entered as 1 (True), these fields will display as Width / Depth.
If changed when components exists you will receive a prompt asking whether to apply
to the components, however this message will only open if you Enter Tab after updating
the fields and if both depth and width have been changed.
You can enter the Height of the product (if application setting id 121 for Estimating is
entered as 1 (True)). This field is for information purposes only.

Units

If application setting id 121 for Estimating is entered as 0, you can enter the unit of
measurement for the Depth and Width.
By default, the units field will either be blank or set to your base measurement (MM for
Metric, Inches for Imperial). The selection allows you to enter a different measure type
for the finished product size. The product depth and width can then be defined using
this unit of measure type and will be converted back to your base measurement during
calculation.

Delivery
Date

Enter the date that the product is to be delivered to the customer. The number of days
(from today’s date) that is entered by default is determined by the value entered in
application setting id 28 for Sales Enquiries.
The date selected may have an effect on the cost and pricing of the estimate, as the
cost and sell rates are entered based on a date range for the resources entered.

Discount

Enter the percentage discount to be applied to the quotation letter. This is a rebate
discount, for example, the calculated value (based on the percentage rate entered) is
added to the sell price so that it can be taken off at invoice stage. This is most
commonly used when an agency is procuring the estimate on behalf of their customer
and enables any commission that they may receive (if the order is won) to be included
in the quotation letter.
The calculation of the discount is as follows:
Added Value only:
(Added Value / (100 - discount percentage)) * discount percentage

Apply to
Material

If a discount percentage has been entered you can specify whether the discount is to be
calculated based on the added value of the estimate or to include the material
calculations as well.
The calculation of the discount when materials are includes is as follows:
Apply to Material
(Total Sales / (100 - discount percentage)) * discount percentage

Mailed

Note

Select the check box if the product is to be mailed. When selected, the mailing date can
be entered for information purposes.

Changing the depth, width, issues or delivery date will reset the calculation process and require both the
components and estimate versions to be re-calculated.
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Finishing Styles
Using Standard Format
If an enquiry has been entered in MIS Console using the standard enquiry form, the Enquiry Detail window will
display the finishing style in the following format:

The main advantage of using this format is that you have the ability to create a single estimate with multiple
finishing styles.
Field Name

Description

Printed

Activated by default. You are unable to edit this field.

Bound

By default this will be selected. With selection, the estimate will include finishing operations
within the calculation.
If you do not want to include finishing operations, then you can clear this selection. You will
receive a message prompt informing you that there is no finishing when you calculate the
estimate version as a final validation that the entry is correct.

Finishing
Styles

Enter the finishing style to be included in the estimate. You can select multiple styles and an
estimate will be calculated for each style entered.
The finishing style selected by default is based on application setting id 6 for Sales Enquiries.
The options available within this list can now be chosen and sequenced to your preference.
For further details see the System Admin for Estimating 5.4 User Guide.
At least one finishing style must be selected to enable the calculation process.
Selecting a new style or de-selecting an existing style will reset the calculation process and
require both the components and estimate versions to be re-calculated.

Number of
stitches

Enter the number of stitches required for binding when the Wire Stitched finishing style is
selected. This option is only available for the Wire Stitched finishing style.

Other
(Custom)

If the product requires a finishing style that is not present in the list, select this check box.
The Enquiry Finishing Style window will open so that you can enter the finishing style
required.
To appear in this list the styles have to be entered within Estimating Maintenance >
Miscellaneous > Finishing Styles and must be entered as being a primary style.
If the check box is already selected, click … to open and review the selection made.
Like selecting a standard finishing style one or more custom styles can be selected for
calculation purposes.
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Field Name
Binders
overs

Description
To open the Binders Overs window, click Binders Overs. You can only select one of the
three options available.
No Binders Overs: Select this option if you do not want the estimate to include binders’ overs
value when calculating the gross sheet quantity.
Override Binders Overs: Select this option and enter the overs % value within the
Override/Additional Overs % field to replace the calculation of the default binders overs % in
the gross sheet calculation, with the value that you enter.
Additional Binders Overs: Select this option and enter the overs % value within the
Override/Additional Overs % field so that this value is added to the default binders overs % in
the gross sheet calculation.
Changing any aspect of the Binders Overs will reset the calculation process and require both
the components and estimate versions to be re-calculated.

Using BOR format
If an enquiry has been entered in MIS Console using the custom enquiry templates, the Enquiry Detail window
will display the finishing style in the following format:

If this format has been selected you can only include one finishing style within the estimate, however the main
advantage of this format is that any pre-defined finishing operations included within the Product Style will already
be included within the estimate version, therefore the minimum amount of change will be required.
Field Name

Description

Finishing
Style

Enter the finishing style for the product. This will filter the list of options available for the
Product Template and Product Style.

Product
Template

Enter the second level filter of templates linked to a finishing style.

Product
Style

Enter the third level filter of product style to build the estimate from. This selection determines
the default component and finishing operations requirement.

Build
Routing

After entering the above BOR, click Build Routing to create the components and estimate
version as entered against the BOR within Estimating Maintenance.
Note

This step should only be done when the Enquiry Header and Quantity
information has been entered.
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Quantity
An enquiry can contain a single or unlimited multiple quantities. Each quantity has a numeric identifier that may
be linked to packing, delivery and ancillary options.

Field Name
Quantity

Description
Enter the quantity the customer has requested a quotation letter for. If application setting id
25 for Estimating has been entered as 1 (True), you enter 50 if the quantity requested is
50,000 copies. If the setting is 0 (False), then you enter 50000.
The value entered in application setting id 5 for Sales Enquiries will populate the first quantity
and any subsequently added quantities.

Run On

Enter the run on quantity to be estimated. Each estimate quantity can have a different run on
value entered if required, for example a quantity of 50,000 copies may have a run on of 1,000
copies, whereas a quantity of 500,000 copies may have a run on of 10,000 copies.
The value entered in application setting id 4 for Sales Enquiries will populate the first and any
subsequently added run ons.

MR + Price
per M

When the check box is selected the costing and pricing data is output to the XML file in a
particular format for subsequent inclusion on the quotation letter. If you wish to use this
pricing method you will need to ensure that your quotation letter template is able to support
this.
Selection of this check box will also make the Versions check box for a component
unavailable.

Add

Click Add to create a new line entry for an additional quantity.
You can also add multiple quantities by double clicking in the space below the existing
quantity entries.

Remove

Note

Click Remove to delete a quantity entry.

Changing either the quantity or run-on or adding or removing a quantity will reset the calculation
process and require both the components and estimate versions to be recalculated.

Components
Components are print related elements that are to be included in an estimate and quotation letter. Multiple
components can be created within an estimate and once calculated, can be used as selections across many
different estimate versions and subsequently pricing options that you may wish to provide to your client.
Calculate once, use many times. For example, your client may wish to have a quotation provided based on a 4pp
cover + 48pp text, or 4pp cover + 56pp text, or 4pp cover and 64pp text. If, in this example, the 4pp cover is
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identical for all three options, then you only need to enter the 4pp cover component once and it can be selected
for each estimate version that you will create.
The print component area contains all of the information needed to be able to calculate an accurate route for
printing the component either as a single section or across many sections. For example, a 16pp component may
calculate and offer routes as a single 16pp or as 2 x 8pp, 4 x 4pp, 8 x 2pp, or 12pp+4pp. As long as you can print
these pagination section options and have the section breakdowns available for the component pagination, the
Estimating application will calculate and offer them to you for selection.
The idea is that you can have one component that may include multiple print sections as long as they all require
the same ink, trim size and paper requirements.

For a Standard style estimate you will need to add the components by clicking Add or Copy. The component
information will be blank with the exception of the Depth and Width fields that will automatically populate with the
dimensions entered within the Enquiry Header area of the window. If you wish to delete a component, click on
the component tab and click Remove.
For a BOR style estimate, click Build Routing. Instantly, you will be asked to confirm that you wish to proceed
and reminded that any existing component information will be lost, if you continue.

Click OK and the Available Sections window will open.

The pagination is offered based on the values entered within Estimating Maintenance > Miscellaneous >
Finishing Styles > Product Template > Product Style > Component. In the above example this is 1 x 4pp cover
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and 1 x 96pp component. If the pagination that the customer has requested is different to the default you can
change the pagination within this window.
Note

You can still change the pagination after the components have been created.

When configuring the BOR product in Estimating Maintenance, you can enter that Cell changes are required. As
a consequence, when you build the components in Estimating, if cells are required, the application will open a
message window asking you to enter the number of cells required for each item entered within the template as
requiring cell details.
Operations Requiring Cell Changes will only be available if the BOR template has been entered where the
finishing operations are entered as requiring cell change information. By entering the cell values at this point
against the finishing operations, the cell value will automatically be set against the relevant finishing operation
without the need for you to enter these manually against each individual finishing operation.

Title
Enter the name of the component.

Pages
Enter the component pagination. This must be divisible by 2.

Prepress
1.

Click Prepress to open the Component Pre-Press Operations window.

2.

Enter the pre-press activities that are to be included in the calculation. Pre-press activities can be
included by default if application setting id 26 for Sales Enquiries have been entered, alternatively you
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can click Add and Remove to include additional items or remove as required.
3.

Click Default to reset the list to the default list of items.
Field Name

Description

Operation
Type

Select the pre-press activity from the list of options. The list is populated by entries included
in Estimating Maintenance. For further details see the System Admin for Estimating 5.4 User
Guide.

Sheet

This check box will become available if the pre-press activity is linked to a JDF Type that has
been entered as being based on sheets rather than individual pages. This can be overridden
and cleared/selected as required. For further details on JDF, see the System Admin for
Estimating 5.4 User Guide.

Size

Enter the size of the pre-press activity. The list is populated by entries included in Estimating
Maintenance. For further details see the System Admin for Estimating 5.4 User Guide.

Quantity
No. Pages

Enter the number of the pre-press activity required. The default is 1.
Enter the number of pages for which the pre-press activity is required. The default is the
pagination for the component.

Note

There is no limit to the number of Pre-Press item records that can be added.

Note

Changing the Pre-Press items will reset the calculation process for the component and estimate
version(s).

Depth / Width (millimeters for metric, inches for imperial)
Enter the trim size of the component. This is generally the same size as the enquiry header however it can be
different to the enquiry trim size, for example, the estimate may include the printing of an order form that is
smaller in size to the main product.

Supplied
On occasion, it is not necessary for you to calculate routes for producing a print component as this may be being
supplied to you. The Supplied Sections window allows you to enter information regarding how the component is
being supplied to you. Select the check box if the component is to be supplied to you pre-printed.
When the check box is selected, the Define button will become available. Click Define and the Supplied Sections
window will open.
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Click Add and, if the pagination and paper requirements have already been entered for the component the
values will automatically populate.

You can amend these values as appropriate by overriding the entries already entered or click Remove to delete
entries no longer required.
This information is necessary for calculation of the finishing operations. It could be a single entry as above or a
combination of separate elements. For example, 180pp component may be supplied as 10 x 16pp, 2 x 8pp and 1
x 4pp sections.

Field Name
Pagination
NLT

Description
Enter the number of pages included in the section.
(Number Like This): Enter the number of supplied sections, for example, you would enter 10
if the customer was supplying 10 x 16pp sections to form a 160pp component.

Weight

Enter the grammage of the supplied section. The application will use this weight when
calculating the component weight for delivery and packing requirements.

Caliper

Enter the caliper (in millimeters) of the paper. This can automatically populate based on the
paper already entered within Estimating Maintenance.

No Up

(Number Up): Enter the number of identical sections that will be produced on a sheet. This
will affect the finishing calculations.

Click OK to close the window. The application will check the total pagination entered against that of the
component and warn if they do not match. At this point you can either resolve the discrepancy or select to
change the component pagination to match the entered detail.

Cover
Select this check box if the component is a cover. This is particularly important for the calculation of finishing
operations and if undefined, could cause potential problems if the estimate is used to create an order in the
Order Management application.

Fold Style
Enter the fold style for the component, for example, a 6pp cover component may require a gatefold fold style
rather than section. The fold styles available are entered in Estimating Maintenance. It has particular relevance
when used in conjunction with Open Size.

Sheeted
Select the check box if you know prior to calculation that the component is to be sheeted off press or produced
sheet fed. This will prevent any folded inline or press finished routes from being calculated and offered as
production options.

Finish
By default the finishing style for the enquiry will populate this field.
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However, you can select a different finishing style. You may choose to do this if you do not have a print
configuration entered in Estimating Maintenance that supports the finishing style entered for the enquiry and the
component specification, or the component is to be press finished for subsequent insertion into a wire stitched or
perfect bound product.

Versions
Select the check box if you want to enter any plate change information to the component calculation.

When the check box is selected the Define button will become available. Click Define to open the Component
Plate Changes window.

Versions are defined on a quantity by quantity basis. For example, if more than one quantity has been entered
then different versions can be specified for each quantity.
The version information can be entered using two different methods.
1.

Definitive version detail and quantities are known.

2.

The only thing known, is the number of versions and plates to be changed, the quantity split is
unknown.

Example 1
In the example below, four versions are required and the quantity split and number of plates changing between
each version is known in advance. This information can be entered using four separate line entries as follows.
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st

1 Version – North – 21,000 copies – 4/4 plate change – As this is the first line entry, the number of plates (No
Plates field) is set to zero as this is assumed to be using the base set of plates that will be calculated by default.
2

nd

Version – South – 12,000 copies – 4/0 plate change

rd

3 Version – East – 7,500 copies – 1/1 plate change
th

4 Version – West – 9,500 copies – 4/4 plate change
When calculated the application will automatically account for the extra plates required, introduce the required
extra follow on make readies and wash up’s and calculate the press speed on the quantity for each version.
Example 2
In the example below, 4 versions have been specified but the detail is not known. Each version comprises of a
4/4 plate change.

When calculated the application will automatically account for the extra plates required, introduce the required
extra follow on make readies and wash up’s. This time though because the quantity breaks are not known the
system will average the quantity for the press speed calculation.

Field Name
Quantity
Range
Add
ID

Description
You can enter version information for each quantity range. Click the field to choose your
suggestion.
Click Add to create a line entry. You can add multiple line entries before entering the
individual version information.
This is the unique version identifier and can be up to four characters in length. DEF is
Default.
If you enter an ID greater than four characters the application will concatenate the entry to
four characters.

Description
Quantity

Enter the version description.
Enter the quantity for that version. The first entry will default to the value entered within
application setting id 5 for Sales Enquiries. Subsequent entries will default to 0.
The sum of the version quantities must equal the selected quantity before the form can be
closed. If they do not match then the Total will go red.

Plates Front

Enter the number of plates that will change on the front of the web.
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Field Name

Description

Plates Back

Enter the number of plates that will change on the back of the web.

No Versions

Enter the number of changes to the component.

No Plates

Enter the number of extra plates that will be required.
The number of extra plates is calculated based on the number of plates required on the front
and back of the web and the number of versions entered. This can be overwritten if required.
For example, if four versions are entered and each version attracts 4/4 plates, then the
number of extra plates is calculated as:
No Plates = (number of versions – 1)* (Plates Front + Plates Back)
= (4/1) * (4+4)
= 24

No Pages

Enter the number of pages that will change. This value has no effect on the calculation.

All Routes

If selected, the plate change calculation is applied to all printable components. For example,
if a 24pp section is produced as 1 x 16pp + 1 x 8pp and the All Routes check box is selected,
then the version information will be applied to both 16pp and 8pp independently. If the check
box is clear, then the plate changes are only applied to the first printable section; the 16pp,
and not the 8pp.

Grain
For Sheetfed and Gravure calculations only. Select the preferred grain direction. For sheetfed routes, when the
routes are calculated and made available for selection, the grain direction of the sheet will be displayed. For
gravure, the grain direction selection will filter the routes calculated and offered for selection.

Bought In (RFQ)
Note

Bought In is a licensed module and so may not be available.

At both Press Component and Finishing Operation levels, Estimating supports the ability to create and send out
Outwork enquiries to suppliers directly from within an Estimate.
Using a combination of the Estimating application, Technique Email functions and Supplier Portal, enquiries can
be sent to suppliers via an email notification and online Supplier Portal. At the point that an enquiry is selected to
be sent, the chosen suppliers will receive a pre-formatted enquiry form detailing all of the information entered by
the estimator. Once they have calculated their prices, using the Supplier Portal, the supplier can enter their
prices against the enquiry record and submit them directly back in to the Estimate.
There is no need for the estimator to receive emails with pricing information, Estimating will receive all responses
via the Supplier Portal and present them to the Estimator to review. Enquiries can be sent to one or many
suppliers and when prices are returned, the Estimator can select which supplier prices they wish to use within
the Estimate.
Requesting an outwork price for a print component
Validation ensures that all component details required are defined and committed before a request for quote
(RFQ) can be made for a press component. These include Pagination, Paper details, Component dimensions
and ink definition.

70 l EFI Technique 5.4 | Estimating User Guide

1.

Select the Bought In check box and click Define to open the Bought In Details window.

2.

Select Template. The list of options are entered in Estimating Maintenance and the choices offered to
you will be specific for print components.

3.

Estimating will try and populate as much information as possible based on the selections already
entered against the component. However, this information can be overtyped or any fields not populated
with information can be edited directly within the form. The fields within the Enquiry are intended to be
typical of the information that you would provide to a Supplier when asking them to quote for work.

4.

Enter all the information required. There is an option to override this system generated default quantity,
whilst retaining the link to the quantity band. You can also enter the actual quantity requirement,
allowing for Binders Overs % (Overs %).
Note

If you have previously entered a component quantity override, this quantity will be included
rather than the enquiry quantity.

5.

Click Supplier Allocations / Responses View to manage who will be sent the RFQ.

6.

Default suppliers who can produce the type of work required will automatically be included (see above).
These can either be removed to send to specific suppliers only or left with a view to sending the enquiry
to them all.

7.

Click Add and Remove to either add additional suppliers or remove suppliers from the list.
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8.

Double click on any supplier entry to allow you to enter additional notation to be included in the enquiry.

9.

If the same note should be included to all selected suppliers, click Apply Notes to All.

10. Select the supplied and click Send if you only wish for the request to go to one supplier. Click Send All
if the enquiry is to go to multiple suppliers. The status for each supplier will be updated.
11. Once an RFQ has been submitted you are no longer able to change any of the component details which
were included within the RFQ.
Note

When prices are returned from the suppliers and you select the option you want to use, the price will be
saved only against the component/operation from where the Bought In options was selected. For
example, if the selection is made against a print component, the prices received from the supplier will
only be available for that component.

At this point, the enquiry is waiting for the supplier to respond through the Supplier Portal and provide their
pricing information. You can track the status of an RFQ from the Active RFQ’s view.
Receiving prices for a print component from suppliers using Bought In
When the suppliers have responded to your quotation request this will be visible in the Active RFQ view in
Estimating and within the Bought In Details within the actual estimate.
1.

To open the Bought In Details window from the Active RFQs view, double click the RFQ, or alternative,
click Define next to the Bought In check box for the estimate component.

2.

Double click the Supplier line entry to view any attachments included.
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3.

Click Attachments and select the document to open.

4.

Click OK to close the window and return back to supplier line entry.

5.

Click Review Pricing.

6.

The Supplier Responses window will open.

7.

Click Accept to confirm the pricing. The Status will update to Accepted. All other requests will now
have a status of Cancelled.

8.

If you subsequently receive another response from a different supplier and choose to accept the new
quote, the original quote that had previously been accepted will now have a status of Cancelled.
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9.

Click OK to close the window and Close to return to the Bought In Details window.

10. Click OK to close and return to the Enquiry Detail window.
11. The component tab will turn to green to indicate a successful calculation.

For information relating to the Supplier Portal, refer to the MIS Console User Guide.

CTP
No longer used.

Bleed
Select the bleed check box if the component will color bleed.
The routes calculated and offered for selection will be filtered based on this selection.

Leaves
Select the check box if the component that you are entering is to produce a note pad. You enter the total number
of pages within the pagination field, for example 100, select the Leaves check box and enter 50 as per the
example below.

The application will calculate the routes based on 2pp configurations.

Open Size
Open Size allows for the flat depth and width of the print component to be entered either using the Depth and
Width fields just below or by enter the pages within Open Size window that will become available when the Open
Size check box is selected.
Using Open Size, Estimating will no longer calculate based on press configurations that match the pagination of
the component. Instead it will refer to generic 2pp configurations (entered in Estimating Maintenance) where the
minimum and maximum sizes match the flat size of the component.
When the Open Size check box is selected, the Define button becomes available. However, if a flat size is all
that is required, this can be entered directly in to the Depth and Width fields.

By default, the application will try to provide you with the total flat size of the product using a combination of the
component pagination, the fold style and page size. This is achieved using JDF Fold catalogs (these can be
used even if JDF interfacing with a Pre Press system is not being used). For further details see the System
Admin for Estimating 5.4 User Guide.
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As part of the open size that Estimating is trying to determine for you, any trim allowances required for the
finishing style of the product will also be included.
If there aren’t any JDF Fold Catalogs entered, the Open Size Depth and Width will default to the component
page size plus trim allowances.
Entering individual page/panel sizes.
1.

Select the Open Size checkbox, and click Define to open the Open Size window.

2.

The Open Depth and Open Width fields update in real time based on the information entered in to the
Open Size window. The example above makes the assumption that each page is of size 297 x 210mm
and the flat size is made up of (2 x 297) x (4 x 210mm) i.e. 594 x 840mm.

3.

If this product was to be roll folded, page/panel size may need to be adjusted so that the product can be
folded with each page/panel sitting flat. This can easily be achieved by simply overtyping the panel size
in to the relevant fields as shown below.
Below is an example of how a 6pp Roll Folded product could be entered. Each panel being one of the
pages with the page width adjusted to account for the roll folding element.

4.

Enter the Spine width if the flat size being entered is a cover for, say, a perfect bound book. The Spine
Width can be used to add to the open width by entering the depth of width of the spine required.

5.

If the Open Size is specific to a Web, for example, when using Multi Web/Web Paper Definition, you can
enter the web paper definition for a specific web by entering the appropriate Web No.
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Example 1 – Single web 8 pages to view (note the Panels Down and Panels Across specification)

Example 2 – Two Webs. Web 1 - 8 pages to view. Web 2 – 4 pages to view.

When entering Open Size by Web, additional webs can be added without the need for them to be configured first
of all against the Component Paper area (see Web Details chapter later in this guide).
To add an entry for a new web, click Add Web… as below in the Web No. field.

When closing the window where multiple webs have been entered, a warning will be presented to advise that this
will overwrite any current web definitions previously entered. You can select to cancel at this point. If you confirm
to overwrite the existing web definitions, the component area will update the web detail as entered in the Open
Size window.
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Below, a component has Open Size defined across multiple webs. The web definition area has updated to match
the number of webs. The total pagination of the component has updated as has the pagination and page size at
web level.

Within the Open Size window you can also include Calculation Groups and Methods.
These can be used to automatically calculate the open size by making the appropriate selections in the Group
and Method fields for the type of product. This does require setup to be entered in Estimating Maintenance
before this can be used. For further details refer to the System Admin for 5.4 Estimating User Guide.

If you enter the panel dimensions or Calculation Methods within the Open Size window against the component, a
yellow triangle-warning symbol will display within the Enquiry Detail window, informing you, or anyone viewing
the estimate, that an entry exists.

Binding Lap
Based on the finishing style selected within the enquiry and its configuration within Estimating Maintenance, the
Binding Lap check box will, by default either be selected or not. For example, within Estimating Maintenance the
wire stitching finishing style is entered as requiring a Binding Lap. By default, when the enquiry is created for a
product that is for this finishing style, Estimating will automatically select the Binding Lap check box.
As a consequence, the lap allowance from the trim values entered in Estimating Maintenance will be included in
the calculation process when determining the page size required.
Note

If a finishing style requires a lap and you clear the Binding Lap check box for the print component in
Estimating, the calculations will ignore the lap allowance entered against the finishing style.

Cells
Allows the Data Cell number to be entered for the selected print component. Within Estimating Maintenance, the
background data for Data Cells can be entred as an amount of set up time per Data Cell, the number of MakeReady sheets per Data Cell as well as the Sell Price per Data Cell.
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The value entered in the Cell field at Component level will simply multiply the value by the set up against the
relevant press resource within Estimating Maintenance. During route calculation selection, double clicking on a
calculated route price will open the Route Cost Breakdown where the calculated Data Cell values can be seen.
Within the Re-Price screen, the values calculated for the Data Cells can be adjusted if required.

Ink
Ink is entered at web level and any newly created enquiry will default to the ink and coverage as entered in
application setting id 12 for Sales Enquiries, or, if the enquiry is created using BOR, the ink and coverage will
inherit the values entered within the BOR Component Defaults.

You can manage the number of inks and coverage per component or web. Click Define to open the Materials for
Component window.

Click Add to create a new line entry for additional ink. Click Remove to delete ink. Click Default to reset the inks.
This will reset the ink coverage to the default entered within application setting id 12 for Sales Enquiries.
You can also enter custom ink allowing for specific PMS references to be included in the calculation and
consequently the quotation letter. To be able to do this you need to ensure that ink is entered in Estimating
Maintenance and has been marked as custom ink.

The cost, mark up and price can be entered for a custom ink.
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Field Name
Ink Type
Description
Custom
Name
Cost
MU

Description
Select the ink type from the list entered in Estimating Maintenance > Miscellaneous >
Material.
Select the ink item associated with the chosen type.
Enter the custom ink name. This is the name that will appear on the quotation letter.
Ink cost per Unit of Measure. You can type this value into this field if the ink has been entered
as a custom ink within Estimating Maintenance > Miscellaneous > Material.
Enter the ink mark up %. This will default to the mark up % specified against the chosen ink
item and you can overtype this value for custom ink.

Price

Ink price per Unit of Measure. This will default to the cost + mark up % value specified
against the chosen ink item and you can overtype this value for custom ink.

UOP

This will display the Unit Of Purchase. The application defaults to the UOP entered against
the chosen ink item in Estimating Maintenance > Miscellaneous > Material.

Cols. F

Select the check box if the ink is to be included on the front of the sheet.

Cols. B

Select the check box if the ink is to be included on the back of the sheet.

Cov. %

Enter the average percentage coverage per page. If this is changed to 0 then no cost/price
will calculated for the color. This will default to the coverage entered within the BOR template,
or if a standard style format is being used, application setting id 9 or 18, 19, and 20 for Sales
Enquiries will be entered by default.

When the window is closed, the total number of colors front and back entered for the component / web, will be
displayed.

Paper
For each component (or web), you can enter the paper upon which the component is to be printed. If you’ve
entered a default paper within the BOR template in Estimating Maintenance this will automatically populate,
however you may have chosen to leave the paper details blank, forcing you to enter all of the paper on an
estimate-by-estimate basis.

If you need to add the paper or change to that which has already been entered, click Paper Grade and choose
from the list of options. Click Brand if a specific brand of paper has been requested as being included in the
estimate, and finally, enter the grammage (gsm). If the brand or grammage fields are blank you have two
options:
1.

Contact with your system administrator to have them added into Estimating Maintenance.

2.

Enter a custom paper.
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The Caliper field will populate with the value entered in Estimating Maintenance for the paper grammage that
you have selected. This will only display if application setting id 112 for Estimating is entered as 1 (True).
Note

If you have application setting id 33 entered as 1 (True) and you wish to calculate speeds etc., based on
caliper, you need to ensure that all your configuration information entered in Estimating Maintenance is
based on caliper and not grammage.

Prices
You can also amend the cost of paper, and subsequently price. This is optional for paper that is available from
the lists, but is a requirement if you’re entering a custom paper.
To add or amend paper costs and prices click Prices.
The Paper Costs window will open.

Multiple entries can be added to enable the cost and price charged to be varied according to the amount of paper
required and or, process applied. For example, the web price per tonne could be varied from the sheet price per
tonne.
If your environment is configured for multi-site with different material costs/prices set against each site, these can
be viewed and amended by selecting the appropriate site using the Site field. When generating print routes, the
paper price levels will be applied for the site at which the press resource is located.
If any of the standard paper cost/pricing levels are changed in any way, the line entry will show with an indicator
in the Cust (custom) field.
Field Name
Unit of
Purchase

Description
Enter the unit of measure the paper cost/price relates to. The default unit will be the value
entered for the material within Estimating Maintenance.
If changed, the cost/price will then be calculated based on the chosen unit. For example, if by
default the paper has a cost/price in tonnes and a paper cost from a supplier has been given
in kilo’s, then the unit of measure can be changed and the cost per kilo entered.
When entering costs and prices for custom paper the Unit of Purchase will default to the
value entered within application setting id 72 for Estimating.

Site

Select the site to which the paper price applies. By default the site location associated with
your user detail will display.

This Site
Only

If you’re entering custom paper and you only wish for the costs and prices to be included in
the calculation for a particular site, you need to select the check box.
If application setting id 65 for Estimating is entered as 0 (False), then by default this check
box will be clear.
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Field Name

Description

Cust

(Custom.) This check box will automatically be selected if a standard price/cost has been
manually adjusted in any way.

Press

Enter the press type the paper entry is valid for. When a new line entry is added this will
default to ALL. The field will default to the same value that has been entered within
Estimating Maintenance > Miscellaneous > Material.

From

Enter the start range of the chosen unit of measure, the paper cost/price is valid for. If a new
range is added then this is set to the end of the previous range.

To

Enter the end range of the chosen unit of measure, the paper cost/price is valid for. If a new
range is added then this is set to the end of the previous range plus 1.

Cost

MU %
Price
Custom All
Default
Remove
Add

Enter the Cost per Unit of Purchase (UOP). The value entered must be greater than 0. If
changed, the price will be re-calculated based on the MU %.

Enter the mark Up percentage to be applied to the cost to calculate the price. If changed the
price will be re-calculated accordingly.
Enter the Price per UOP. If changed, the price will be re-calculated based on the MU %.
Click Custom All to manually enter all paper costs and prices.
Click Default to reset any paper costs and prices back to the standard levels.
Click Remove to delete a paper cost.
Click Add to create a new line entry.

Find Stock
This allows you to search through the actual Inventory Management stock codes and select stock codes to be
used within the Estimating calculation.
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Click Find to open the Find Stock window.

Within the Search Criteria area you can choose to enter the stock code, if known, or to make selections within
any of the other fields in order to locate the most suitable stock code. In the example below the Width and Depth
fields have values entered.
Click Find to display matching stock codes within Search Results for you to choose the stock code that you
would like to use.

If you wish for the Search Results to include stock that has been quarantined, select the Inc. Quarantine check
box. If you wish to clear the filter selection, click Reset.
Click the Use check box to select the preferred stock code and click OK.

Supplied Paper
If the customer is supplying the paper to you, select the Supplied check box. This will remove all paper costs
and subsequent prices from the component calculation.
Entering a Custom Paper
If the customer has requested a specific paper grade, brand and grammage that you do not have entered as a
generic paper in Estimating Maintenance > Miscellaneous > Material > Paper, you can enter a custom paper.
1.

Select the Custom check box. The Brand and gsm fields will clear. Enter the Brand and gsm. The
grade will still need selecting from the list of options available.
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2.

Click Prices to open the Paper Costs window. The Unit of Purchase will default to the value entered for
application setting id 72 for Estimating. The Site field will default to the site location associated with your
user detail will display. If you only wish for the costs and prices to be included in the calculation for a
particular site, you need to select the check box. If application setting id 65 for Estimating is entered as
0 (False), then by default this check box will be clear.

3.

Click Add and enter the Press Type, From, To, Cost / UOP and MU% fields. The Price will
automatically calculate (cost * mu%). You can overwrite the Price and the MU% field will update.

4.

Click OK to close the window.

Paper Finish
Enter the paper finish. By default the paper finish entered for the paper selected will display. The list of options
available are maintained within Estimating Maintenance > Miscellaneous > Paper Coatings.

Colour
This is a text field that allows you to enter the paper color if it needs to appear on the quotation letter.

Custom Web Width
If you wish for the paper requirements to calculate based on a specific web width you can enter the size (in
millimeters) within the Custom Web Width field. This will override any calculation made by the application.

Web Definition
The application supports the ability to enter multiple webs for heatset/coldset presses. This is to facilitate the
specification of different stocks and colors on each web.
For example, a requirement where the cover is on 100gsm WFA paper and is run on web 1 and the text on
60gsm LWC paper on web 2 two webs could be entered.
By default the application will create one default web. If all the webs are running the same stock and colors then
it is not necessary to create further webs.
Note

Application setting id 43 for Estimating will need to be entered as 1 (True) for this option to be available.

Below are some examples of how the web definition can be used.
Example 1. This would apply to sheetfed routes, single web routes or multi web routes where the paper, inks,
size specification etc., is common across all webs.

Example 2. This example has a component where there are two webs of the press, each web being printed on a
different stock and with different color combinations.
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Note

Single web routes and sheetfed routes will not be calculated when using this scenario.

Adding additional webs
1.

Click Add to create a second web. (Click Remove to delete additional webs.)

2.

The application will ask you if you wish to copy the default web. In this example the default web was
copied.

3.

Amend the pagination (Pages), Depth and Width, paper and ink as appropriate.

4.

Click Web 2.

5.

Amend the pagination, paper and ink as appropriate.

Note

The Default web cannot be removed.

Note

If entering multiple webs then matching press configurations must be entered in Estimating
Maintenance > Press > Configuration, to support such a route.
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Example 3. This component is for a 60pp printed on five webs with each web having a different color split,
pagination, paper grade, brand, GSM and page size.
Web 1 – 16pp, printed 4/1, Light Weight Coated 80gsm, Size 297 x 210mm

Web 2 - 16pp, printed 1/1, White Bond 90gsm, Size 210 x 148mm

Web 3 - 8pp, printed 4/4, Light Weight Coated 70gsm, Size 297 x 105mm

Web 4 - 4pp, printed 2/1, Light Weight Coated 65gsm, Size 297 x 210mm

Web 5 - 16pp, printed 5/5, Wood Free Coated Gloss 100gsm, Size 297 x 210mm

This particular example is quite an extreme scenario but does provide a good representation of what can
potentially be achieved using Web Definition.
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Flexibility to define inks, paper, pagination, page size, custom web widths etc., can all be set at web level if
required.
Providing there are press configurations defined within Estimating Maintenance that match the specification,
routes will be returned during Press Route Calculation.
It is important to note that, only press configurations with a matching number of webs will be considered during
route calculation. However, the sequence of the webs within the press configuration is not a strict parameter.
Using Example 3 above, this has been defined within a web sequence of 16pp, 16pp, 8pp, 4pp, 16pp. If press
configurations are present that match the paginations but the sequence is not the same, they will still be returned
as possible routes for selection.
For example, configurations entered in Estimating Maintenance, where the webs have been entered as follows
can still be returned for the above component.
16pp, 16pp, 16pp, 8pp, 4pp
or
4pp, 8pp, 16pp, 16pp, 16pp
or
4pp, 16pp, 16pp, 16pp, 8pp
Any sequence of webs can be calculated and offered providing the paginations, paper weights, size etc., are all
valid.

Overrides
At component level you have the ability to manually influence the calculation. This can be achieved using the
override options.

If any of the overrides are included against the component a yellow triangle-warning symbol will display informing
you, or anyone viewing the estimate, that overrides exist.

Quantity Overrides
Against each component the main quantity can be overwritten allowing for different quantities to be included in
the component calculation. For example, the main enquiry quantity may be 50,000 copies but the customer has
requested extra 25,000 copies of the cover, so you need to calculate the cost and price for 75,000 copies of the
cover.
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To enter a quantity override, select the component and click Quantity. This will open the Component Quantities
window.

When opened, you can see the Enquiry Quantity and the Component Quantity along with the quantity
number. By default the component quantity will match the enquiry quantity.
The Enquiry Quantity is for information purposes only, however you can change the Component Quantity. In the
example already stated, for the 50,000 enquiry quantity range we want to print 75,000 copies for the cover. To
achieve this, enter the required quantity within the Component Quantity field for the appropriate enquiry quantity
range.
If application setting id 25 for Estimating is entered as 1 (True), then you only need to enter the quantity per ‘000,
therefore in this example you would enter 75.
Click OK to accept the quantity and close the window.
Note

If you have already calculated the component and then enter a quantity override this will reset the
component calculation and invalidate any estimate version using the component.

Once the quantity override has been entered, the estimate process continues in the usual manner (whether from
a contract or an enquiry). However, when you come to the route selection you will note that within the route
selection window the component quantity is displayed with the enquiry quantity.

Wastage Override
By default when calculating the component the system will use the impression and paper wastage factors that
have been entered for the site and resources. However, you can override these values using the Wastage
option.
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Select the component and click Wastage to open the Component Detail window.

Enter the wastage values as required, that you wish to be included in the calculation rather than the values
entered within Estimating Maintenance.
The Binders Overs % entered within this window will be added to the binders overs value entered for the site in
Estimating Maintenance.
If you enter a Paper % value and also select Include Paper Waste in running then the wastage for the paper
will be included in the calculation of the gross impressions to go through the press.
If you select No Plates (material change) and No make ready then no pre press labor, plate costs, or press
make ready will be included in the route calculation.
You can also enter overrides relating to the calculation of make ready hours, press speed and trim allowances.
Note

If you have already calculated the component and then enter a wastage override this will reset the
component calculation and invalidate any estimate version using the component.

Note

Any overrides entered within this window will apply to all routes during the calculation regardless of
press type, configuration etc. We would suggest that manual routing also be entered when using the
wastage overrides so that only specific options are calculated and offered for selection were the
wastage override values entered would be valid.

Press Extras
Against any component additional press in-line operations can be entered. This could include items such as
varnishes, or allowances for spine glue etc.
Note

Extras may automatically be included against the configuration within Estimating Maintenance so
caution needs to be applied prior to including them against the component.
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Click Extras for the component to open the Press Extras window.

Before any press extra can be entered and subsequently calculated, the extra will have to be entered in
Estimating Maintenance and be associated with a press capable of performing the operation. For further details
see System Admin for Estimating 5.4 User Guide.
Field Name
Operation
Type
Materials

Description
Click Add and choose the extra from the list.
Upon selecting the operation type the list of required materials set up against the press
extra in Estimating Maintenance will be available.
The list of materials can be added to or removed as required using Add and Remove.
Additional material elements can also be added and they do not have to be those entered
against the press extra.
When you enter the material group, type and item the dimension fields will adjust
accordingly.

Group

Enter the Material group.

Type

Enter the Material type.

Item

Enter the Material item.

Calc Group
Calc Method

Enter the Calculation Group to automate the material calculations. For further details see
System Admin for Estimating 5.4 User Guide.
Calculation Method to help automate the materials calculations. For further details see
System Admin for Estimating 5.4 User Guide.

Dimension

Specify the 1st dimension.

Dimension

Specify the 2nd dimension.

Dimension

Specify the 3rd dimension.
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Note

Press Extras are only valid for the calculation of in-house routes and outwork routes will not be
calculated or offered for selection if a press extra has been added to a component within an estimate.

Manual Routing
The Estimating application will always calculate and offer routes based on the component specification as long
as there are configurations entered in Estimating Maintenance that support that specification. However, you may
choose to filter the routes presented to you prior to calculation. It is possible to enter such filters via the Manual
Routing window. This includes how the component is broken down into printable sections, whether produced inhouse or outworked.
Click Manual for the component to open the Manual Routing window. The window offers the ability to filter the
routes in a variety of options.

In House / Outwork

You can determine what type of press routes should be calculated and offered for selection. The available
selections are In House and Outwork. If you select In House, the application will calculate and offer press
routes for producing the component on your own press resources. If you select Outwork, the application will
calculate and offer press routes based on suppliers producing the component. To enable this, basic press
configurations need to be entered within the Outwork tab in Estimating Maintenance.
Note

You can choose both or just one of the options, but at least one option must to be selected.
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Press Types

You can choose to filter the routes calculated and offered for selection based on different press types. By default,
all press types will be selected and press routes will be calculated and offered if they are present within
Estimating Maintenance and capable of producing the print component. For example, if you only want sheetfed
routes to be calculated and offered for selection, clear the check boxes for the other options and ensure that the
Sheetfed check box remains selected.
Based upon this selection, the resource filter is automatically updated.

Site
If your company is multi-site with presses across various sites, the site selection area allows you to filter out
press resources at specific sites. However, the list of sites available is based on your user profile and whether
you have permission to estimate for site, sector or group and also whether a user at a particular site has access
to resources at other sites. In the example below, the user has permission to calculate estimates for sites and
resources at group level, however within Estimating Maintenance > Site > Press Site Link, the site of Leeds
(this is the site location of the user), only has access to resources at Leeds, Manchester and Nottingham, and
hence only those three sites are offered for selection.

At least one site must be selected and you can either select the individual sites or choose the Select All and
Select None as appropriate.
Based upon this selection, the resource filter is automatically updated.

Reasonable Section Breakdown (RSB)
A print component is entered regardless of the section breakdown of how it is physically printed, but when
calculated will offer route options based on many different section breakdown combinations. This can potentially
present hundreds of press routes for you to choose. As a consequence the section breakdown allows you to filter
the routes offered based on specific route breakdowns. This is extremely useful, if, for example, the job prints in
the next month, you have a component pagination of 96pp, yet you know that you only have press capacity to
print this pagination as 3 x 32pp sections.

Selecting the RSB allows only those routes that both support the definition of the component and match the
RSB, to be available for selection.
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At least one RSB must be selected and you can either select the individual RSB or choose the Select All and
Select None as appropriate.
This is also a useful tool if you do not get the RSB expected when calculating the component. A good area to
check is the RSB within the Manual Routing window to check that the option has actually been entered in
Estimating Maintenance.

Resource
If you know the resources that you wish to select the routes for, you can filter by resource. By default, all press
options will be selected. By clearing press resource options this will prevent them from being offered for selection
as calculated press route options.

At least one resource must be selected and you can either select the individual resource or choose the Select
All and Select None as appropriate.

Working Methods
For sheetfed press routes you can filter the options calculated and offered for selection based on the working
method.

Note

Gravure and Web offset presses need to have the Perfecting check box selected.

At least one working method must be selected and you can either select the individual method or choose the
Select All and Select None as appropriate.

Sheet Sizes
For sheetfed press routes only you can pre-select the sheet size that you wish the component to be printed on.
The available sheet sizes are entered in Estimating Maintenance > Miscellaneous > Sheet Sizes.
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By default, all will selected but you can choose to either select the individual sheet or choose Select All and
Select None as appropriate. At least one sheet size must be selected.

If the sheet size that you wish to use in the estimate calculation is not available, you can enter a custom sheet
size. This cannot be used in with any other sheet size selection. When selected, all other selected sheets will
automatically be cleared and the ability to enter the custom sheet size will become available.

This allows you to enter the overall size of the sheet in the Depth and Width fields along with the printable area
of the sheet in the Printable Depth and Printable Width fields. Typically, a gripper edge is required and you can
enter this value by selecting an option from the Gripper Edge field.
In the example below, a 660 x 920mm sheet has been entered with a 5mm unprinted area on all edges, gripping
on the bottom of the sheet. The sheet would then be used for all sheetfed route calculations where the
parameters of the sheet and print component can be produced using the sheetfed press.
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You can pre-select the layout of the pages on a sheet. To do this, click No. Up (number up), (underneath the
sheet sizes list of options). This will open the Pages to view pre-select window.

By default the application will attempt to select the best fit for the product size, however you can choose either
the Width Across or Height Across the sheet if you know how the job will be produced at this stage.
You can also enter different Depth and Width values so that you can enter scenarios of a different open size to
save you having to close the Manual Routing window, update the component trim size and then click Manual
Routing > No. Up to see which options are available to you. If you change the Job Size within the Pages to view
pre-select window, the changes will not be saved and will not update the component trim size.
For single web and sheetfed configurations you can also filter based on Pages Across and Pages Down the
sheet. This will prevent route calculation where the number of pages across and pages down the web do not
match the values entered in the filter.

Pre-cutting
If you have to pre-cut a sheet from a master sheet size down to a smaller, custom sheet size you will need to
select the Pre Cut check box within the Manual Routing window.

Select the Pre Cut checkbox, and the Master, and Options become available. Choose the sheet size from the
Master field. This will automatically populate the Depth and Width fields.
By default the sheet size will select the (Automatic) option.
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Click Options to open the Precutting Options window.

The example above shows a total of four different pre-cut sheet sizes and/or impositions. These are based on a
component quantity of 75,000 copies and on the ‘LS / Hberg SM 6U + UV’ sheetfed resource. For enquiries that
contain multiple quantities, a different pre-cut sheet size can be selected for each quantity. You can also select a
different resource by selecting the Press field.
The example below shows the list of available pre-cut sheet size options for a small format Digital Indigo press.
As this can only run up to a maximum sheet size, the larger sheet size options are not included for possible
selection.

Field Name
Untitled
Column

Description
This is the name of the press resource selected.

Depth

This is the depth of the calculated cut sheet options. You can override this value but only
within the minimum and maximum parameters of the press.

Width

This is the width of the calculated cut sheet options. You can override this value but only
within the minimum and maximum parameters of the press.

No. Out (1)

This is the number of products (based on the flat size) that can be imposed on the cut
sheet.

No. Out (2)

This is the imposition of the products (based on the flat size) on the cut sheet. Entered as
number of products down the cut sheet depth by number of products across the cut sheet
depth.

No. Sheets (1)

This is the number of cut sheets that can be cut from the Master sheet.

No. Sheets (2)

This is the layout of the cut sheets from the Master sheet. Based on the depth of the cut
sheet by width of the cut sheet.

Total Out

This is the total number of printed products that can be produced from the Master sheet
size.

No. Cuts

This is the number of cuts required to the Master sheet size to achieve the cut sheets.

Waste %

This is the amount of paper being wasted (percentage) based on the imposition of the cut
sheet.

Select

You select the check box for the cut option you wish to include in the estimate calculation
based on the quantity and press selected.
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You will note that some cut sheet options include the symbol
. This is displayed to inform you that the
orientation of the product has been changed on the pre cut sheet in order for it to fit. This would also suggest that
the grain direction of the pre cut sheet is now different to the Master sheet size, that may influence your decision
when selecting this option.
When you have selected your preferred cut option, this will then be included within the press route calculation.
The run speed, ink values etc. will be calculated based on the cut sheet, but the paper requirement will be
calculated based on the Master sheet.

Ganging
In advance of the route calculation you may wish to group (gang) components and or versions together on one
sheet.
Note

When this option is chosen the print route calculation will use 2pp open size configurations.

How to gang press routes for two different components
Note

This option can only be entered for components that print on the same paper.

Before you can gang the components together ensure that the two components are created. In the following
example there is a 4pp outer cover and a 4pp order form, with different trim sizes but the paper grade, brand and
grammage is the same. (They could have different inks and pagination.)
4pp cover (75,000 copies)

4pp order form (150,000 copies)

1.

Select one of the components. In this example the 4pp cover has been selected.

2.

Click Manual.

3.

Select the sheet size that you wish to use.
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4.

The Ganging options will now become available. If multiple quantities have been entered into the
enquiry the following process can be applied at the individual quantity level. Select the quantity that you
wish to gang the pages together on one sheet.

5.

Select the check box to confirm the components that are to be printed together on the same sheet.

6.

When selected, the print quantity will populate as will the default number up of 1 for each print
component. Based on the required print quantity and default number up, the number of Impressions
required is calculated.

7.

Change the No Up (number up) value as required.

8.

You need to ensure that the Req Qty (required quantity) and Net Qty (quantity to be produced) match.
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9.

An alternative would be to click Layout. This will allow you to create a graphical representation of how
you believe the items are to be ganged.

Field Name
Rotate

Set Colour

Overlap
Confine to
sheet edges

Description
By default the images will be presented by how the size has been entered. Click Rotate
to rotate the image by 90 degrees. Alternatively right click and choose Rotate from the
short cut menu.
Where multi components or version are being included on the sheet, for easier visibility of
the layout on the sheet you can enter each component or version as a different color.
Alternatively right click and choose Set Colour from the short cut menu.
Select this check box if you can allow images to be overlapped or interlocked.
Select this check box if you wish for the pages to stay within the edge of the sheet.

Concertina

This check box will only become available if the Overlap check box is selected.

No. Across

Prior to selecting the page to be placed on the sheet, select the page of the component
and then enter the number of images that you expect to be printed across the sheet for
the component selected. This means that you can drag and place two pages on a sheet
in one go, rather than having to place them individually.

No. Down

Prior to selecting the page to be placed on the sheet, select the page of the component
and then enter the number of images that you expect to be printed down the sheet for the
component selected. This means that you can drag and place two pages on a sheet in
one go, rather than having to place them individually.

Horizontal
Spacing

When placing more than one page on the sheet in one go, you can enter the size (in
millimeters) for the spacing or gutters that are to be automatically placed between each
image in the horizontal position.

Vertical
Spacing

When placing more than one page on the sheet in one go, you can enter the size (in
millimeters) for the spacing or gutters that are to be automatically placed between each
image in the vertical position.
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Field Name

Description

Increment

Default value is 1. The can be overtyped and helps to move images more easily in larger
steps.

Arrow Buttons

Allows you to select single or grouped images and move them directionally on the sheet.
Right click one of the pages on the sheet and choose Select All from the shortcut menu.
Click the arrows to move the selection around the sheet.

Show Grid
Percentage
drop down
menu

Checking this box makes a grid view available on the sheet to help with alignment.
Select the zoom level for the layout. The layout can only be manipulated at 100% view

10. Click Set Colour.

11. The Color pallet window will open. Choose the color for the component and click OK to confirm the
selection. Repeat this process for the subsequent components.

12. In the top left hand corner of the window the component open size will display. Click and drag this into
its position on the sheet.

13. If you need to change the orientation of the product size, click Rotate prior to dragging onto the sheet.
14. To move and image, simply click on to it which will then display the image as a cross hatched block and
then use the arrow keys to move the image in to the required position.
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15. By default, images cannot be overlapped/inter-locked, however, selecting the Overlap check box allows
you to place images on top of each other.
16. By default, the image size used within the layout view is based on the open size of the product. If this
needs to be adjusted, click Open Layout. The Open Layout button will only be available if no pages
have been positioned on the sheet. You can amend the Open Size in exactly the same manner as
detailed in the Open Size chapter earlier in this guide.

17. By specifying the open size information within the layout view, any subsequent images dragged on to
the sheet will be representative of the open size entered.
18. Repeat this process until the sheet is fully utilized. The area available within the layout is based on the
sheet size selection made in the previous window and is in direct ratio to the actual size of the sheet.
19. If you wish to remove a page from the sheet layout, select the page and Press Delete on the keyboard,
or alternatively, right click the page and choose Delete from the shortcut menu.

20. The No Up fields will automatically update.
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21. Click OK to confirm the changes and close the layout window.
22. The No Up field within the Manual Routing window will also update.

23. Click OK to save the changes and close the Manual Routing window.
24. The Manual button now displays the yellow triangle-warning symbol.
25. Select the second component included in the ganging on one sheet. The component no longer requires
calculation and further editing so the fields are now unavailable.
Note

The routes that will be calculated and made available for selection will calculate the run times etc.,
based on the impression quantity.

How to gang press routes for one component with multiple versions
1.

Enter the version information for the component via the Component Plate Changes window. In this
example, there are four versions to the 4pp cover.

2.

Click Manual to open the Manual Routing window.

3.

Select the sheet size and select the versions to be printed on one sheet.

4.

Adjust the No Up as required.
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5.

In the above example, Version A has been adjusted to print 2up on the ganged sheet. This now has an
impact on the Impressions and Net Qty as the print versions and quantities are now equally balance
across the ganged sheet resulting in no overs being produced for any of the print versions.
Enter the No Up value if you know in advanced the number up of each print version on the ganged
sheet.
If you do not know how this will be printed on the sheet click Layout.

Press Runs (Multi-pass)
By default the application will try to calculate routes for print all colours on both sides of the sheet in one pass.
However, if this is not possible the application will automatically calculate and include additional passes for a
sheetfed press if it recognizes that the product cannot be produced in one pass based on the specification of the
print section and the number of units of the press, and if there is no perfecting bar or a perfecting work style
linked to the supporting configuration.
However, you may choose to manually enter the press runs prior to calculation.
Entering manual press runs
In the following example, a 4pp cover prints 6 colors front and 4 colors back plus an aqueous varnish.
1.

For the component, click Manual to open the Manual Routing window. The bottom right hand corner of
the window allows you to enter the press run information. By default it will display the information based
on one press run.

2.

Click Define Pass to the open the Define Run window.

3.

Clear the check boxes for the inks and or varnish that will not be printed on the first run.

4.

Click OK to save the changes and close the window.
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5.

Click Add Pass to create Run 2. Click Run 2 and click Define Pass.

6.

By default the remaining inks will automatically be selected. In this example the varnish is also to be
added, so the Press Extra check box needs to be selected.

7.

Click OK to save the changes and close the window.

8.

The Press run detail has updated.

9.

During press route calculation, the available press options will show an individual price for each pass
allowing for combinations of resources.
Note

When the route has been calculated, it is still possible that a pre-defined press run will still
require two or more passes and the route breakdown will confirm this if applicable.

The above is a simple example. However, the number of passes that you wish to create is only limited by the
number of colors and if these have been included in other passes.

Cutting within press runs
The ability to define cuts between runs is not currently operational.

Removing Manual Routing
If you have entered manual routing for a component but wish to clear the selections you have made. Open the
Manual Routing window and click Cancel. The following message window will open.

Click Yes to proceed and remove all manual routing that had been entered.
Click No to retain manual routing and close the Manual Routing window.
Click Cancel, the stop the request and keep the Manual routing window open.
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Component Calculation and Route Selection
When components have been added to an estimate, the next step is to calculate and choose the preferred
method of work (configuration). If a component has not been calculated the Calc… button and the component
tab will display a white cross on a red background.

If application setting id 38 for Estimating is entered as 0 (False), the Calculate button will not include the image.

Calculating components
1.

Select the component and click Calculate. The application will start to calculate possible routes and
combinations of sections in order to achieve the requirement entered in the print component.
Note

If press extras have been entered an additional window will open confirming that no outwork
routes will be included in the calculation.
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2.

Click Yes for the calculation process to start, or No and the calculation process will stop.

3.

When the calculation process has finished the Component Routing window will open.
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4.

The options presented are summarized categories based on the breakdown of the component
pagination. In the above example there is only one option as this is a 4pp component. Below is an
example of a 96pp component.

5.

Within the Component Routing window, it is also possible to view the available capacity on each press
resource in the 2 weeks leading up to the delivery date entered in the enquiry.

6.

To view the capacity, select Show available capacity on route selection.

7.

Two new fields will appear; Avail (available), and Req’d (required).

8.

Avail will show the available hours in the week leading up to the delivery date. This value is taken
directly from the Production Scheduling application.

9.

Req’d will show the number of hours calculated for the press route that are required to produce the
route on press.
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10. You can choose to show the layout of the section on the sheet for each of the routes available for
selection. Click Show layout and when you hover over one of the available sections, the imposition
entered against the press configuration (in Estimating Maintenance will open on the window as a tool tip
diagram.

11. Click Show discarded routes if you want to be able to see and select route calculations that would
normally be discarded because they do not have a valid paper, ink or extra material cost. Application
setting id 31 for Estimating controls whether this check box is selected by default.

12. To find out what data is missing, double click the route selection to open the Route Cost Breakdown
window. The missing data will be highlighted as below.
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13. If the check box is clear the discarded routes are hidden from view and cannot be selected.
14. If application setting id 69 for Estimating is entered as 1 (True), the Component Routing window will
also include guillotine and folding operations that would be required based on the section method.

15. If you click OK in this window, without choosing the route, the following Route Selection window will
open.

16. There are 2 stages in the selection of a calculated route. First is to select the required breakdown. The
second is to select the physical method of production for the chosen breakdown.
17. The application will calculate separate routes for each combination of finishing style and quantity.
18. In the above example, six different breakdowns have been returned for the 96pp component.
19. To select the required breakdown, either double click the entry or select the breakdown and click View
Detail.
20. The Component Routing window will open. Application setting id 30 for Estimating influences whether
the values displayed are Cost, Budget or Target.

Note

The Component Routing window can be maximized to aid visibility of the routes available and
make selection easier.
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21. By default the cheapest cost route is selected. To change the option, click the required route.
22. The Method/Description column shows the description entered against the Press Configuration within
Estimating Maintenance to give greater clarity to the Estimator of the routes being returned and the
production method on which the price/cost is based.
Note

The format of the Method/Description field can be controlled using Application Setting 61 for
Estimating.

23. To choose the route click either Set Selection or Set & Next. If multiple quantities have been specified
then clicking Set & Next will automatically move onto the next quantity.
24. To select routes for alternative finishing styles and/or quantities simply chose the required option from
the Finishing Style and Quantity fields at the top of the window.
25. Regardless of the value entered in application setting id 30 for Estimating, the view can be switched to
show either Budget or Target (low sell) pricing by selecting the Show as field.
26. The view can be switched back to the section breakdown. Click View Summary. If a route has been
chosen then this will be displayed against the summary. Click View Detail to open the Route Detail
window.
27. If the breakdown involves multiple printable routes then these will be displayed within the route selection
window.

28. Each printable route is independently selected. This can be on a different resource and even different
site.
29. Once a route has been chosen for all finishing style and quantity combinations, the window can be
closed. To save the selection and close the window click OK. If a route has not been chosen then a
warning message window will open informing you that a route selection is missing. Before the route will
be considered within the Post Press calculation process a route must have been selected.
30. If you wish to force a re-calculation, maybe because you need to amend the component specification,
click Reset Routes. This will close the window.
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31. When all calculated routes have been selected and the Component Routing window is closed, the
component tab and Calculate button will also update to confirm that it has been calculated. The Review
button will also become available.

Reviewing Component Routing
1.

When all calculated routes have been selected and the Component Routing window is closed, the
Review button will become available.

2.

If a route has been calculated, the chosen route can be changed without the need to re-calculate. Click
Review. The Component Routing window will open.

3.

The route previously selected route will be available in the Route Selected field, but you can now
choose either a different section breakdown or select an alternative site, press and method for the same
section breakdown.
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4.

When reviewing either newly calculated route options or those previously calculated, you can view the
route cost breakdown for the section selected.

5.

From the Route Detail window, double click the route to open the Route Cost Breakdown window. All of
the fields are read only.

Route Cost Breakdown

Field Name

Description

Route Detail
Enquiry No
Rev
Finishing Style

The enquiry number.
The enquiry revision number.
The enquiry finishing style.

Quantity

The component quantity.

Section

The component number.

Title

The component title.

Opening an Enquiry in Estimating | Estimating User Guide 5.4 l 111

Field Name

Description

RSB Option

The option number for the section breakdown entered in the Reasonable Section
Breakdown window in Estimating Maintenance.

RSB Seq
Pagination
Printable
Section
No. Like This
No. Up
No. Passes

The sequence number for the section breakdown entered in the Reasonable Section
Breakdown window in Estimating Maintenance.
The component pagination.
The print section pagination.
Number like this for the print section pagination that is included in the component
pagination.
The number of identical images that can be output on one sheet.
The number of passes through the press that will be required to produce the required
print section.

Depth

The component depth trim size.

Width

The component width trim size.

Press ID /
Name

The unique press identifier for the press and its site and press name entered in
Estimating Maintenance.

Config ID /
Name

The unique configuration identifier entered for the press configuration and the Description
of the configuration entered in Estimating Maintenance.

Work Style

The work style associated to the configuration for the print section.

Manual Route

No longer used.

Pre Press
Pages of Data /
Film

The total number of pages of data. For example, Printable Section * NLT * (number of
colors/2).
So for a 96pp component that prints as 3 x 32pp, 4 colors would calculate 384 pages;
(32*3)*(8/2) = 384.

Click Cost
Pre Press
Labour Cost
No. of Plates /
Cost

Number of gross sheets x number of colors x cost x number of sides.
Pre Press Labor Hours * Pre Press Cost Rate.
Number of plates required. ((Number of inks front + number of inks back) * plate
multiplier) * NLT.
In the 96pp component example, ((4+4) *1 * 3) = 24.

Cost Per Plate
Plate Material
Cost
Platemaking
Hours

Cost per plate entered on Press tab in Estimating Maintenance for the resource selected.
Number of plates x Cost Per Plate.
Number of plates x Plate Making Hours/Plate, on Press tab in Estimating Maintenance for
the resource selected.
In this example the Plate Making Hours/Plate value is 0.100, therefore 24 * 0.100 = 2.40.

Cost Rate

Platemaking Cost rate per hour based on the delivery data of the enquiry entered on Site
tab in Estimating Maintenance for the resource selected.
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Field Name

Description

Platemaking
Labour Cost

Platemaking Hours x Cost Rate.
In this example, 2.4 * 50 = £120.

Press and Ink
MR Hours
MR Cost
Process Ink
Running Hours
Run Cost

Total number of make ready hours for the component.
MR Hours x Cost Rate for the press.
Amount of process ink required based on unit of consumption x Cost per UOP. Both the
amount and the value is displayed.
Number of printed sheets / impressions per hour.
Running Hours x Cost rate for the press.

Special Ink

Amount of special ink required based on unit of consumption X Cost per UOP. Both the
amount and the value is displayed.

Speed IPH

Number of impressions per hour that the press can produce based on the specification of
the component and the method selected.

Cost Rate
Other Material

Press Cost Rate per hour based on the delivery data of the enquiry as entered for the
press in Estimating Maintenance.
Cost for additional materials included in the calculation, for example varnish etc.

No. Cells

Number of cells included in the component.

Cell Time

Number of Cells x Time per Cell.

Cell Cost

Number of Cells x Time per Cell x Resource Cost Rate Per Hour.

Cell Price

Number of Cells x Price per Cell.

Paper
Web
Paper Type

The web number that the section is printed on.
The short description name for the paper grade.

Depth

The depth of the sheet.

Width

The width of the sheet.

Weight
Per Sheet
Amount
Unit Cost

The grammage of the paper required.
Grams per sheet.
Amount of paper required, based on unit of consumption. For example, in the 96pp
component example this calculates 63,906 kilos of paper.
Unit of purchase cost.

Cost

Amount x Unit Cost.

MU%

Mark up percentage.

Price

Cost x Mark up percentage.

MR
Impressions

(MR Sheets + No Plates MR Sheets + (Follow On MR Sheets + No Plates MR Sheets) *
Extra Plate Sets) + Press Extra MR Sheets.
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Field Name

Description

Run
Impressions

Net Sheets + Binders Overs + Running Waste.

Paper Cost

Amount of paper x Unit Cost of paper.

Mark Up %

Paper mark up percentage.

Price
Handling Cost

Mark Up %
Price
Paper Waste %

Paper Cost x Paper mark up percentage.
Application setting id 59 controls whether paper handling is only included in the
calculation if paper is supplied by the customer and application setting id 58 controls
whether the calculation is based on weight or by time.
Handling mark up percentage.
Handling Cost x Handling mark up percentage.
The percentage of paper waste included in the calculation.

Finishing
Guillotine Cost

The calculated guillotine cost that will be required post print section production, prior to
final binding operation. The calculated value is only displayed if application setting id 69 is
entered as 1 (True).

Folding Cost

The calculated folding cost that will be required post print section production prior, to final
binding operation. The calculated value is only displayed if application setting id 69 is
entered as 1 (True).

Totals
Route Cost

Budget Selling
Price

(Plate Material Sell (cost + mark up %) + Process Ink Sell (cost + mark up %) + Special
Ink Sell (cost + mark up) + Other Material Sell (cost + mark up %) + Paper Sell (cost +
mark up %) + Pre Press Labour Cost + mark up % + Platemaking Labour Cost + mark up
%) + ((MR Hrs + Run Hrs) x Press Sell Price rate).

Low Selling
Price

(Plate Material Sell (cost + mark up %) + Process Ink Sell (cost + mark up %) + Special
Ink Sell (cost + mark up) + Other Material Sell (cost + mark up %) + Paper Sell (cost +
mark up %) + Pre Press Labour Cost + mark up % + Platemaking Labour Cost + mark up
%) + ((MR Hrs + Run Hrs) x Press Low Sell Price rate).

Print
OK
Cancel

Note

Click Cost + Pre Press Labour Cost + Plate Material Cost + Platemaking Labour Cost +
MR Cost + Process Ink Cost + Run Cost + Special Ink Cost + Other Material Cost +
Paper Cost + Handling Cost.

Click Print to output the Route Cost Breakdown window.
Click OK to close the window.
Click Cancel to close the window.

More detailed calculation examples are available within the System Admin for Estimating 5.4 User
Guide.

Packing and Delivery
The packing and delivery window allows extra packing and delivery information to be entered and to be included
in the post press calculation process.
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The packing and delivery information entered relates only to the main (final) finishing operation and is not
considered for any interim process.
The application will automatically include delivery for shipment to outworkers and/or other manufacturing sites if
they are included in either the press or finishing calculation.
There are two methods for calculating Packing and two methods for calculating Delivery.
•

Packing
o Standard
o Advanced

•

Delivery
o Standard
o Freight Rates

Packing - Standard
To enter the packing requirements click Pack & Delivery from the navigation pane.

The Pack & Delivery window will open.

Any entries added during the enquiry process or included based on application setting id 13 for Sales Enquiries
will already be included. Click Remove to delete a packing requirement no longer needed and click Add to
include a new packing requirement in the version calculation.
Field Name

Description

Type

Packing type. The list of types available are entered in Estimating Maintenance >
Miscellaneous > Material > Group; Packing > Type.

Item

Packing item within the selected type. The list of items available are entered in Estimating
Maintenance > Miscellaneous > Material > Group; Packing > Type > Item.
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Field Name
Description
Pack Qty

Description
Packing description. Upon selection, it will default to the item description but you can
overtype this to a more suitable description is preferred.
Enter the number of copies in the pack.
By default the Pack Quantity will be 0 and, if left at 0, then the system will calculate the
pack quantity based on the final product weight and the value entered as the items
maximum weight within Estimating Maintenance > Miscellaneous > Material > Group;
Packing > Type > Item.

% of Qty
Actual Qty

For Qty

Enter the percentage quantity of the run that the packing is for. The default value is 100%.
This allows you to enter the actual number of the enquiry copies that are to be packed
using this method, instead of entering the percentage of the run length. If you enter a
value in this field the % of Qty value will be ignored.
If multiple quantities exist within the enquiry then you can enter packing requirements that
are targeted for a particular quantity. To do this, enter the quantity number. This is the
number next to the quantity within the Enquiry Detail window.

If only one quantity exists for the enquiry, or the packing requirement is to be included in
the calculation for all quantities, then you need to enter 0.

Standard Packing Calculation Method
Example scenario: 250,000 copies, 4pp cover on 130gsm + 96pp text on 70gsm, 297 x 210mm portrait. Packing
in A4 Cartons and Standard Pallets, Delivery to 1 address Leicester (from Leeds).
Process

Calculation

Source

Weight of product
Weight of each
component

=

(Trim size / 1000) * grammage *
(pagination / 2)

Cover

(297 x 210 / 1000) * 130 * (4 / 2) =
16.2162 grams

Text

(297 x 210 / 1000) * 70 * (96 / 2) =
209.5632 grams

Weight of book
plus product

Weight of book + product weight uplift
%

(from Site tab)

16.2162 + 209.5632 * 5% = 237.07
grams
Pallets
Number of
copies per
pallet

=

Packing
Quantities

=

Maximum weight of pallet / Product
Weight
1000 / 0.237070 = 4,218
4,000

(from Materials)
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Process
Total number of
Pallets

Calculation
=

Quantity / Copies per pack

=

250,000 / 4,000 = 62.5, rounded up to
full pallets = 63

Cost per UOP

=

£7.00

Cost of pallets

=

Number of pallets x Cost per pallets

Source

(from Materials)

63 x £7.00 = £441.00
Price of pallets

=

Cost of packing * Mark Up %

(from Materials)

£441 * 5% = £463.05
Carton Packing
Number of
copies per pack

=

Maximum weight of pack / Product
Weight

(from Materials)

12.5 / 0.237070 = 52.7 copies
Packing
Quantities

=

50

Total number of
Packs

=

Quantity / Copies per pack
250,000 / 50 = 5,000

Cost per UOP

=

£0.25

Cost of packing

=

Number of packs * Cost per pack

(from Materials)

5,000 * £0.25 = £1,250.00
Price of
packing

=

Cost of packing * Mark Up %

(from Materials)

£1,250 * 5% = £1,312.50

Packing – Advanced
Advanced Packing will allow you to choose a finishing operation and specify a detailed packing specification that
covers the ability to BPOP, Bundle and Palletize, and Carton and Palletize. If Advanced Packing is defined
within the Estimate then any order created from it will inherit the packing detail.
Important

To begin working with Advanced Packing you need to ensure that the appropriate configuration and
set up is in place. Details on how to do this are contained within the System Admin User Guide for
Order Management 5.4.

Using Advanced Packing
1.

Click Pack & Delivery and remove any existing standard packing entries.

2.

Click Enquiry Detail.

3.

Ensure that the print components are calculated.
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4.

If using standard style finishing, click Add to create a new estimate version.

5.

Click Assign or Include All (as appropriate) to include the components into the estimate version.

6.

Click Finishing and the Estimate Finishing window will open.

7.

If using BOR style finishing double click the existing estimate version and the Estimate Finishing
window will open.

8.

Click Packing… and the Advanced Packing web page will open.
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There are three options for entering Advanced Packing:
•

BPOP

•

Bundles

•

Cartons

Option 1 - BPOP (Bulk Packed on Pallet)
If the option you require is BPOP, then you can change the Cost, Mark Up % and subsequently Price.
Using the above example, 297 x 210mm portrait product and based on the following pallet specifications entered
in Estimating Maintenance, along with a rounding factor of 50 (application setting id 86).

For each valid pallet, the following process is applied when calculating the number of pallets required.
1. Number of products per pallet per layer =
(Pallet Depth / Product Depth) * (Pallet Width / Product Width) = (1000 / 297) * (1200 / 210) = 3 * 5
= 15
(Pallet Depth / Product Width) * (Pallet Width / Product Depth) = (1000 / 210) * (1200 / 297) = 4 * 4
= 16
Whichever option enables more copies per layer this option is chosen, so in this example copies per pallet
per layer = 16
2. Number of layers per pallet =
This is calculated based on number of products per layer, and then also takes into account the maximum height
of the pallet less the pallet material height and thickness of product.
In the example provided
Max height pallet = 1000
Pallet Material Height = 100
Product Height = 4.82
(Pallet Height – Pallet Material Height) / Product Height = (1000 – 100) / 4.82 = 186
3. Copies per pallet =
Products per layer * Layers per pallet = 16 * 186 = 2,976
= 2,950 (rounded down to nearest 50)
4. The next check is to ensure the maximum pallet weight has not been exceeded.
(Maximum pallet weight – Pallet Material Weight) / Product Weight = (1000 – 15) * 1000 / 237.06
= 4,150 (rounded down to nearest 50)
This will calculate the maximum number of products that can be put on the pallet based on weight.
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5. Calculate number of pallets =
Total Net quantity / Number of products per pallet = 250,000 / 2,950 = 85 pallets
6. Calculate cost / price for packing =
Number of pallets * Cost per UOP = 85 * £7 per pallet = £595
Cost of packing * Mark Up % = £595 * 5% = £624.75.

Option 2 - Bundle & Palletize
Example: 297 x 210mm portrait
Max bundle height = 300mm (App setting id 83)
Max bundle weight = 11kg (App setting id 82)
Bundle rounding factor (rounded down to the nearest x) = 5 (App setting id 87)

Firstly the application will check the parameters set against the application settings in Information Console.
1. The application will calculate how many products per bundle and will use the lowest value (you cannot
exceed either maximum) of:
Maximum bundle weight / product weight, rounded down = (11 * 1,000) / 73.35 = 145
OR
Maximum bundle height / product thickness (caliper or spine thickness), rounded down = 300 /
1.488 = 200
Note

You can manually type in pack per bundle, however the application will not validate your entry so you
need to manually adjust the pack per bundle with caution.

2. Calculate actual bundle size (height, depth & width) and weight:
Bundle Weight = Number of products per bundle * Product Weight = 145 * 0.07335 = 10.635kg
Bundle Height = Number of products per bundle * Part Height = 145 * 1.488 = 215.76mm
The Bundles are then stacked onto the pallet according to a selected/customized Pallet Stacking Pattern:
First, calculate number of layers, based on the example detailed and the stacking pattern selected, it knows it
can get 15 bundles per layer plus 15 bundles on the alternate later. The next calculation is how many layers it
can get on the pallet
3. Pallet Layers
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(Maximum Pallet Height – Pallet Material Height) / Bundle Height = (1,000 – 150) / 215.76 = 3
(rounded down to nearest whole number)
4. The number of bundles per pallet is then calculated
Bundles per Layer * Layers per pallet = 15 * 3 = 45
5. The number of pallets required is then calculated
First calculate the total number of bundles required
Nett Quantity / Parts per Bundle = 150,000 / 145 = 1035
Then calculate Total number of bundles / Number of bundles per pallet = 1035 / 45 = 23
6. Calculate Cost/Price per bundle + per pallet
Number of bundles * Bundle UOP
Number of pallets * Pallet UOP

Option 3 - Carton & Palletize (Using Standard Materials)
The following example uses the carton parameters entered below in Estimating Maintenance. It will use
application setting id 88 for rounding factors (in this example 5).

When you select Cartons as the packing option, the following web page is opened:

First, you must select which Carton you require from the field (in this example A4 Cartons).
The application will then calculate how many items (parts) can be fitted inside the carton
1. Based on Weight, the Max weight of the carton is 10kg, the actual material weight of the carton is
0.25kgs, therefore the product inside, can only be 9.75kg in weight (10 – 0.25)
Product weight = 0.07335kgs, therefore 9.75 / 0.07335 = 130
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Based on Size, the application will check in both orientations how the product best fits the carton
Product size = 297 x 210 portrait
Carton depth = 300, Carton Width = 215
Therefore the Product width (210) fits both within the Carton Depth and Width, but the Product
Depth only fits within the Carton Depth, so the product can only fit with a portrait orientation.
Note

If the product was A5 it would fit twice and therefore the application will always work out the greatest
number up it can fit in a carton.
(Internal Height of carton / Product Height) * Number up = 300mm / 1.488mm = 201 * 1 = 200

The application will then select the smaller of the two, in this instance, the weight.
The application will then calculate how many cartons can fit on a pallet
2. Pallet Layers
(Maximum Pallet Height – Pallet Material Height) / External Carton Height = (1,000 – 150) / 310 = 2
(rounded down to nearest whole number)
3. The number of cartons per pallet is then calculated
Cartons per Layer * Layers per pallet = 15 * 2 = 30
The application will now build the pallet layer by layer and apply the cartons per layer and alternate cartons
per layer until the pallet layers has been reached.
As per example provided, the A4 Carton Option 2 would calculate 27 Cartons Per Pallet because the
alternate pallet layer only equals 12.
4. The number of pallets required is then calculated
First calculate the total number of cartons required
Nett Quantity / Items per Carton = 150,000 / 130 = 1,154
Then calculate Total number of cartons / Number of cartons per pallet = 1,154 / 30 = 39
5. Calculate Cost per bundle + per pallet
Number of cartons * Cartons UOP =
1,154 + pack multiplier (in this example = 10s) = 1160 * 0.215 = £249.40
Number of pallets * Pallet UOP =
39 * 7 = £273
Total packing cost = £522.40

Option 3 - Carton & Palletize (Using Custom Carton)
In order to use this option, you must first set up a custom carton material in Estimating Maintenance >
Miscellaneous > Material.
1.

Click Packing… from the Estimate Finishing window.

2.

Select the Cartons tab and select the Custom… check box.

The application calculates the custom carton size based on the product size and the following application
settings:
Application setting 96 is the id referenced for the Item within Estimating Maintenance
Application setting 99 is the base carton height (mm)
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Application setting 100 is the space allowed around the product in the carton (mm)
Application setting 101 is the size of the tabs (mm)
Application setting 102 indicates the maximum carton weight (kgs)
Application setting 103 indicates the material weight of the carton (kgs)
The flat layout of the carton is calculated according to the diagram below.

Product size is 297 x 210mm
Custom carton has a 10mm margin, therefore, Depth = 307mm, Width = 220
1. Based on Weight, the Max weight of the carton is 20kg, the actual material weight of the carton is 0.5
kilos, therefore, the product inside can only be 19.5 kilos in weight (20 – 0.5)
Product weight = 0.07335kgs, therefore 19.5 / 0.07335 = 265 copies
The application now looks at the maximum height of the custom carton as determined by application setting number
99, in this example this is 300mm, and now calculates the number of products based on product height
(300 – 10) / 1.488 = 190 (rounded down to nearest 5)
The application will then select the smaller of the two, in this instance, the height.
Based on the chosen number of copies the height of the custom carton is recalculated using this number.
Product Height * Number of copies + Packing Margin = 1.488 * 190 + 10 = 292.72
The application will then calculate how many cartons can fit on a pallet.
If none of the pre-defined pallet patterns fit, you can specify a Custom Pallet Pattern.
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You will need to add a Code, Description and To Pack Size.

Pallet Layers and number of cartons per pallets are now calculated in the same way as standard cartons (as
detailed below).

The application will then calculate the cost of the custom carton material
1. Calculate the required area (flat size) of material for the custom carton:
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Open Width of carton =
(((Product depth + margin) + (Product width + margin)) x 2) + TAB WIDTH = (307 + 220) * 2 + 50 =
1,104
then multiply by the following Open Depth of carton =
(Product width + margin + CALCULATED HEIGHT) = 220 + 292.72 = 512.72
2. Using the calculated requirement, establish how many cartons can be made from one sheet of the carton
material
Sheet size of custom material is 1500 (depth) by 2500 (width)
Divide width of sheet by the width of the carton = 2500 / 1104 = 2 (rounded down)
Divide depth of sheet by the depth of the carton = 1500 / 512.72 = 2 (rounded down)
Total number of cartons from a sheet = 2 * 2 = 4
Divide width of sheet by the depth of the carton = 2500 / 512.72 = 4 (rounded down)
Divide depth of sheet by the width of the carton = 1500 / 1104 = 1 (rounded down)
Total number of cartons from a sheet = 4 * 1 = 4
The application will take the higher value of the two
Therefore it is possible to get 4 cartons out of one sheet, so the application can now calculate how many sheets
of material is required.
3. The application calculates the number of cartons required
(Nett quantity / items per carton) = 150,000 / 190 = 790 (rounded up)
4. The application can then calculate the Number of sheets required
Number of cartons / number of cartons per sheet = 790 / 4 = 198 (rounded up)
5. Sheet cost
Number of sheets * Cost per sheet = 198 * 0.50 = £99
6. Total Packing cost = Pack Cost + Pallet Cost = £99 + £189
Choosing the packing option
1.

When you have decided which of the packing options you wish to choose for this estimate, select the
entry and click Apply.

2.

A packing icon will appear next to your choice.
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3.

Close the Advanced Packing window and continue with the estimating process.

4.

If you need to change the packing selection, click Delete from the toolbar. If you have multiple entries,
for example, cartons on pallets, click Remove All and then click Delete.

Delivery – Standard
Click Pack & Delivery from the navigation pane to enter the delivery destination.

Standard Delivery is calculated based on the cost of delivery to a destination multiplied by the number of loads.
Any entries added during the enquiry process or included based on application setting id 14 for Sales Enquiries
will already be included. Click Remove to delete a delivery destination no longer needed and click Add to
include a new delivery in the version calculation.
Field Name
Delivery Point

Description
Enter the required delivery location. The list of available options are entered in
Estimating Maintenance > Locations.

% of Qty

Enter the percentage quantity of the run that the delivery is for. The default value is 100%.

Actual Qty

This allows you to enter the actual number of the enquiry copies that are to be delivered,
instead of entering the percentage of the run length. If you enter a value in this field the %
of Qty value will be ignored.

For Qty

If multiple quantities exist within the enquiry then you can enter delivery requirements that
are targeted for a particular quantity. To do this, enter the quantity number. This is the
number next to the quantity within the Enquiry Detail window.

If only one quantity exists for the enquiry, or the delivery requirement is to be included in
the calculation for all quantities, then you need to enter 0.
No Drops

Transport Type

This field is only available if the application setting id 119 for Freight Rates in Estimating
is entered as 1 (True), and allows you to enter the number of drops required at a
particular delivery destination.
This field is only available if the application setting id 118 for Estimating is entered as 1
(True). For further details see the System Admin for Estimating 5.4 User Guide for details
of the configuration of available selections.
Note

Fuel Levy

The entry of this data is for information only. It will not have any affect on
the Estimated cost/price.

This field is only available if the application setting id 119 for Freight Rates in Estimating
is entered as 1 (True), and allows you to enter the fuel levy to be included in the delivery
calculation based on the Transport Type selected.
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Field Name

Description

Inco-Terms

This field is only available if the application setting id 118 for Estimating is entered as 1
(True). For further details see the System Admin for Estimating 5.4 User Guide for details
of the configuration of available selections.
Note

The entry of this data is for information only. It will not have any affect on
the Estimated cost/price.

Standard Delivery Calculation Method
Example scenario: 250,000 copies, 4pp cover on 130gsm + 96pp text on 70gsm, 297 x 210mm portrait. Packing
in A4 Cartons and Standard Pallets, Delivery to 1 address Leicester (from Leeds).
Process

Calculation

Source

Weight of product
Weight of each
component

=

Cover

(Trim size / 1000) * grammage * (pagination /
2)
(297 x 210 / 1000) * 130 * (4 / 2) = 16.2162
grams

Text

(297 x 210 / 1000) * 70 * (96 / 2) = 209.5632
grams

Weight of book
plus product

Weight of book + Product Freight Uplift (%)

16.2162 + 209.5632 * 5% = 237.07 grams
Overall weight
of product

=

(Product weight / 1,000) * Net Quantity
0.23707 * 250,000 copies = 59,267 kilograms

Distance
between
locations

=

99 miles

Maximum
weight per load

=

25,000 kilograms

Number of
Loads

=

Overall weight of product / Maximum weight
per load
59,267 / 25,000 = 2.37, rounded up to full
wagon = 3

Cost for
distance range
and weight

=

£180

Cost for distance range x Number of Loads
£180 * 3 = £540
Delivery price

=

Cost * Mark Up %
£540 * 25% = £675

(from Application Settings)
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Delivery - Freight Rates
Transport Rates allows the banding of freight calculation by zone and weight, plus the ability to enter a set up,
drop and fuel levy amounts.
To enter the delivery data, within the estimate, click Pack & Delivery.

Field Name
Delivery Point

Description
Enter the required delivery location. The list of available options are entered in
Estimating Maintenance > Locations.

% of Qty

Enter the percentage quantity of the run that the delivery is for. The default value is 100%.

Actual Qty

This allows you to enter the actual number of the enquiry copies that are to be delivered,
instead of entering the percentage of the run length. If you enter a value in this field the %
of Qty value will be ignored.

For Qty

If multiple quantities exist within the enquiry then you can enter delivery requirements that
are targeted for a particular quantity. To do this, enter the quantity number. This is the
number next to the quantity within the Enquiry Detail window.

If only one quantity exists for the enquiry, or the delivery requirement is to be included in
the calculation for all quantities, then you need to enter 0.
No Drops

Transport Type

This field is only available if the application setting id 119 for Freight Rates in Estimating
is entered as 1 (True), and allows you to enter the number of drops required at a
particular delivery destination.
This field is only available if the application setting id 118 for Estimating is entered as 1
(True). For further details see the System Admin for Estimating 5.4 User Guide for details
of the configuration of available selections.
If you wish for a default Transport Type to be entered for every new enquiry, ensure that
the appropriate value is entered in application setting id 120 for Estimating.
Note

Fuel Levy

The entry of this data is for information only. It will not have any affect on
the Estimated cost/price.

This field is only available if the application setting id 119 for Freight Rates in Estimating
is entered as 1 (True), and allows you to enter the fuel levy to be included in the delivery
calculation based on the Transport Type selected.
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Field Name

Description

Inco-Terms

This field is only available if the application setting id 118 for Estimating is entered as 1
(True). For further details see the System Admin for Estimating 5.4 User Guide for details
of the configuration of available selections.
Note

The entry of this data is for information only. It will not have any affect on
the Estimated cost/price.

Freight Rate Delivery Calculation Method
Example scenario: 250,000 copies, 4pp cover on 130gsm + 96pp text on 70gsm, 297 x 210mm portrait. Packing
in A4 Cartons and Standard Pallets, Delivery to 1 address Leicester (from Leeds).
Process

Calculation

Source

Weight of product
Weight of each
component

=

Cover

(Trim size / 1000) * grammage * (pagination /
2)
(297 x 210 / 1000) * 130 * (4 / 2) = 16.2162
grams

Text

(297 x 210 / 1000) * 70 * (96 / 2) = 209.5632
grams

Weight of book
plus product

Weight of book + Product Freight Uplift (%)

16.2162 + 209.5632 * 5% = 237.07 grams
Overall weight
of product

=

(Product weight / 1,000) * Net Quantity
0.23707 * 250,000 copies = 59,2675
kilograms = 59.2675 Tonnes

Freight Cost

(((Ship Weight/Drops)*Cost per tonne of 1
drop)*Drops) + Setup + (number of drops *
Drop Cost) * (1 + Fuel Levy)
(((59.2675/1) * 30) * + 50 + (1 * 40) * (1 +
0.02)
1,778.025 + 50 + 40 * 1.02 = £1,905.37

Freight Price

Freight Cost * Mark Up %
1905.37 * 10% = £2,095.91

Ancillaries
Ancillaries are used to capture additional cost and pricing information that may make up part of the final
quotation or appear as additional items outside the main quote total. Typically, items specified here cannot be
captured within other aspects of the application.
The type of items includes one of costs, odd materials or specialized outworking or processes.
If ancillary items have already been included when creating the enquiry, they will automatically appear in this tab.
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To enter an ancillary, click Ancillaries from the navigation pane.

The Ancillaries window will open.

Note

The field widths can be adjusted. Click on the column width and drag to its desired location.
Field Name
Sequence

Description
Enter the sequence number to confirm the position that you wish for the ancillary item to
appear on the quotation letter. The quotation letter template may need to be adjusted to
support this option.
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Field Name
Contract

Description
You can assign an ancillary contract price to a commercial estimate. This can be used if
you have a contract that has been created specifically to contain a list of additional
ancillary prices and is available for selection for all customers.
Follow the steps to add a new ancillary item. When the item has been added, select Use
Contract Pricing and select the contract that is to provide the pricing for the item.
Note

For a contract to be available for selection is has to be entered as a
Standard Price List within the Contract.

Select Contract for the new line created (this is necessary to enforce the contract price
to be applicable to the newly added line item, as existing ancillary items may be already
present which were included within the estimate which are not from the contract defined
in the Ancillary screen). Select the ancillary item as applicable, either by selecting the
Type, Code and Description, or by selection of the Description field, i.e. matching
behavior for an ancillary item in an order created directly from a contract.
For enquiries created from a contract, you do not need to perform the above, as the
contract ancillary items are already linked to the order and available for selection and
inclusion.
If selected you will not be required to enter the cost or price for the item. Instead the cost
and pricing fields will be unavailable and the cost and pricing will only be visible when the
estimate version has been calculated.
Outwork /
Outworker

If the ancillary item is to be supplied by an outworker then you need to ensure that the
Outwork check box is selected. You will then need to ensure that the appropriate
Outworker name is selected within the Outworker field.

Ver No.

If multi estimate versions exist, then the ancillary can be targeted for a particular version
by entering the estimate version number. If 0 then the operation will be applied to all
estimate versions. The default is 0.

Fin. Style

If multiple finishing styles are included in the enquiry, you can choose to add an ancillary
item to a specific finishing style. Click Fin. Style to select either ALL or one of the
finishing styles from the list of options.

Qty No

If multiple quantities exist within the enquiry then you can enter an ancillary item that is
targeted for a particular quantity. To do this, enter the quantity number. This is the
number next to the quantity within the Enquiry Detail window.

If only one quantity exists for the enquiry, or the ancillary item is to be included in the
calculation for all quantities, then you need to enter 0.
Qty Override

No Of

Ancillary Type

If you wish to include an ancillary item for a specific quantity and not the enquiry quantity,
you can enter the required quantity of the ancillary within the Qty Override field. If left
blank then the ancillary will be based on the estimate quantity.
If you need an ancillary item to be included more than once for any given quantity or
estimate versions, enter the number times the ancillary type is to be included in the
calculation.
The ancillary type allows you to enter what the additional cost and price is for.The list of
options available are entered within Estimating Maintenance > Miscellaneous >
Ancillary Items > Ancillary Types.
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Field Name
Ancillary Item

Description
Notes
One Off Cost

Description
The ancillary item available is linked to the ancillary type already entered and provides
further detail on what the additional cost and price is for. If the ancillary is selected from a
contract, then these two fields will allow the appropriate cost and price to be included in
the estimate version calculation.
Enter the description for the ancillary entry.
If you wish to include more text for the description click … to enter the additional notation /
instruction.
If the ancillary item cost is a one off cost and not based on a quantity you can enter the
value in the One Off Cost field. If entered, then the One off Price is calculated by adding
the mark up %.
Upon entry, the cost /price make ready and cost/price per quantity values are set to 0.

MR Cost

If cost and pricing for the ancillary item has a make ready enter the value in the MR Cost
field. If entered then the Make Ready Price is calculated by adding the mark up %.
Upon entry, the one off cost /price are set to 0.

Unit Qty

Enter the unit quantity for the item. For example, if a cost/price per thousand is required
then enter 1,000. When the ancillary amounts are calculated this number divides the
required quantity.

Cost Per Qty

Enter the cost per specified unit quantity for the item. If entered then the Price per Qty is
calculated by adding the mark up %.
Upon entry, the one off cost /price are set to 0.

MU %
One off Price

Enter the uplift to be calculated for the item’s cost. The default is 0.
If a one off cost has been entered but no mark up % then the field will automatically
update with the cost value. If a mark up % has also been entered then the sell price will
automatically update. If you choose to enter the sell price directly then any one off cost is
back calculated by the mark up %.
Upon entry the cost /price make ready and cost/price per quantity values are set to 0.

MR Price

If a make ready cost has been entered but no mark up % then the field will automatically
update with the cost value. If a mark up % has also been entered then the sell price will
automatically update. If you choose to enter the sell price directly then any make ready
cost is back calculated by the mark up %.
Upon entry, the one off cost /price are set to 0.

Price Per Qty

If a price per quantity cost has been entered but no mark up % then the field will
automatically update with the cost value. If a mark up % has also been entered then the
sell price will automatically update. If you choose to enter the sell price directly then any
cost per quantity is back calculated by the mark up %.
Upon entry, the one off cost /price are set to 0.
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Field Name
Separate /
Optional

Description
You can choose where you wish for the ancillary item to be included within the sell price,
either as part of the Print, Finish and Delivery values, or broken out on the quote letter
(select the Separate check box), or as an extra in addition to the total sell price (select
the Optional check box).
If the Separate or Optional check boxes are not selected, then the value for the ancillary
item will be included in the quotation letter based on the ancillary type selected. For
example, if you enter a Binding ancillary type and neither Separate or Optional are
selected, when the quotation letter is output in the following format: Print, Finish, Deliver,
Paper, then the value for the ancillary item will be included in the Finish element.

Use Contract
Pricing
Reset Cols
Duplicate

Add
Remove

Indicates when creating a new ancillary that you wish to base the price on a price list that
has already been set up within the Contracts module. If selected then you must choose
the required contract price list from the list of options.
If you have changed the column widths within the Ancillary Items window but want to
change back to their default setting, click Reset Cols.
This allows you to create a copy of an existing ancillary item. This may be useful if you
have a requirement that has a different cost and price based on either the finishing style,
quantity or estimate version, but rather than have to create a blank line entry, you can
enter the item, click Duplicate and an identical line will be created for you to amend the
information as necessary.
Click Add to create a blank line item.
Click Remove to delete an ancillary item.

Additional Finishing
The additional finishing window allows extra finishing operations over and above that of the main finishing styles
to be entered for inclusion in the estimate version calculation process.
Inserts can also be entered so that it is included as part of the main finishing operation.
To enter additional finishing and / or insert information click Additional Finishing from the navigation pane.
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The Additional Finishing window will open. This is split into two sections. The top half of the window allows you to
enter additional finishing operations that you wish to include in the estimate version calculation.

Field Name
Additional
Finishing
Operation
Version No

Qty No

Description
Enter the required extra operation. The options available are finishing styles entered in
Estimating Maintenance > Miscellaneous > Finishing Styles and entered as not
primary.
If multi estimate versions exist, then the additional finishing operation can be targeted for
a particular version by entering the estimate version number. If 0 then the operation will
be applied to all estimate versions. The default is 0.
If multiple quantities exist within the enquiry then you can enter an additional finishing
operation that is targeted for a particular quantity. To do this, enter the quantity number.
This is the number next to the quantity within the Enquiry Detail window.

If only one quantity exists for the enquiry, or the additional finishing operation is to be
included in the calculation for all quantities, then you need to enter 0.

The bottom half of the window allows you to add inserts so that they are included in the finishing operations
wihtin the estimate version calculation.

Field Name
Insert Type

Description
Enter the required insert. The options available are finishing styles entered in Estimating
Maintenance > Miscellaneous > Additional Ops.
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Field Name
Number of

Description
Enter the number of inserts to be included in the calculation. The default is 1.

% of Run

Enter the percentage quantity of the run that the insert is for. The default value is 100%.

Extra Sections
for Binding

Number of extra sections to be accounted for within the calculation of the main finishing
operations.

After entering insert information, if you click to navigate to another window within the estimate, the following
message window will open.

Click Yes to save changes and continue, or No to cancel any changes.

Company Detail
The Company Detail window provides information relating to the customer for whom the enquiry is created. It is
read only and contains the company’s name, address, contact, and payment term detail and the second half of
the window displays all company notes.
Click Company Detail from the navigation pane.
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The Company Information window will open.

The company detail and notes are maintained within the MIS Console > Companies.
Notes against the company are designed to relay pertinent information that may affect the quotation and order
management process.
If company notes do exist then when you enter the Customer within the Enquiry Detail window a message
window will open asking if you wish to view the comments before proceeding.

Notes & Revisions
If the enquiry was created in MIS Console, notes may have been entered to assist you with constructing and
calculating the estimate. If this is the case, then you can view this information at any stage throughout any stage
of the estimate calculation process.
Click Notes & Revisions from the navigation pane.

136 l EFI Technique 5.4 | Estimating User Guide

The Salesperson Notes & Revision Detail window will open. Based on where the additional information was
entered within the Sales Enquiry will determine into which category they appear in this window.

The General, Print, Finish, Company and Revision note fields are read only.
If you wish to add any information relating to the estimate you can enter these within the Estimator Notes field.
Follow Up By, Follow Up Date and Time allow you to enter information regarding the enquiry follow up and for
this information to be passed back in to MIS Console > Sales Enquiries without the need to leave the
Estimating application.
Likewise, if a sales enquiry was created in MIS Console by a Salesperson and these fields are populated in the
enquiry, this information will display in the above fields. If you wish to subsequently change the selections within
the estimate, an activity will be created for the salesperson entered in Follow Up By.

Custom Fields
In Estimating you often need to enter specific information particular to your organization that is not easily entered
elsewhere in the application. As a consequence, Custom Fields (that are designed based on your requirements)
allow additional tabs to be available where you can enter this information.
Click Custom Fields from the navigation pane.
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This will open the Custom Fields window with a tab for each of the entries created in Estimating Maintenance >
Custom Fields.

Fields can be created that require different format of entries. These include:
•

Text; you enter the additional text information.

•

Numbers; you enter a numeric value.

•

Lists; you select from a list of options.

•

Yes/No; you select Yes or No.

•

Date; you select a date.

•

Time; you enter a time.

The data entered can be output to the quotation letter if required.

Estimate Versions
Once the individual components have been estimated and calculated you can now begin to build the finished
product and to do this you must create an estimate version.
The estimate version brings together the press and post press operations and calculates the costs and
subsequent prices so that you can produce the quotation letter to the customer.
Whilst you can add an estimate version at any stage of the estimating process, prior to calculation you need to
ensure that the print components have been calculated, and all packing, delivery, ancillary and finishing
requirements have been entered.
Details on how to enter the components, packing, delivery and ancillary items are included earlier in this guide,
however to calculate and offer the route selection for the finishing operations can only be managed once the
estimate version has been created.
Each estimate can have multiple estimate versions. For example, the customer may have requested a quotation
letter for a variety of text or cover pagination options, on various paper grammages. As long as the print
component has been added and calculated for the options, then these can be added to create multiple versions.
Also, if you have a quotation letter template that supports multi-version estimates, all of these options can be
included in one quotation letter.
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Creating the Finished Product
To create an estimate version click Add.

The Add New Version window will open and you can now select the components to be included in the estimate
version.

To select each component individually click the Assign check box for the components to be included, or, as in
the above example both components are to be included, click Select All.
There is no limit to the number of versions that can be created and the variation between them. The same
component can be assigned and used in multiple times. For example, if the prospect/customer has requested a
price for a 4pp cover plus 32pp text, 4pp cover plus 48pp text and 4pp cover plus 64pp text, the cover
component will only be created once, but can be assigned to multiple estimate versions.
As the components are assigned the Total Pagination is accumulated and description created. Both of these
can be manually overtype if required. If at the end of the assignment process the total pagination does not
match the sum of the selected components then a warning message window will open.
If you are creating the estimate version but do not wish to amend any of the finishing details prior to calculation,
click OK.
If you wish to enter some additional finishing detail, or simply wish to view the current finishing detail, click
Finishing.
If the enquiry has been created using the BOR style method then the estimate version will automatically be
created.
Once the estimate version is created but you wish to view the current finishing detail, you can either double click
the existing entry, or click Change to open the Estimate Version Assignment window, and then click Finishing.
Note

Dependent on the amount of pre-configuration that has been entered for the BOR and its associated
finishing operations will greatly influence how much or little further manual entry will be required.

In the following example, the enquiry was created using the BOR style and hence the estimate version is already
created, based on the configuration of the BOR template.
Opening Estimate Finishing
In the following example, the enquiry was created using the BOR style and hence the estimate version is already
created, based on the configuration of the BOR template.
1.

From the Enquiry Detail window, you can either:
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a.

Select the estimate version, and click Change to open the Estimate Version Assignment
window.

b.

Click Finishing.

2.

Or, you can double click the estimate version.

3.

Using either of the above methods, the Estimate Finishing window will open.

Finishing
Operations

Printable sections
included in finishing
operation

Inserts and
additional
operations

A major part of the estimate version creation and maintenance process is the management and calculation of the
required finishing operations.
By default the application will always create a finishing operation for the main style of the estimate, even for
press-finished styles, to allow the basic finishing to calculate a cost and price. This also facilitates the correct
calculation of any packing and delivery. If any component requires cutting and/or folding these operations will
also be automatically created.
Any additional finishing entries entered within the Additional Finishing window will be added to the list of finishing
operations. However, these operations will require some manual intervention to specify the components/inserts
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used. If not resolved before calculating the estimate version the finishing operations will fail and be excluded
from the cost and price calculations.

Estimate Finishing
You can manage the finishing operations and, for BOR style estimates, the sequence of operations. Finishing
operations are created for each combination of style and quantity and can be managed independently.
The window is divided into three main areas, the top portion represents the operations, bottom left the assigned
components for the selected operation, and bottom right any additional supplied matter/inserts for the selected
operation.
If multiple finishing styles and/or quantities have been entered, if you want to change the view, select Estimate
Finishing Style and / or Quantity to choose a different option.
Note

It is important to check each combination to ensure validity before calculation.

Basic operations can be managed within the Estimate Finishing window.
Select File > Delete to remove a finishing operation.
Select File > Exit to close the Estimate Finishing window.
Select Tools > Reset > All (for the Quantity and Style) to reset all the finishing operations back to the default
created when the estimate version was added. Caution should be used and any work carried out against the
operations will be lost.
Select Tools > Debug mode. This will generate a .txt file during the calculation process and will help to identify
why a finishing route will not calculate and will include reasons for the failure.
If debug mode is switched on then when the finishing is calculated the application will store and report each step
of the finishng calculation process and offer the user the option to view.

Click OK to open the .txt file. It can also be found stored within the local Technique folder (32 bit C:\Program
Files\Technique\file_name or 64 bit C:\Program Files (x86)\Technique\file_name).
The report can prove very useful during the set up phase of the module in helping identify why finishing routes
will not calculate.
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Below is a sample of the debug report content.

Select Tools > Debug mode to switch off the debug mode and stop the generation of the .txt file.

Finishing Operations
The top half of the Estimate Finishing window allows you to manage and include any finishing operations that will
be required to produce the product.

However, the Estimate Finishing window will offer you a slightly different display and options based on whether
the estimate was created using a BOR template or using the standard style. For example there is a difference in
the display and sequence of the finishing operations. A BOR style estimate will sequence the finishing operations
in the order that they should occur (and based on how the BOR templates was entered in Estimating
Maintenance). However, if the estimate is created using the standard style, then it bears no resemblance to the
actual sequence of events. It is simply including the operations for calculation. The example above is based on
an estimate created from a BOR.
Note

If the estimate is created using the standard style of estimate, the View Process button will not be
available.

Main Proc
This field is only available when the estimate is created using BOR and is the main operation sequence number
for the component. The Main Process value for the first line entry will default to 001 as will the Sub Process
value. In the example above, and generally, for every different operation involved in producing the same
component, up to the point of binding, would have a Main Process value of 1. Only the Sub Process value will
increase. When a different component is to be included in the finishing operation, the Main process would then
need to be 2.
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There are occasions when the Main Process number can be duplicated. For example, 2 x components to be wire
stitched. If no other operations were required, then you would have Main Process 1 and Sub Process 1 for the
cover, and Main Process 1 and Sub Process 1 for the text.

Sub Proc
This field is only available when the estimate is created using BOR and is the minor operation sequence number
belonging to the main process.

Est Success
This field informs you whether the calculation process has been successful for this finishing operation. Therefore
for uncalculated routes these would display No, whether no calculation had yet been performed or if routes fail
during the calculation process. This can be used to look at specific operations when determining why the routes
will not calculate.

Op No
This is the assigned operation ID.
When using standard style estimate, 00 is always assigned to the operation that represents the enquiry finishing
style and is also considered as the final operation. There is no 00 operation for BOR style estimates.
Any additional operations are assigned an ascending number starting at 01 and onwards.

Split
This is the number to indicate whether there has been a quantity split. If a quantity split is included then the new
split is assigned the next number is sequence.

F/S
This displays the finishing style of the operation. You can change the finishing style for any operation. To change
the style, click the F/S field and select from the list of available options.

Outwork
This field acts as a filter to enable you to restrict the route calculation and subsequent selection to only be from a
supplier. By default, the Outwork field will state No, however outwork costs and prices will still be calculated and
offered along with any in-house options. Selecting Yes prior to calculation will prevent the calculation of in-house
routes.
If you select Yes, then the resource list against the operation will change to a list of finishing outworkers as
entered in Estimating Maintenance > Outworkers > Can Bind.

Bought In
If you have the Bought In module license, this option allows you to send your request for quote directly to the
supplier.

Opening an Enquiry in Estimating | Estimating User Guide 5.4 l 143

1.

Click the Bought In field and select Yes to open the Bought In Details window. The Outwork field will
automatically update to Yes.

2.

Select Template. The list of options available are entered in Estimating Maintenance and the choices
offered to you will be specific for print components.

3.

Estimating will try and populate as much information as possible based on the selections already
entered against the finishing operation. However, this information can be overtyped or any fields not
populated with information can be edited directly within the form. The fields within the Enquiry are
intended to be typical of the information that you would provide to a Supplier when asking them to quote
for work.

4.

Enter all the information required.

5.

Click Supplier Allocations / Responses View to manage who will be sent the RFQ.

6.

This will open the RFQ Allocations window.

7.

Default suppliers who can produce the type of work required will automatically be included (see above).
These can either be removed to send to specific suppliers only or left with a view to sending the enquiry
to them all.

8.

Click Add and Remove to either add additional suppliers or remove suppliers from the list.
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9.

Double click on any supplier entry to allow you to enter additional notation to be included in the enquiry.

10. If the same note should be included to all selected suppliers, click Apply Notes to All.
11. Select the supplied and click Send if you only wish for the request to go to one supplier. Click Send All
if the enquiry is to go to multiple suppliers. The status for each supplier will be updated.
Note

When prices are returned from the suppliers and you select the option you want to use, the
price will be saved only against the operation from where the Bought In options was selected.
The prices will only show against the operation that was selected when the Bought In function
was used.

12. At this point, the enquiry is waiting for the supplier to respond through the Supplier Portal and provide
their pricing information. You can track the status of an RFQ from the Active RFQ’s view.
13. If you wish to view the information after the initial selection and entry of information, click Bought In.
Receiving finishing prices from suppliers using Bought In
When the suppliers have responded to your quotation request this will be visible in the Active RFQ view in
Estimating and within the Bought In Details within the actual estimate.
1.

To open the Bought In Details window from the Active RFQs view, double click the RFQ, or alternative,
click Bought In within the Estimate Finishing window.

2.

Double click the Supplier line entry to view any attachments included.

3.

Click Review Pricing.

Opening an Enquiry in Estimating | Estimating User Guide 5.4 l 145

4.

The Supplier Responses window will open.

5.

Click Accept to confirm the pricing. The Status will update to Accepted. All other requests will now
have a status of Cancelled.

6.

If you subsequently receive another response from a different supplier and choose to accept the new
quote, the original quote that had previously been accepted will now have a status of Cancelled.

7.

Click OK to close the window and Close to return to the Bought In Details window.

8.

Click OK to close and return to the Estimate Finishing window.

9.

Click Details.

10. The Finishing Detail – Reprice Route window will open.

11. The values from the supplier have populated the window allowing you to enter a markup value (MU%)
prior to calculation. Click OK to continue.
For information relating to the Supplier Portal, refer to the MIS Console User Guide.
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Description
This is the name of the operation. By default the application enters the finishing style description but this can be
overwritten. For example, if you add a pre-collate operation, the F/S will be WS (Wire Stitched) yet the
Description will automatically populate with Perfect Bound (or whatever the main finishing style is for the
enquiry). In this example, you may want to change the Description to something more appropriate, such as PreCollate.

Site
This field acts as a filter to enable you to restrict the list of possible sites that are calculated and offered for
selection based on the site location of the resource.
If you’ve entered Yes in the Outwork field, this will provide a list of suppliers that have been entered as Can Bind
in Estimating Maintenance. If you enter a particular supplier then only routes for that supplier will be offered for
selection.
Whether in-house or outwork, if the Site is entered as All, then all possible options will be calculated and offered
for selections (as long as they are capable of producing the operation).

Resource
This field acts as a filter to enable you to restrict the list of possible resources that are calculated and offered for
selection based on the site location of the resource.
If you’ve entered Yes in the Outwork field, this field can be ignored.

Cells
Enter the number of Data Cells required against the finishing operation within this field. During route calculation,
if Data Cell configuration data is found for valid finishing resources during route calculation, the cost, time and
sell price will be included in the calculated numbers.
To enter the number of cells required, simply enter the number directly in to the Cell field against the relevant
operation.
Finishing Operations within the BOR template can be set to trigger a confirmation message when building a BOR
based estimate which asks the user to define the number of Cells required for each item set within the template
as requiring Cell details.
The Operations Requiring Cell Changes window will only open if the BOR template has been set up with
Finishing Operations that are entered as requiring cell change information. By entering the cell values at this
point against the finishing operations, the cell value will automatically be set against the relevant finishing
operation without the need for you to enter these manually against each individual operation.

Product Qty
This field is only available when the estimate has been created using BOR and will automatically populate with
the enquiry quantity.

Overs %
This field is only available when the estimate has been created using BOR and will include the binders overs
percentage for the operation. Dependent on how the binders over values that have been entered in the BOR
template will determine the value included.
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In the following example, the BOR is entered as including Site BO.

The application setting id 70 for Estimating is entered as 1 (True), therefore the binders overs values are entered
based on the Site Binders Overs values.

If the BOR is entered as including the values from the Site Binding Overs window, the Overs % value within the
Estimate Finishing window includes the Waste % and Waste Qty.
In the example below using the values entered within the Site Binders Overs, (as entered within the BOR
template), the Waste % and Waste Qty values are included in the calculated Overs %. ((0.025 x 250000) + 50) /
250000 * 100 = 2.52%.

Output Qty
This field is only available when the estimate has been created using BOR and represents the quantity that
needs to be generated by the finishing operation.

Waste %
This field is only available when the estimate has been created using BOR and is the percentage of waste that is
expected to be incurred during the finishing operation.

Waste Qty
This field is only available when the estimate has been created using BOR. This allows you to enter the number
of copies of waste for the finishing operation rather than express as a percentage or in addition to the
percentage. This is added to the Waste % value to calculate the Output quantity.
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Input Qty
This field is only available when the estimate has been created using BOR and represents the quantity that
needs to be available at the start of the finishing operation, so that the output quantity is sufficient, either for the
next finishing operation or the final number of copies that the customer is expecting to receive.
The above quantity and waste fields are best explained using the following example: The order below contains
4pp cover + 96pp text (printed as 3 x 32pps). The cover will be cut into singles prior to being perfect bound with
the text (the perfect bound operation is the final operation).
Step 1
The customer requires 250,000 of the finished product (perfect bound operation), however, whilst the final
operation is in progress it is expected to incur 2.50% waste, therefore it calculates that it needs an Input quantity
of 256,250 copies (Product Qty x Waste %).

Step 2
A cutting operation is required to be applied to the cover that is included in the final product. As the cutting
operation feeds into the perfect binding operation the application knows that it needs to output a quantity of
256,250 copies (to satisfy the potential waste during the binding operation). The cutting operation is also
expected to incur a waste value of 1%. Therefore the Input quantity (copies required to be available for cutting)
required is 258,812 and is calculated as follows: 256,250 (output quantity) x 1% (waste %).

No Sects
This field is only available for standard finishing style estimates and will not be visible for estimates created using
BOR, and will confirm the number of printable sections that will be included in the finishing operation.
As per the example below, one 16pp section is to be wire stitched and therefore the No Sects field displays 1.

Quantity and %
These two fields are only available for standard finishing style estimates. The enquiry quantity will automatically
populate this field, but you can override the value if required. If changed, the % field will automatically update to
inform you what the new quantity is in relation to the enquiry quantity. For example, if the enquiry quantity is
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50,000 copies, yet the Quantity value is changed to 25,000, then the % value will automatically update to 50%.
Similarly, if you change the % value from 50 to 100, then the Quantity field will update to the same as the enquiry
quantity.

Weight To Bind
This is the accumulated weight (in kilos) of the assigned components.
The calculation is as follows:
((sheet size (web width x cut off)/1000) x gsm) / 1,000,000 x ((Quantity x Binders Overs %) / number up)
((1260 x 890) / 1000 x 70) / 1,000,000 x 25,000 = 2,001.7

MR Hours
Allows for a number of additional make-ready/set up hours to be incurred during the operation route calculation.
These are additional hours which will be added to the standard set up time defined within Estimating
Maintenance.

Cost
Indicates whether the application calculates the cost of the operation.

Sell
Indicates whether the application calculates the price of the operation.
Primarily, this is used when pricing from a contract where the price of an interim operation is included in the main
operation. If No is entered, the application will bypass looking for the contract entry.

Materials
Indicates that the operation entered in the BOR is calculated using materials only and does not have a printable
section as an input. For example, Endpapers being produced by a folder as part of a Book Binding process may
simply be taking cut unprinted sheets and folding them to size. In this example, this would be a material only as
none of the printed components will be being processed at the same time.
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Small Machine Finishing Operations
Finishing resources can be configured to calculate based on parameters rather than the traditional mode and
speed configuration that is commonly used for stitching and binding resources. The parameters are entered in
Estimating Maintenance against the finishing style, which, in turn, are configured against the resource.
Therefore, dependent on the resource type, these additional fields may be present within the Estimate Finishing
window. The format of these fields is not constant for each operation as they are user definable. For details on
how to configure these types of resource see the System Admin for Estimating 5.4 User Guide. An example of
the format available within Estimating is shown below.

The values shown within the window are those set as the default values within Estimating Maintenance. You can
adjust these values within this window to change the calculated cost and price. The fields presented to you are
essentially overrides permitted by the system administrator. The number of options available within the grid is
variable and is dependent on the finishing machine being configured. Anything from one option to 20 options can
be configured to display.
An additional field, Piece Thickness will be available. This allows you to override the thickness of the item. If you
choose to leave this as 0, then piece thickness will be calculated by the application.

Viewing and amending the finishing operations for an estimate created from a
standard style estimate
Adding a Quantity Split
This is only available for an estimate created using the standard style, and allows you to split a finishing
operation by quantity so that you can split a large finishing run, so that it can potentially be estimated across
multiple sites and resources.
1.

To apply the split, select the finishing operation you wish to split, and click Quantity Split.

2.

The finishing operation will be duplicated, including the assigned components and any in-line
operations.

3.

Adjust the Quantity as appropriate and apply any site and or resource filters as necessary.

Including a Pre-Collation operation
This is only available for an estimate created using the standard style (not BOR), and allows you to manage high
section count binding operations by including pre-collate operations.
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Steps to create a pre-collate operation are as follows:
1.

Select the required operation and change the number of included sections down to the required
level to fit on the resource. The adjustment made must account for the addition of any precollected sections.

2.

In the above example the number of 16pp sections included is reduced to nine. This will reduce
the total number of sections included in the operation to 10 thus allowing for the addition of a precollate section.

3.

Click Add Pre-Collation. A Wire Stitched finishing operation will be added that includes the
components entered for the binding operation.

4.

As, in this example, the 4pp cover is already included in the binding operation, this component can
be removed from the pre-collate operation. Select the cover and click Remove.

5.

A message window will appear asking you to confirm your selection. Click OK to confirm and
continue.
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6.

For the remaining print sections, click Include and select the number of sections to be included in
the pre-collate operation. The application will automatically restrict your choice and only allow you
to choose from the remaining available number of sections, in this example, seven.

7.

Upon creation of the pre-collation operation the number of sections against the original operation is
automatically incremented by one.

8.

Further pre-collation operations can be added if required.

Adding Finishing Operations
1.

To add additional finishing operations click Add Operation.

2.

A new finishing operation is added and will default to the main enquiry finishing style and quantity.

3.

To change, click the F/S field and select the required finishing style and set the required quantity.

4.

Click Add and the Section Addition window will open.

5.

Select whether the print section to be included in the operation is either a print section you are printing
in house (Estimate Section) or a supplied component (Added Section).

6.

Click the Section field and select the print section.

7.

Click Apply if you wish to save the change but keep the Section Addition window open or click OK to
save the change and close the window.

Adding Cutting and Folding
Cutting and folding operations will automatically be included as separate finishing operations based on the print
routes calculated and selected, and finishing style of the enquiry.
Note

If application setting id 46 for Estimating is entered as 1 (True), then a saddle stitched enquiry that
contains a 4pp section (text or cover) that is printed using a sheeted or sheetfed process will not
automatically include a folding operation.

If entered in Estimating Maintenance, additional default information that is required to calculate the cut and fold
operations, such as number of cuts, fold number up and number of folds required will also be entered
automatically, however you can amend this default information as appropriate. For further details on the cutting
and folding defaults, see the System Admin for Estimating 5.4 User Guide.

Opening an Enquiry in Estimating | Estimating User Guide 5.4 l 153

Adding Cutting and Folding

Note

1.

To add additional cutting or folding operations click Add Guillotine/Folding. The Add
Guillotine/Folder Options window will open.

2.

Choose either Guillotine or Folding operation type.

3.

Select whether the print section to be included in the operation is an Estimate Section (printed inhouse), or an Added Section (the component is entered as supplied, pre-printed to you).

4.

Based on the selection, select the Section to be included.

5.

Click Apply if you wish to save the change but keep the Add Guilotine/Folder Options window open
or click OK to save the change and close the window.

6.

For any additional cutting operation you need to enter the No of Cuts that will be required during
the guillotine operation. If a folding operation has been entered you will need to enter the Fold No
Up, No. Folds and Fold Style.

If application setting id 35 for Estimating, (Advanced Guillotine) is entered as 1 (True), then you must
also enter the Cut No Up and Lift Height when a cutting operation is included in the estimate.

Viewing and amending the finishing requirements for an estimate created from
a BOR style estimate
The main function of BOR is to create a production scenario that requires minimal manual adjustment by you and
allows correct allocation of wastage levels at operation level and for this information to back calculate to the
press components to ensure that the running times, paper requirements are 100% accurate. As a consequence,
when adding additional finishing operations into the estimate, the process is slightly different to that detailed
above, as you need to not only add the operation, but also confirm its position (or sequence) in the production
scenario.
There are two methods for adding additional finishing operations into an estimate created from a BOR template.
•

Using Bill of Routing and Finishing Definition

•

Using Add Operation

Using Bill of Routing and Finishing Definition
It’s often very difficult to visualize the production flow of an estimate, particularly if there are a lot of finishing
operations to be performed. The Bill of Routing and Finishing Definition window provides a visual
representation of the production flow and allows for certain aspects of it to be adjusted within the diagram.
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From the Estimate Finishing window, Click View Process…

The Bill of Routing and Finishing Definition window will open.

This window presents a graphical representation of the process flow.
The green column represents the print elements.
The blue column represents how the print elements are being produced and on which press resource.
The Yellow area represents the finishing operations are included.
Much like a flow chart, the graphical representation links each of the operations in order with the correct print
elements following a particular path.
Green and Red icon indicators are available against each operation. Where the indicator is green, the operation
has calculated successfully. On initial creation, only the print elements will be indicated with the green icon.
Where the operations show a red indicator, these have not been calculated or have failed to calculate previously
(useful when trying to work out why your estimate calculations won’t complete).
Against each operation is a read only quantity value and an editable wastage field. If the wastage value is
manually changed against an operation, all previous linked operations and print components will also increase.

Operation
Quantity

Wastage Percentage

In the above example, the 64pp by default showed a production quantity of 260,151 copies.
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However, in the example below, the wastage for the Spiral Bound operation has been adjusted to 10% and the
Binder Gathered operation has been changed to 3%. The total print quantity for the 64pp component has now
increased up to 288,944 copies. Just by changing the wastage value against any operation, all previous linked
operations or components will increase automatically to accommodate this higher/lower requirement.

Adding finishing operations using View Process
There are three options available from the toolbar.
•

Add Operation

•

Insert After

•

Insert Before

Note

Both the Insert After and Insert Before options are also available by selecting an existing operation, right
click and choosing the appropriate option from the shortcut menu.

Add Operation
1.

Click Add Operation to create a new operation to be included but will not be linked in anyway in to the
diagram, this would have to be done manually by the user. In the following example a cutting (guillotine)
operation is added using Add Operation.

2.

In the above example a cutting operation needs to be included before the Perfect Bound operation, but
the same method can be applied if you need to add a folding operation.

3.

Click Add Operation.

4.

The Add New Operation window will open. Select the cutting operation from Finishing Style.
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5.

Upon selection, click OK to confirm and the cutting operation will now be included.

6.

You need to remove the link between the printed cover to the perfect bound operation. Select the Cover
operation and click Delete Outputs.

7.

Drag the cutting operation to be inline with the printed cover and the perfect bound operation (for visual
purposes only). Click on the printed cover operation and drag over to the cutting operation. This will
create the link between the printed cover and the cutting operation. Now do the same for the cutting
operation to the perfect bound operation to create the link.

8.

Click Apply to save the changes.

9.

Click OK to close the window. Within the Estimate Finishing window the additional operation has been
included with the correct print sections included.

10. Select the newly created operation. For a cutting or folding operation enter the No of Cuts or the Fold
No Up, No. Folds and Fold Style respectively.
Insert After
An example of the Insert After option is shown below.
1.

Click the operation that will immediately precede the new operation. In this example this is the Spiral
Bound operation.
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2.

Click Insert After from the toolbar (or shortcut menu) and the Add New Operation window will open.

3.

Select the finishing style for the new operation from the list of options. The options available are entered
in Estimating Maintenance > Miscellaneous > Finishing Styles.

4.

Click OK to add the operation and save the changes.

5.

The operation is now included with all the required links automatically created.

6.

Enter the wastage percentage for the newly created operation.

7.

Click Apply to save the changes. If a waste percent has been added to the new finishing operation, the
application will back calculate and update the operation quantities for those preceding operations that
are linked to it. If you have not entered a waste percent, upon closing the above window, the application
will open a message window asking you to confirm if you wish for the default overs to be included.

Insert Before
The method to include a new operation before an existing operation, is the same method as for Insert After,
except the new operation will be precede the selected operation rather than after it.

Removing Operations, Inputs and Outputs using View Process
Managing the finishing workflow extends to removing operations and deleting inputs and outputs.
Removing an Operation
1.

Select the operation to be removed. Either right click and choose Delete Operation from the shortcut
menu or select Delete Operation from the toolbar.

2.

You will be asked to confirm your selection. Click Yes to proceed, or No to cancel the delete process.

3.

The operation will be removed.

4.

The removal of the operation may require some manually adjustment to the workflow. In the example
below, a cutting operation was removed. This has left the cover component with no link in place to
subsequent finishing operations.
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5.

To recreate the link, select the operation and drag it over the operation into which it will be the input. In
this example, the folded cover is to be one of the inputs for the Punch operation.

6.

Click Apply to save the change. The operation quantity (which had changed to 0 when the link had
been broken) is now automatically calculated.

7.

Click OK to close the Bill of Routing and Finishing Definition window.

Deleting an Input
1.

Select the relevant operation and click Delete Inputs form the toolbar or shortcut menu. In the example
below we want to remove the inputs from the Punch operation. Select the Punch operation, right click
and chose Delete Inputs from the shortcut menu. You can see that the operations that the inputs and
outputs are highlighted in red.

2.

As soon as Delete Inputs is selected the links are removed.

3.

The operation will remain but will no longer be linked to previous operations as shown above.
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4.

To re-create the links within a process flow, drag and drop an unlinked item on top of another that you
want to link to.

Deleting an Output
This process is the same as for deleting an input, with the difference the output links are removed between the
operations.
When you close the Bill of Routing and Finishing Definition window any changes, additional operations added
etc., will now be present in the Estimate Finishing window.

Adding/Removing operations from the Estimate Finishing window
Operations can be added or removed directly in the Estimate Finishing window.
To remove, select the operation and click Remove. However, caution is advised if using this method to remove
an operation from an estimate created from a BOR as the input and outputs as you may find that remaining
operations have no inputs and this will force the calculation to fail.
In the example below, the Spiral Bind operation has been removed and as a consequence the process flow has
been broken and now there is no input into the Punch operation.

As a consequence we recommend that if you are removing operations within an estimate created from a BOR,
that you use the View Process method.
Adding an operation
1.

To add an operation, click Add Operation.

2.

The Add New Operation window will open.

3.

The application automatically enters the Main and Sub Process number as the next sequential number,
making the assumption that the new operation will be included at the end of the existing series of
operations. If you wish for the new operation to be inserted between existing operations, then this
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should be managed within the Bill of Routing and Finishing Definition window.
4.

Enter the Finishing Style and click OK to save the change. When viewing the list of finishing style
options available, if you press the first letter of the name of the finishing style, for example H for
handwork, the list will automatically jump to the finishing styles that start with that letter.

5.

The new operation will be added into the list. You will now need to enter the component that will form
the input of the operation.

6.

Select the newly added operation.

7.

In the above example you will note that the Component Identification area of the window has no
content. Click Add to select the input for the operation. The Section Addition window will open.

8.

You can now choose either the input by selecting a print section you are printing in house (Estimate
Section) or a supplied component (Added Section), or you can choose the Operation Output. The
Output Operation allows you to choose the operation into which the newly created operation will feed.
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9.

In the example below, the Output Operation has been selected and the list of Sections now displays the
finishing operations already included in the finishing process flow.

10. Enter the section and click Apply to save the change and keep the Section Addition window open or
OK to save the change and close the Section Addition window.
11. If you select an Operation Output that is already an input into another operation the following message
window will open.

12. Click Re-Assign or Cancel to clear your current selection and to open the Section Addition window
again, click Split if you want the input to be split between the existing operation into which it feeds and
the operation you have just entered.

Resetting the BOR
Throughout the process of managing and making changes to the BOR process, you may wish to reset back to
the original template.
1.

To do this, click Tools > Reset > All (for this Quantity and Style).

2.

A message window will open asking you to confirm your choice, as ALL changes relating to the BOR
will be lost.
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3.

Click Yes to proceed or No to cancel.

4.

After confirming the reset, the BOR finishing process flow will now be reset back to the process flow as
contained within the BOR template in Estimating Maintenance.

Materials
You can assign materials to a finishing operation so that the cost and price for the material is included in the
calculation and subsequent price to your client.
If materials have been entered in Estimating Maintenance for the finishing style, for example, wire for saddle
stitching or glue for perfect binding, they will automatically be included and there is no need for you to add them
at this stage of the estimate version.
If you’re unsure if the material has automatically been included or you wish to add a material to the finishing
operation click Materials to view or add this information.
If materials are already included the details will display.

In the above example, a stitching wire material has been added to the finishing style of Saddle-stitched. For each
copy that is run through a stitching resource, 40mm of stitching wire will be included in the cost and added in to
the estimated materials.
You have the ability at this point to override any of the values or even add in another material that you would also
like to be included in the cost and price calculation of the estimate. Or, if you prefer, you can remove the material
items.
To change an existing material entry, select any of the fields containing values and overtype the value. Click Add
or Delete to enter additional materials or to remove existing entries.

Adding Bindery Extras in Estimating
Bindery Extras allows you to enter penalties to binding operations in the same way as the press. This will allow
you to enter additional make ready time, overs, speed variations and cost and price variations.
Bindery Extras are not included by default and need to be added to each Estimate Version for inclusion in the
calculation.
From within the Estimate Finishing window, click Extras.

Opening an Enquiry in Estimating | Estimating User Guide 5.4 l 163

The Bindery Extras window will open so that you can add and remove the required extras and add and remove
any associated materials.

Only valid extras that have been entered for the finishing resource in Estimating Maintenance can be chosen and
the same extra cannot be chosen twice.
Each aspect of the extra is applied to the calculation in the following way:
Extra Hoppers
We calculate the base number of hoppers as now (including any additional operations) and add the extra
hoppers as specified. If multiple extras are specified then the number of hoppers is accumulated.
Modes and speeds must support the total number of hoppers to be valid.
Extra MR Hours
We calculate the base make ready as now (including any additional operations) and add the extra MR time
specified. If multiple extras are specified then the MR time is accumulated.
Extra MR Assistants and Extra Assistant Rate
We calculate the base number of assistants and assistant cost/price. The Extra MR assistant numbers and rate
are added to these numbers.
Extra Running Assistants and Extra Assistant Rate
We calculate the base number of assistants and assistant cost/price as now (including any additional
operations). The Extra Running assistants cannot be added to this number as the assistant rate to be applied
may differ from the site assistant rate. Therefore these values are saved separately.
Extra Speed Reduction %
The extra speed reduction % is considered in line with any other speed reduction that may apply. i.e. if a
pagination and/or quantity speed reduction also applies then only the highest overall speed reduction is used.
Maximum Run Speed
If a maximum running speed has been specified then at the end of the calculation the calculated speed is
checked against the maximum speed for all incurred extras and additional operations. If the speed has been
exceeded then the speed is set to the maximum.
Extra Cost Rate
We calculate the base cost rate as now (including any additional operations) and add the extra cost rate
specified. If multiple extras are specified then the cost rate is accumulated.
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Extra Sell Rate
We calculate the base sell rate as now (including any additional operations) and add the extra sell rate specified.
If multiple extras are specified then the sell rate is accumulated.
Extra Mark Up %
We calculate the base mark-up % and add the extra mark-up % specified. If multiple extras are specified then
the mark-up % is accumulated.
Binding Extra Materials
Binding extra materials are to be calculated and stored in the same manner as finishing operation materials.
Default bindery extra materials are included automatically.

Reviewing the Outwork Pricing Details
If application setting id 2 for Estimating Finishing is entered as 1 (True) and a finishing route is entered as
Outwork and a Supplier name has been entered within the Site field, the Details button is will become available.
Click Details to open the Finishing Detail – Reprice Route window.

This window allows you to enter or override costs and prices for the outworker selected.

Section Assignment
The Component Identification area of the Estimate Finishing window allows you to review and or amend the
section that will feed into the finishing operation. As a minimum, at least one section and or one insert must be
assigned to the finishing operation so that it can calculate and offer routes for selection.

Opening an Enquiry in Estimating | Estimating User Guide 5.4 l 165

In the following example, a perfect bound finishing operation has two inputs: the cover and text components.

Field Name
Sec No
Description
Printable Sec
NTL

Description
The component id number that contains the section.
This is the component title.
This is the pagination of the printable section. This can only be changed if the printable
section is a sub part of the main component.
Number Like This. This indicates the number of identical printable sections, for example 1
x 96pp component printing as 3 x 32pp, the NLT would be 3.
This can only be changed if the printable section is a sub part of the main component.

Include

Weight to Bind

This displays the number of the printable sections to be included in the operation. This
can be amended, for example when adding pre-collate operations. See the Including a
Pre-Collation operation chapter earlier in this guide.
This is the calculated weight of the included sections. See the Weight to Bind chapter
earlier in this guide.

At the bottom of the Estimate Finishing window there are two additional fields: Handwork Hours and Total Hands
(Override). These values should no longer be used, instead you should add in Bindery Extras to allow for
additional hand work.
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Insert Assignment
The third area of the Estimate Finishing window allows you to enter inserts or additional operations for inclusion
in the calculation of the estimate version.

If your estimate is based upon the standard style and items have been added within the Additional Finishing
window, these will automatically be included.
If no entries exist, click Add to create a new line so that you can enter the data.

Field Name
Operation Type
Description
Quantity

Description
Enter the insert type. The options available are entered in Estimating Maintenance >
Miscellaneous > Additional Ops.
The description field will defaults to the Operation Type after this is entered and you can
amend this as required.
Enter the quantity of operations to be included. When an operation is entered the
finishing operation quantity will automatically populate. If you change the quantity, then
the % field will automatically update.

%

Enter the percentage of the finishing quantity that the operation quantity is for. By default
this will be 100%. If you change the percentage value, the operation quantity will
automatically update.

Start Point

Enter the quantity in the run where the operation is to be included. By default this will be
0, but you can choose to start the in-line operation after the finishing operation has
already commenced. For example, if the finishing operation has a quantity of 75,000
copies, but the first 25,000 copies do not include the inline operation, then the start point
would be 25,001.
If many inserts are assigned to the operation with different start points the application
works out a profile of concurrent inserts and calculates the cost/price accordingly.

Weight Per Unit

If known, you can enter the weight of the inline operation. If entered, the weight will be
included in the overall weight of the finished product.

Calculate
When an estimate is created from a BOR template, you can choose to calculate the estimate version from within
the Estimating Finishing window. For details of calculation, please see Estimate Version Calculation later in this
guide.
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Packing
If you are using the Advanced Packing module, this additional button is available so that you can enter the
packing requirements for the estimate. For further details see the Advanced Packing chapter earlier in this guide.

Set Quantities
This option is available when the enquiry includes multiple quantities. Its purpose is to allow you to apply any
changes made to the version and quantity that you may have made, and apply the changes to all the quantities
within the enquiry.
To apply the changes to all quantities, click Set Quantities. The Set Quantities window will open.

You can then choose which quantities you wish to apply the changes to.
Note

If application setting id 134 for Estimating is entered as 0 (False) then the press routing across the
quantities has to be the same, for example the press routes have to have the same configuration
selected, for the copy to proceed. When the application is able to validate the press route selection,
then the finishing operations for the other quantities are deleted prior to copying from the current
quantity.

Note

This will not work if the different quantities have different section breakdowns. For example, quantity 01
has a breakdown of 4pp cover + 3 x 32pp text, and quantity 02 has a breakdown of 4pp cover + 6 x
16pp. If quantity 01 has amendments made to the finishing operations, you will need to manually apply
any changes to quantity 02 separately.

Mixed Quantities
If you have entered components with quantities that are different to the enquiry quantity you may need to do
some further adjustment within the Estimate Finishing window. For example, an enquiry has been created
whereby the main enquiry quantity is 100,000 copies. However, 25,000 copies include a 4pp cover on 115gsm
and 75,000 copies include a 4pp cover on 130gsm, the text is the same throughout.
Applying mixed quantities in an estimate version.
1.

Ensure that the two cover components are added to the estimate and that the Quantity override has
been entered. Calculate and select the routes for the print components in the normal manner.
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2.

Either click Add or Change to open the Estimate Version Assignment window.

3.

Ensure that all the required components are included.

4.

Click Finishing to open the Estimate Finishing window.

5.

Additional cutting and folding operations will be included as per the application rules. Select the final
operation, and as illustrated above, the Component Identification is incorrect and needs to be changed.
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6.

Using the example above, remove one of the cover inputs into the perfect binding operation and change
the Product Quantity for the finishing operation.

7.

Add a new operation for the 4pp cover + 96pp text for the remaining 25,000 copies. When the operation
is added the product quantity will default to the enquiry quantity and this needs to be changed. For the
newly added operation, include the component identification.

8.

In the above example the estimate has been created using a BOR template, but the process is the
same if the estimate has been created using the standard style.

9.

Click View Process (if available) for a visual representation of the product process flow.

10. Now the correct quantities and component inclusions have been entered you can proceed with the next
step in the estimate calculation.
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Estimate Version Calculation
Once all the required finishing operations, packing, delivery and ancillary items have been entered in the
estimate, then the version can be calculated.
Note

As part of this routine the chosen press routes are re-calculated to draw in the correct binders overs.

Calculating an estimate version
1.

Select the estimate version to be calculated. If the Version Number is highlighted red, this indicates that
the version is not currently calculated.

2.

Click Calc….

The Calculating Route window appears and the calculation process begins. The routine goes through five
stages of calculation:
1.

Re-Calculation of the press components.

2.

Calculation of the finishing routes.

3.

Calculation of packing requirements.

4.

Calculation of delivery requirements.

5.

Calculation of ancillary items.

If a finishing route cannot be calculated an Engine Notification window message will open informing you that
the process has failed.
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3.

Click OK and the will application continue to carry on checking and calculating all other finishing
operations. The warning is in place to advise you that routes have not calculated and the price will not
be correct and therefore, you need to return back to the Estimate Finishing area to correct the
operation.

Possible causes of the above warning being returned during calculating are:
1.

No input parts (or materials) are defined against the operation.

2.

The specification of the input parts to the operation exceed the limitations of the available resources.

3.

Valid Cost/Sell rates are not available against the finishing resources within Estimating Maintenance.

4.

The finishing resource has been created within Estimating Maintenance but has not been made
available as a finishing for the estimators. Check that the resource is listed in the ‘Finishing Site Link’
table for the users site within the Site tab of Estimating Maintenance.

Choosing the Finishing Routes
Once the finishing routes have been calculated the Finishing Route Selection window will open. The selection
process has to be repeated for each combination of finishing style and quantity.
If application setting id 1 for Estimating Finishing is entered as 1 (True), the application will present all possible
options, both in-house and outwork (even if outwork has not previously been selected within the Estimate
Finishing window.

Field Name
Finishing Style
Quantity
Del to
Customer

Description
For enquiries that include multiple finishing styles, select the finishing style to view and
set the finishing route.
For enquiries that include multiple quantities, select the quantity to view and set the
finishing route.
For a BOR style estimate, select the final finishing operation to make the value of the
delivery to the customer available.

172 l EFI Technique 5.4 | Estimating User Guide

Field Name

Description

Cost inc Del

If the finishing operation includes any delivery elements then this information is displayed
at the top of the window to help the route choice. Click the route selection options and this
value will change as appropriate.

Total Route
Cost

The total cost for the route selected.

Total Route
Price

The total sell price for the route selected.

Size
Resource

Displays the size associated with the mode as entered in Estimating Maintenance >
Finishing > Modes & Speeds.
The resource name that is capable of producing the finishing operation. The name is
preceded with the site location of the resource. If it’s an outwork resource, then Outwork
will precede the outworker name.

No Up

The number of identical products that can be produced in one pass of the operation. If
application setting id 62 for Estimating is entered as 1 (True), then you will only be offered
routes where the number up for the binding operation is equal to or less than the number
up for the printing of the sections that feed into the finishing operation.

Freeze

Select this check box if you have multiple operations, and the scroll bar is available. The
Size, Resource and No Up fields will stay visible even when you scroll to the right of the
window.
The Finishing Route selection window can also be maximized to aid visibility of the routes
calculated and available for selection.

Show available
capacity on
route selection

Select this check box and two new fields will become available that show what available
and required capacity each in-house resource has in the two weeks leading up to the
delivery date entered in the enquiry.
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Field Name

Description

View Detail

Click View Detail to open the Finishing Route – View Detail window. The same window
can also be opened by double clicking the route.

Set for All
Quantities

For an estimate that includes multiple quantities, you can click Set for All Quantities to
confirm the default route selection for all quantities. However, if you wish to review the
routes first, click the Quantity field and select the quantity as appropriate.

Route Status

Click Route Status to review the current the status of the route selection.

This is particularly useful when the estimate contains multiple finishing styles and
quantities to allow you to see which options have not yet had a route selected.
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Field Name
Reprice

Description
Click Reprice to open the Finishing Detail – Reprice Route window.

You can change the prices calculated (fields highlighted in yellow) at this stage of the
calculation or within the Reprice Estimate window when the calculation has finished. For
more information on the content of this window, see the Repricing chapter later in this
guide.
Estimate
Finishing

If a route has failed to calculate or you wish to modify the finishing operations, click
Estimate Finishing to open the Estimate Finishing window. When you have finished
modifying the operations, click Continue and the calculation process will resume at stage
two and re-calculate the finishing route incorporating any changes that might have been
made.

Click on the route to select it. By default the application chooses the lowest cost options. If application setting id
51 is entered as 1, then the least cost route, regardless of whether it’s in-house or outwork will, by default be
selected by the application.
Once all the required routes have been selected click Continue to carry on with the version calculation.
Once the finishing routing has been chosen the calculation will continue and calculate the remaining stages.
When all stages have completed the Reprice Estimate window will automatically open.
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Reviewing the estimate calculations
After setting the preferred finishing operation routes, the Estimating application will continue to calculate all other
elements require such as packing, deliveries etc. Once all values have been calculated, the Reprice Estimate
window will open.

The Reprice Estimate window displays all costs and pricing included in the estimate as well as providing the
means to adjust all pricing, and also the ability to generate the Quotation letter to the customer.

Field Name

Description

Enquiry

The enquiry and revision number.

Version

The estimate version and version title. If you have selected to group multiple versions to
be output on one quotation, this field will allow you to switch between the different
versions. For further details, see Multi-version estimates later in this guide.

Product Weight

This is the calculated weight for a single product.
The calculation for each component is:
(Trim size depth x Trim size width) x gsm / 1000 x (No. of Pages / 2) / 1000 + Product
Weight Uplift = Component Product Weight
Each part is added together to calculate the product weight.
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Field Name
Finishing Style
Quantity

Description
For enquiries that include multiple finishing styles, select the finishing style to view and
set the finishing route.
For enquiries that include multiple quantities, select the quantity to view and set the
finishing route.

Press
Press Route

This is the component title and pagination.

Site / Press

This is the Site location and resource that has been selected for the printing operation. If
an outwork route has been selected, the supplier name will display. It will display Bought
In, if you have used Bought In to obtain a cost for the component calculation.

Cost / Rate

This is the hourly cost rate for the printing resource as entered in Estimating
Maintenance > Press > Rates.

AV Rate

This is the calculated hourly Added Value Rate for the printing resource.
If the sell rate for the resource is cost + mark up percent, as entered in Estimating
Maintenance > Press > Rates, this will be calculated as cost rate * mark up %.
If the sell rate for the resource is entered in Estimating Maintenance > Press > Rates
based on Apply AV, then the value entered in Estimating Maintenance > Press > Rates
> Sell Price will be the AV Rate.
For outwork and bought in calculations this will be 0.

Route Cost

This is the route cost for the resource selected and includes Pre-press planning labour,
Plate labour, Plate / Cylinder costs, make ready and running costs, ink and other material
costs, including cells. Basically everything to produce the component on press, except the
paper cost. This is itemized separately within the Reprice Estimate window.

Mark Up %

This is the mark up percent value between the route cost and route price, for the resource
selected.

Route Price

This is the sell price for the route. It is calculated as Route Cost * Mark Up %.

Show costs as

Cost values for each element can be switched between Standard and Direct values.
When the Standard option is selected, the values shown within the Cost will be the true
cost values based on the cost rate per hour entered in Estimating Maintenance > Press
> Rates.
The Direct option will show slightly different cost values and is essentially used in
conjunction with the Contribution. The cost value shown when using this option will be
the total sell price for the element minus its contribution value. Likewise, the Total Sales
price minus the Contribution value should equal the Total Direct Cost.

Other
Cost
MU%
Sell

This is the cost value for each of the elements included in the estimate.
This is the mark up percent for each of the elements included in the estimate.
Total sale price = Pre Press Labour price + Pre Press Material price + Plate Labour price
+ Plate Material price + Print Labour MR price + Print Labour Run price + Print
Material price + Ink price + Paper Labour price + Paper Material price + Finishing Labour
MR price + Finishing Labour Run price + Finishing Material price + Insert Labour price +
Insert Material price + Ancillary Labour price + Ancillary Material price + Outwork price +
Packing price + Delivery To Binder price + Delivery To Customer price + Material price
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Field Name
Base Price

Run On

Description
The Base Price cannot be changed and permanently displays the sell prices for each
element of the estimate based on the original calculations. It allows you to view any
pricing variations that may have been made within the Reprice Estimating window. For
example, the Sell price may have changed by the Base Price will remain constant, until
either the print component or estimate version is re-calculated.
This displays the sell price run on and is calculated as:
Total Sell – Make Ready sell / Quantity.
If application setting id 9 for Estimating has been entered as 1, no run on values for
delivery will be included in the calculation.

Run Back

The sell price run back is calculated as:
Sell Run On * Run Back percentage.
You can adjust the run back percentage within the Reprice Estimate window by entering a
new value. A default run back percentage can be entered. For further details see the
System Admin for Estimating 5.4 User Guide.

Elements
Print Total

The sum of the press routes.

Pre-Press

If you wish to review and or reprice any pre-press activities that have been included in the
estimate, click Pre-Press. The Reprice Pre-Press window will open.

Paper

If you wish to review and or reprice the paper requirements that have been included in the
estimate, click Paper. The Reprice Paper window will open.

Binding

If you wish to review and or reprice any finishing operations that have been included in
the estimate, click Binding. The Finishing Detail – Reprice Route window will open.

Materials

If you wish to review and or reprice any material items that have been included in the
estimate, click Materials. The Reprice Material window will open.

Packing

If you wish to review and or reprice any packing items that have been included in the
estimate, click Packing. The Reprice Packing window will open.

Delivery

If you wish to review and or reprice any delivery items that have been included in the
estimate, click Delivery. The Route Delivery Costs window will open.

Specials

If you wish to review and or reprice any ancillary items that have been included in the
estimate, click Specials. The Reprice Ancillaries window will open.

Discount

If a rebate discount has been entered within the Enquiry Detail, the discount value will
automatically populate this field and the percentage discount will also display.
The calculation of the discount can be either for Added Value only or you can specify that
the discount is to be calculated based on the added value of the estimate and to include
the material calculations as well.
Added Value only:
(Added Value / (100 - discount percentage)) * discount percentage
Apply to Material
(Total Sales / (100 - discount percentage)) * discount percentage

Quote Total

This is the Sell price, in your currency, that will be sent to your client.
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Field Name
Restore

Contribution %

Description
If you have repriced the estimate, but wish to restore all calculations back to the original
calculated Base Price, click Restore. Any changes you have made since the initial
calculation will be deleted. This allows you to reset the pricing without having to recalculate the estimate version and re-select routes etc.
If application setting id 27 for Estimating is entered as 1, the Contribution % value for the
estimate will display.
Contribution / Total Sales * 100 = Contribution percent.

Contribution

If application setting id 27 for Estimating is entered as 1, the Contribution value for the
estimate will display.
Price – Material Cost – all non-labour parts of Cost = Contribution.
So, if the cost rate (as entered in Estimating Maintenance > Press > Rates > Elements
is split out by Labour, Fixed, Depreciation etc., the application will deduct the value for the
elements which are not Labour.
Press Contribution = Added Value - ((Make Ready Cost + Run Cost) * Labour%) - PrePress
Bindery Contribution = Added Value - ((Make Ready Cost + Run Cost) * Labour%) (Extra Operator Cost + Handwork Cost + In Line Op Cost + In Line Extra Operator Cost)
Added Value and Contribution are calculated on a route-by-route basis and then summed
to display the value in the Contribution field.

Added Value %

If application setting id 27 for Estimating is entered as 2, the Added Value % for the
estimate will display.
Added Value / Total Sales * 100 = Added Value percent.

Added Value

If application setting id 27 for Estimating is entered as 2, the Added Value for the estimate
will display.
Added value = Total sale price - (Ink cost + Paper Labour cost + Paper Material cost +
Material cost + plate Material Cost + pre Press Material Cost +
click Cost + packing Cost + delivery To Customer Cost + delivery To Binder Cost +
ancillary Labour Cost + ancillary Material Cost + outwork Cost)

AV %

If application setting id 27 for Estimating is entered as 2, the AV % for the estimate will
display.
This is the percentage difference between the Base AV price and the Repriced AV price.
Quoted Added Value / Baseline Added Value x 100%

Exclude
binding when
recalculating
new selling
price

If you wish to re-price the Total Sales value, but do not wish any finishing operations to be
included in the re-price, then you must ensure that this check box is selected.

Reprice By %

Click Reprice By % to open the Reprice window. For further details, see Re-pricing the
Estimate chapter later in this guide.

Print
Close

Click Print to print the Reprice Estimate window.
Click Close to close the Reprice Estimate window.
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Field Name

Description

Workings

Click Workings to generate the internal Workings documentation. For further details, see
Estimate Workings chapter later in this guide.

Quotation

Click Quotation to open the Quote Design window. For further details, see Generating
the Quotation Letter chapter later in this guide.

If you have closed the Reprice Estimate window but wish to review the information again, from the Enquiry Detail
tab, select the estimate version and click Reprice.

Alternatively, click Reprice Estimate from the Actions pane.

Re-pricing the Estimate
The application supports numerous methods of re-pricing the estimate. In summary they are:
•

Type in an overall price and run-on values.

•

By percentage.

•

By individual elements.

Total Sales Re-Price
One of the re-price options available is the ability to enter a new overall selling price for either the Total Sales
price or Total Run On price.
Changing the Total Sales or Run On
1.

Within the Reprice Estimate window, enter the new Total Sales value within the Total Sales field. Then
either tab or click into a different field.
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2.

The application adjusts the added value (mark up %) on a pro rata basis based on the Added value of
each of the press and bindery routes to achieve the new price. If required the bindery routes can be
excluded from the calculation. To do this click Exclude binding when recalculating new selling
price.

3.

The Total Sales Run On value is adjusted, the Total Sales Run Back value will also adjust accordingly
based on the percentage values defined against each pricing area.

4.

To change the Total Sales Run On value, enter the new value in the Run On field.

5.

The Total Sales Run Back value will also adjust accordingly based on the percentage values defined
against each pricing area.

Re-price By %
The second option to re-price the estimate is to do so by applying a percentage value to the make ready and
running prices.
Changing the Price of an estimate using Re-price by %
1.

From the Reprice Estimate window, click Reprice By %.

2.

The Reprice window will open.
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3.

Within this window, based on the finishing style and quantity you can re-price individual elements, or
choose to re-price all.

4.

Enter the required MR Reprice % and Run Reprice % values. You can enter negative values if you
wish to reduce the sell price.

5.

Click OK to save the changes and close the Reprice window. The selected pricing is uplifted or reduced
by the % factors.

Note

Caution should be used if applying further percentage changes as they are applied on a accumulative
basis.

Re-price Individual Elements
Each individual element of the estimate can be re-priced.

Press Routes
Re-pricing in house print routes
1.

To re-price an individual in-house press route double click the chosen print route.

2.

The Reprice Press Route window will open.

3.

This window provides you with the ability to adjust the price for the individual elements that produce the
printed component, with the exception of paper (this is managed separately). For example, ink, other
materials, plate costs etc.

4.

You can change the price fields where a cost exists. All cost fields are unavailable for change. When a
price is updated, the mark up percentage will automatically update.

5.

You can also change the mark up percentage as required by entering a new value in the MU% field for
each element. When the mark up percentage is updated, the price will automatically update.
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6.

Alternatively you can enter a new value in the following fields:
a. AV Rate.
b. Low Sell Rate.
c. Speed (Impressions Per Hour).
d. MR Hours.
e. Run Hours.
f. Total MR.
g. Run per ‘000.
h. Budget Price.
i.
Low Sell Price.

7.

Click OK to save any changes and close the Reprice Press Route window.

Re-pricing in outwork print routes
1.

To re-price an individual outwork press route double click the chosen print route.

2.

The Reprice Outwork Route window will open.

3.

You can change the following by entering a new value.
a. MR Cost
b. Cost Per ‘000
c. Print Cost
d. MU%
e. Print Price
f. Route Price

4.

Click OK to save the changes and close the window.

Re-pricing in bought in print routes
1.

To re-price press route that has been calculated using the Bought In module, double click the chosen
print route.

2.

The Reprice Press Route window will open.
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3.

You can only change the Budget Price. Enter the new price and click OK to save the change and close
the window.

Pre-Press
If you have entered pre-press activities for a component you have the opportunity to change the pricing as
required.
Re-pricing pre-press activities
1.

To re-price pre-press activities click Pre-Press.

2.

The Reprice Pre-Press window will open.

3.

You can choose which component you wish to re-price. Click Section and select the component.

4.

All costs fields are unavailable for change.

5.

You can change the following by entering a new value.
a. MU (%)
b. Lab. Price
c. MU (%)
d. Mat. Price.

6.

Enter a new value in the labor or material mark up percent, or the labor or material price. Dependent on
which value is changed the new MU % or Price is calculated.

7.

Click OK to save the changes and close the Reprice Pre-Press window.

184 l EFI Technique 5.4 | Estimating User Guide

Paper
You can re-price the paper included in the estimate for all components where you, the printer, are supplying the
paper.
Re-pricing Paper
1.

To re-price paper click Paper.

2.

The Reprice Paper window will open. You can adjust the field widths in the top half of the window to
make the information more visible.

3.

Each paper type and size of reel or sheet will be display in the top area of the window. If a number of
components use the same paper then the required amount will be accumulated. If you wish to change
any of the values, enter the data in the bottom half of the window.

4.

Select each paper requirement and the paper calculations will become available in the bottom half of
the window for you to change.

5.

You can change the following by entering a new value.
a. Width (Sell)
b. Depth (Sell) for sheetfed paper
c. Unit Cost
d. Mark Up % (Unit)
e. Unit Sell
f. Paper Sell
g. Mark Up % (Handling)
h. Handling Sell

6.

Changing any one aspect will recalculate the other fields accordingly.
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The Kg’s Sell is calculated as follows:
1. Gross quantity = Nett quantity / no. up + waste% + MR Sheets
2. Grams per sheet = Web width x cut off x grammage / 1,000,000
3. Gross quantity x grams per sheet
7.

Click OK to save and apply any changes and close the Reprice Paper window.

Binding
You can re-price the finishing operations included in the estimate, whether they be in-house, outwork or bought
in.
Re-pricing Binding
1.

Click Binding.

2.

The Finishing Detail – Reprice Route window will open. You can adjust the field widths in the top half of
the window to make the information more visible.
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3.

Each finishing operation will be display in the top area of the window. If you wish to change any of the
values, enter the data in the middle section of the window.

4.

Select each finishing operation and the calculations for that operation will become available in the
middle section of the window for you to change. You can change the following:
a. AV Rate
b. Assistant Rate
c. Copy Speed
d. For Make Ready and Running
i. MU%
ii. Price
iii. Hours
iv. Extra Hours
v. No Of Extra Assistant
vi. Extra Assistant MU %
vii. Extra Assistant Price
e. For Cells
i. No Of (cells)
ii. MU%
iii. Price
f. Total MR
g. Run per ‘000
h. Route Price

5.

Changing any one aspect of the pricing will recalculate the other fields accordingly.

6.

If additional operations have been entered, these will be available to re-price in the bottom half of the
window.

7.

You can change the following by entering a new value.
a. Extra MR Hours
b. Extra Run Hours
c. MU %
d. Total Price
e. Price ‘000

8.

If you have application setting id 123 entered as 1 (True) for Advanced Bindery Assistants, this will be
included within the Operations area of the window.

The calculated number of Log assistants is displayed as Hopper Assistants, and the calculated number
of Bind-In assistants is displayed against the additional operations.
If no inserts are included but the binding operation includes sheeted sections, then the calculated BindIn assistants are added to the Hopper Assistant number.
9.

Click OK to save and apply any changes and close the window.
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Materials
If materials have been entered for a finishing operation (or style), you can re-price the calculated values.
Re-pricing Materials
1.

Click Materials.

2.

The Material Reprice window will open. You can adjust the field widths in the top half of the window to
make the information more visible.

3.

You can change the following by entering a new value.
a. MU %
b. Price
c. MU % (Run On)
d. Run On Price

4.

Click OK to save any changes and close the window.

Packing
You can re-price the packing requirements included in the estimate, whether they have been entered using
standard packing or advanced packing.
Re-pricing Packing
1.

Click Packing.
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2.

The Reprice Packing window will open.

3.

Each packing operation will be available for re-pricing as required.

4.

You can change the following by entering a new value.
a. Pack / Bundle Quantity
b. Pack Price
c. Mark Up %
d. Packing Price
e. Pack Labour Cost
f. Mark Up % (Labour)
g. Pack Labour Price

5.

Changing any one aspect of the information will recalculate the other fields accordingly.

6.

Click OK to save any changes and close the window.

Delivery
If you have entered delivery locations in your estimate, you can re-price the delivery.
Re-pricing Delivery
1.

Click Delivery.
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2.

The Route Delivery Costs window will open.

3.

Each delivery will be available for re-pricing as required.

4.

You can change the following by entering a new value.
a. MU (%)
b. Price

5.

Changing any one aspect of the information will recalculate the other fields accordingly.

6.

Click OK to save any changes and close the window.

Ancillary Items
If you have entered ancillaries in your estimate, you can re-price these via the Reprice Ancillaries window.
Re-pricing Ancillary Items
1.

Click Specials.
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2.

The Reprice Ancillaries window will open.

3.

Each delivery will be available for re-pricing as required.

4.

You can change the following by entering a new value.
a. No Of
b. One Off Cost
c. One Off Price
d. Unit Qty
e. Cost per Qty
f. Price Per Qty
g. MR Cost
h. MR Price
i.
Total Cost
j.
MU %
k. Total Price
l.
RO Price

5.

Changing any one aspect of the information will recalculate the other fields accordingly.

6.

Click OK to save any changes and close the window.

Estimate Workings and Quotations
Both the Workings and Quotation documents can be output by you choosing a template, and generating an XML
data file, to which the template is applied and displayed for you to print or email as necessary. Operating in this
manner allows any number of templates to be written which allows the same data to be output in different
formats, dependent on both your organization structure and your client’s requirements.

Estimate Workings
The Estimate Workings document is designed for internal purposes and often contains information regarding, not
only the specification of the estimate, but the calculations that have been included, such as run speeds, make
ready times, costs etc. As the data can be displayed using your own customized templates, this will output the
information contained in the estimate in a format that is specific to your requirements.
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Generating the Workings
1.

Open the Reprice Estimate window and click Workings.

2.

The Estimate Generation window will open.

3.

If your enquiry has more than one revision, you can generate the document for any of the other
revisions created against the same enquiry number.

4.

Click Template to choose the output format that you wish to view the details in.

5.

By default both the Re-General XML and View document when complete check boxes will be selected.
Each time the document is generated, a new XML file is generated and any previous XML files for the
enquiry and revision will be deleted. Therefore if you want to view the document using the last XML file
that was generated clear the Re-Generate XML selection. This will also save time if you want to print
multiple templates as the extract has already been created. If you only want to generate the XML but
are not interested in viewing the Workings document on screen, then clear the selection for View
document when complete.

6.

When you are ready to output the Workings document, click Generate. During the generation process
the progress can be monitored using the progress bars at the bottom of the window.
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7.

The Document Viewer window will open.

8.

You can Print, convert to a PDF or PDF and Email the document by selecting the appropriate option
from the toolbar.

9.

Click the X in the top right hand corner of the window to close the Document Viewer window. If
application setting id 47 for Estimating is entered as 1 (True), then you will be directed back to the
Reprice Estimate window. If the application setting is entered as 0 (False), then the Estimate
Generation window will still be open.

Quotation Letter
The Quotation Letter is the document that can be sent to your client. There are two stages to produce the
quotation letter.
•

The first is to override any of the default phrases used on the letter and choose the financial level of
detail.

•

The second is to generate the letter.

Generating the Quotation Letter
1.

Open the Reprice Estimate window and click Quotation.
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2.

The Quote Design window will open.

3.

The Quote Design window consists of six (tabs) pages. The first four pages are used, if required, to
override the letters default text. For example, if you wish to override the default color description then
type the required phrase into the Custom Colour field (Page 1).

4.

Against each entry there are a series of check boxes.
Field
Name

Actual
Name

Description

Inc.

Include

Include. If selected, this will include either the default or custom text.

Def.

Default

Default. If selected, the default phrase will be output. If you type into
the custom field, this selection will automatically be cleared. If
selected, any custom entry will be deleted.

Bold

The text can be output in Bold font on the quotation letter.

Bo.

5.

Page 4 allows you to include terms and conditions to be output on the letter. Certain terms and
conditions will be automatically selected based on the nature of the quote. To choose any particular
term simply select the corresponding check box.
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6.

Page six allows you to determine the level of financial breakdown to be displayed on the quote letter.

7.

Click on the boxes to control the financial level. There are a variety of combinations available.
a. Click Print/Finish to toggle the output between Print and Finish as a total price for both
elements, or for each element to be output as separate line items.
In the following example Print and Finish was selected (along with the other items).

b.

The Quotation letter will output as:

c.

In the following example Print / Finish was selected.
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d.

The quotation letter will output as:

e.

In the following example only Total was selected.

f.

As a consequence, the quotation letter was output as:

8.

Click Paper Schedule if you want the paper requirements to be included in the quotation letter.

9.

Once the output requirements have been entered, click Quote to open the Estimate Generation
window. If you want to return to the Estimate Reprice window click Reprice.

10. The Estimate Generation window will open.

11. If your enquiry has more than one revision, you can generate the document for any of the other
revisions created against the same enquiry number.
12. Click Template to choose the output format that you wish to view the details in.
13. By default both the Re-General XML and View document when complete check boxes will be selected.
Each time the document is generated, a new XML file is generated and any previous XML files for the
enquiry and revision will be deleted. Therefore if you want to view the document using the last XML file
that was generated clear the Re-Generate XML selection. This will also save time if you want to print
multiple templates as the extract has already been created. If you only want to generate the XML but
are not interested in viewing the Workings document on screen, then clear the selection for View
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document when complete.
14. By default Show Images will be selected by default and will allow images such as company logos (if
entered in the template) will be visible within the Document Viewer window. Clear this selection if you
do not want these to display. This is particularly useful should you wish to print a copy of the document
on pre-printed header paper.
15. When you are ready to output the quotation letter document, click Generate. During the generation
process the progress can be monitored using the progress bars at the bottom of the window.
16. If you have Prince XML installed and generate your documents direct to PDF, you will receive the
following message window when you click Generate.

17. The Document Viewer window will open. You can Print, convert to a PDF or PDF and Email the
document by selecting the appropriate option from the toolbar.
You can add a default subject line to application setting id 44 for Estimating so that each time an email
is created from the Document Viewer window, this is the format that will be adopted.
If application setting id 66 for Estimating is entered as 1 (True), then you will email from the server
rather than from your computer.
18. Click the X in the top right hand corner of the window to close the Document Viewer window. If
application setting id 47 for Estimating is entered as 1 (True), then you will be directed back to the
Reprice Estimate window. If the application setting is entered as 0 (False), then the Estimate
Generation window will still be open.
Note

When customizing your quotation letter, whether it be entering custom text or changing the financial
output, the Quote XSL template must be designed to support the output values in the XML. If the
template does not support the values, the changes may not work.

Multi Version Quotes
It is possible to produce a quotation document containing multiple pricing options from within the same estimate.
This is useful if the client has requested different pagination, trim size, and grammage options and multiple
versions have been created.
Generating a multi-version quotation
1.

Ensure that the estimate versions to be included in the single quotation letter have been calculated and
any re-pricing options have been entered.

2.

From the Enquiry Detail window, select the Quote check box. This will select all versions. If you have
more than two versions but do not want to include all versions, select the individual version check
boxes.
Select the check box to include all versions
included in the quotation letter.

Select each version check box to include
specific versions in the quotation.
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3.

Quotation now becomes available.

4.

Click Quotation and the Quote Design window will open.

5.

Click Version at the top of the window to switch between each of the included estimate versions and
enter values specific to that version in the available tabs just like you would if it was a single version
quote.

6.

If you enter custom text that is valid for all versions included, click Apply To All to include the changes
to all of the versions included.

7.

You can still make changes to the pricing for each estimate version. From the Quote Design window,
click Reprice and the Reprice Estimate window will open.

8.

Click Version at the top of the window to switch between each of the included estimate versions and
enter values specific to that version.

9.

When you have finished customizing the pricing and display of the individual estimate versions, click
Quote from the Quote Design window. The Quote Generation window will appear for you to continue to
generate the quotation letter in the same manner as a single version quotation.

Note

The Quotation template (XSLT) needs to be configured to allow for multiple versions before this function
will work correctly. Please refer to your Project Manager for details.
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Removing a Version
A version can be removed at any time. Select the estimate version and click Remove. A window will appear
asking you to confirm your selection.

Note

Caution should be used when removing versions if previously used to create a quote or order as all
reference to the quote and its workings will disappear and the orders pricing will become invalid.

Marking an Estimate as Complete
When you have calculated an estimate and generated all necessary documentation, we advise that you enter the
estimate as complete. This will inform other users of the system that the enquiry has been calculated and an
estimate and quotation letter has been created. It can also have an affect on the visibility of the quotation via the
MIS Console application.
If application setting id 45 for Estimating is entered as 1 (True), an email will be sent to the salesperson for the
enquiry.
In the Estimating application, this will move the enquiry from the Active Enquiries view to the Completed
Enquiries view. Within MIS Console, this will move the enquiry from the New Enquiries view to the Pending
Enquiries.
This can be done within the individual estimate revision or from the Active Enquiries view.
1.

Click Complete.

2.

A confirmation message window will open.

3.

Click Yes to confirm and change the status of the estimate, or No, to keep the enquiry within the Active
Enquiries view.

Revising an Enquiry in Estimating
When an enquiry has been submitted and subsequently opened in Estimating the sales enquiry cannot be edited
in Sales Enquiries. Instead, users have to create a revision.
However, in Estimating, whilst you can also revise the enquiry, you can also edit the existing enquiry. We
strongly recommend that the revision process is adopted but it does often depend on the change required.
If the revision is for a completely different format to the original, then it is always advisable to create a revision.
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Revising an enquiry in Estimating
1.

Select the enquiry from either the Active or Completed Enquiries view and click Revise.

2.

The Revise Estimate window will open. It is not mandatory to enter a revision reason (as it is if the
enquiry is revised in the Sales Enquiry module) but obviously, for tracking purposes it is worthwhile to
enter a reason for the revision.

3.

Click OK. A Revise Estimate window will open asking you if you wish to open the new revision. Click
Yes to proceed and open the enquiry revision or No to create the revision but not open the Enquiry
Details window. If application setting id 53 for Estimating is entered as 1 (True), the new enquiry
revision will retain any calculations included in the enquiry from which the revision was created. This is
particularly useful if you have amended pricing so that any new estimate can retain the same level of
pricing as required.

Editing an Enquiry in Estimating
If your client has requested an additional price and you choose not to revise the enquiry you can open the
original revision and amend the details. However, we would still strongly advise that you add to the existing data,
rather than change the existing data, for example, add a component if the grammage is to be different to the
original, or add a new quantity. Changing data can be particularly dangerous if the estimate has already been
used to create an order. A warning message window will open if an order has been created and so you should
proceed with caution.
Editing an existing enquiry in Estimating
In the following example a new quantity has been added to the original enquiry revision.
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As you can from the above, the component and estimate versions have changed from calculated to noncalculated forcing you to recalculate the component and version.
For each component, click Calculate. This will open the Selective Calculation window.

The application recognizes that the original quantity (250,000 copies) already has routes calculated and selection
and has therefore not selected this quantity. You can, if you wish, select the original quantity, but this will
invalidate all existing calculation and route selection, for both the component and any estimate version to which it
is already linked.
Click OK to proceed to calculate and select routes for the additional quantity as required.
The estimate versions will remain with a red highlight. Click Calculate and the Selective Calculation window will
re-open. Again, select the quantity that you require so that the calculation and route selection process can
proceed.
Freezing Pre-Calculated Estimate Version Routes
If an estimate version has already been calculated, re-pricing of the calculated standard prices may have been
performed. If the version needs to be re-calculated for any reason at all, you are given the opportunity to select
the elements that should be recalculated and deselect those that should not where re-pricing may have taken
place.
For the estimate version, click Calculate. The Final Calculation window will open.

There are five options that you can either select or clear, dependent on what you wish to be re-calculated. The
default is to have all options available. If all of them are selected, any existing calculation and possible re-pricing
will be deleted when you click OK.
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However, if only the printing elements should be recalculated, four of the options can be cleared and their
previously calculated values left unchanged, as per the example below.

Note

Binding and Delivery options are directly linked. If, for example, you select Delivery, then the Binding
option will automatically be selected and vice versa.

Enquiry Detail - Tabs
The tabs within Estimating allow you to work within multiple different views at any one given time. From within
the Enquiry Detail window you can click on the Active Enquiries tab, and this will take you back to the Active
Enquiries list but will leave the enquiry tab open allowing you to switch between them.
Using the tabbing functions allows for multiple enquiries to be opened with each enquiry opened simply creating
a new tab.

Re-positioning Tabs
Tabs can also be re-positioned on screen. Instead of switching between open tabs, they can be placed side by
side or on top of each other. To re-position the tabs, click and drag the tab in to the area of the screen that you
want to place it. Once an available position is identified by the application, a grey positional outline will show.
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Side by side tabs
Select one of the enquiry tabs, click and drag and an enquiry tab to the right hand side of the Enquiry Detail
window until the grey outline appears.

Top and bottom tabs
Select one of the enquiry tabs, click and drag and an enquiry tab to the bottom of the Enquiry Detail window until
the grey outline appears.
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Click and drag the separator bar to adjust the size of the re-positioned tabs.

The number of tabs and positions is only limited by your screen resolution. In the example below using a large
resolution screen, four tabs have been dragged in to position using a combination of both the side-by-side option
and the top and bottom option. Again, using the separator bars between each panel, their size can be adjusted.

To remove the multiple enquiry display, click and drag the Enquiry Detail tab back to the tab area at the top of
the window.
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Should you have the available screen space, a useful view could be as follows, having the Active Enquiries view
shown as one panel with columns re-arranged to show the important information for current/new enquiries and
the estimate being worked on open in another panel.

Viewing and Changing the Quotation Letter in MIS Console
When the estimate has been generated from the Estimating application, and based on permissions you can not
only view the quotation letter via MIS Console, but you may be able to re-price the estimate and amend the
quotation design.
There are two methods for viewing the quotation letter in MIS Console.
•

Sales Enquiries

•

Estimating

You can access the Estimate via Sales Enquiries, from either the Pending or Complete view.
The Est No field displays the Estimate number of enquiry and the background color allows a visual display of the
current status of the enquiry as follows:
Red: Enquiry has not been converted to an estimate
Amber: Enquiry has been converted to an estimate but is still in progress
Green: Enquiry has been converted to an estimate and a quotation has been produced
Click Est No. to open the Quote List window.

To access the Estimate via Estimating, click Quotes. The Quote List window will open.

Viewing the Quotation Letter
1.

From the Quote List window, click Version.
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2.

The Document Viewer window will open.

3.

Click Printer Friendly Page or Email to print or email the quotation letter from this window.

4.

From the Document Viewer window you can also Reprice the quotation, change the quotation design or
select a different template to view the document, by selecting the appropriate option from the toolbar.

Re-pricing a quotation letter
One of the really beneficial areas for users in MIS Console, from the Quote List window, is the ability to re-price
the quotation online, re-generate the quotation letter and re-send to the client.
This task can be performed either for a quotation letter generated in Estimating or from Quick Pricer.
Re-pricing the estimate
1.

Open the Quote List window. Select the Version to wish to review.
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2.

Click Reprice. The Reprice Quote window will open. This includes the pricing panel on the left hand
side and either the quotation letter or workings document (dependent on which template has been
selected) on the right.

3.

Based on the Reprice profile associated to the Profile Group that you belong to, the options available
within the left hand side of the page may be different to those included above. There are three main
columns in the Reprice panel, Base Price, New price, (+/-)%.
The Base Price is the current pricing levels split down across the different categories within the estimate
such as Pre Press, Paper, Packing, Press etc. The Base Price is fixed and cannot be adjusted in
anyway, its purpose is as a reference point for any price changes that may now be made.
Note

The Base Price is, however, controlled by application setting id 16 for MIS Console.

4.

Enter the new value into New Price. At the point of entering a new price, the application will again
review your repricing permissions and determine if the increase/decrease in price falls within your
repricing profile permissions. If the value exceeds the parameters, the new price will not be committed
and will highlight in red to advise you that it is not an allowed value. When this happens, you will need to
follow your organization’s internal procedures for re-pricing.

5.

When you have completed entering the new pricing levels, click Save. This will re-generate the
quotation letter so that the changes are available to send to the client.
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In the example below, the Total Sales value has been adjusted from £45,078.11 to £46,000. The
change in price is then committed by saving the changes.

The pricing can be changed as many times as is required and upon committing the change, the quote
letter will re-generate.
6.

You can change the width of the pricing and quotation panels within the window. Click and drag the
center divider to adjust the width.
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Changing the design of a quotation letter
Open the Quote List window. Select the Version to wish to review.

1.

Click Design. The Design Quote window will open.

2.

You can change the content of the quotation based on the options available on the left hand side of the
window. Enter new text within the Details area of the window. Scroll down and additional options are
available. The design change options are fixed and cannot be adjusted to match the template format so
this area may not work for all quotation formats.
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3.

These additional options allow you to change the financial layout of the quotation in the same manner
as the Estimating application.

4.

When you have made your changes, click Save or Save To All Versions, if the quotation is part of a
multi-version quotation. A new quotation letter will generate and open on the right hand side of the
window. This can subsequently be printed or emailed etc., as per the usual process.

Attaching a document to the quotation letter
Open the Quote List window. Select the Version to wish to attach a document to.

1.

Click Attach. A new window will open allowing you to attach any documentation and will also include
any documentation already attached to the enquiry.

Creating an order
If you wish to create an order for the estimate, click Create Order. Further details are available in the Order
Management 5.4 User Guide.

Changes to a Multi Version Quotation
If multiple estimate versions were created for the enquiry you have the ability to change the multi-version
selection, or it may be, that whilst the estimate had multiple versions, a multi-version quotation was not
generated.
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If the quotation letter was generated as a multi-version quotation, when you open the Quote List the Multi field
will already be selected.

Select one of the estimate versions and the Multi button on the toolbar becomes available.

Click Multi and a new window will open enabling you to remove existing versions from the multi-version
quotation.

For example, the customer may now decide that they want to proceed with the 32pp and require this to be
produced as a single version quotation. Clear the check boxes for the versions no longer required.

The quotation can then be re-generated as a single version.
Similarly, versions can be added back in to make it a multi-version quotation again.
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Select an enquiry that has a minimum of two estimate versions. You will note that whilst the Multi check box is
not selected, the Multi button on the toolbar is available.

Click Multi from the toolbar. The following window will open.

Select the versions that you now want to include in the multi-version quotation and click Submit. The above
window will close and you will be directed back to the Quote List window. Click Version and now the quotation
will include the multiple versions.
If a multi-version quotation letter has been generated, within the Reprice screen you can also amend the pricing
for each version.

Select the appropriate version from the toolbar to toggle between the versions.
Within the Design mode, you can also amend and save each version design, or choose to update all versions.

Click Save to save the changes for the individual version (but still be part of a multi-version quotation letter), or
click Save For All Versions if you wish the changes to be applied to all versions.
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Quick Pricer
Introduction
Quick Pricer provides the ability to calculate an instant price based on your Estimating standards. The price can
then be generated into a formal quotation that can be forwarded on to your client.
There are two types of Quick Pricer quotation:
•

Commercial

•

Contract

Commercial
Quick Price Commercial needs additional configuration. (For further details see the System Admin for Estimating
5.4 User Guide for details of the set up.)
You create a Quick Pricer quotation by creating a new enquiry in MIS Console. For further details see Creating a
Sales Enquiry earlier in this guide.
Creating a Commercial Quick Pricer Estimate and Quotation
1.

Click new enquiry.

2.

The Commercial Enquiry window will open. If many templates are present, the scroll bar at the bottom
can be used to move left and right through the selections.
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3.

Select the chosen product format.

4.

Select a product style from the available options. The options available are entered in Estimating
Maintenance > Miscellaneous > Finishing Styles > Product Template > Product Styles.

5.

In addition to the template option selection is a site selection. This will default to your user profile site
location. However, it can be changed if required.

6.

Select Limit routing to site, if you only want pricing to be calculated based on the resources located at
the site location entered. Clear Price from contract check box if selected by default. If application
Setting id 19 for MIS Console is entered as 1 (On), then you will only be able to use resources located
at the Site entered.

7.

Click Continue.

8.

The design and layout of the enquiry forms below are bespoke and may not match what you see in your
system. For further details on how to configure the template design see the System Admin for
Estimating 5.4 User Guide and how they can be manipulated to suit your organization.

9.

Enter any changes from the default values already present, for example, quantity, trim size, pagination,
ink, paper etc.

10. Enter any packing, delivery or ancillary requirements and include any notes as required.
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11. Click Quick Price from the toolbar.

12. The application will work through all possible routes for producing the product and after a few seconds
will display the cheapest available total price on screen. At any point, you can change the specification
of the enquiry, for example, change the size, paper, pagination etc., and then click Quick Price to
calculate and offer a new price.

13. If multiple quantities have been entered, after calculation has completed, the details for each quantity
will be displayed as shown below. The panel is optimized for displaying up to three quantities and price.

14. Click Show All to view prices for all quantities.
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15. If no pricing is displayed, this could be due to a variety of reasons. It may be that the enquiry
specification you have entered is not available for quoting using Quick Pricer, or that the content of the
enquiry does not fall within the parameters configured in your system. On these occasions, click Submit
to send the enquiry request through to the Estimating team for review and calculation in the Estimating
application.
16. If the Quick Price estimate is acceptable, and you want to generate a formal quotation letter click
Quote.

17. You will not be able to continue with the production of the quotation if you have not entered a title for the
enquiry. The application will inform you of the missing data.

18. Enter the Title and click Quote.

19. Enter the Company and Contact. If there is more than one salesperson linked to the contact you will
need to select the Salesperson. Select the Style Sheet to determine the format of the quotation letter.
If you need to enter any additional information, then you can enter this in the Further Information field.

20. Click Quote. This will start the process of generating the document on screen.
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21. The Document Viewer window will open.

22. Even though a Style Sheet had previously been selected, it can still be changed and a different
template selected from the toolbar. Options can also be added allow the cost and prices calculated in
the estimate to be output on you own internal workings documents.

23. Click Reprice or Design to amend the pricing or text content as required. This is the same process as
detailed in the chapter Viewing and Changing the Quotation Letter in MIS Console earlier in this guide.
24. To email the quotation letter, click Email.
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25. A new window will open with the email address of the contact populated as well as the subject title and
the Quote attachment.

26. The To address field will default to the email address for the contact entered in the enquiry and their
email address as entered in Company Management. The value entered in application setting id 44 for
Estimating will populate the Subject by default. The value entered in application setting id 13 for
Estimating will populate the From field by default. You can change these values or add to them as
required within this window.
You can enter your own personal message to the recipient in the Message field. Click Send for the
email to be processed and sent to your recipient.
It is possible to customize email templates per language and per site. For this to be available, you will
need to install and configure email templates so that when the appropriate template is selected, the
application will use this template to populate the HTML format of the email to be sent.
Note

The price generated is based on the actual Estimating configuration data. Once the quotation document
is generated on screen, an Estimate record will be available within the Estimating application. This will
contain fully calculated prices and resource routes that can be amended or re-calculated from within
Estimating if required.

Fetch Document
If your documentation is generated directly to PDF, there may be occasions when it will not open, for example, if
many users are also trying to generate PDF based documents at the same time. There is a slightly delay whilst
PDF files are created so if there is a queue for documents being produced, the application can occasionally
return a message informing you that the document cannot be display after a period. If this occurs, click Fetch
Document to allow you to restart the process of generating the document without having to restart the Quick
Pricer or online quote generation process.

Submit to Estimating for review
Even if you have chosen to calculate a Quick Pricer estimate, to get an idea of pricing for the specification of the
enquiry, you can still submit the enquiry to the Estimating team for them to calculate. Follow the steps detailed
above to submit the enquiry to Estimating.
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Contract
Using a similar process to the Commercial Quick Pricer there is also the opportunity to create a Contract Quick
Pricer estimate.
Creating a Contract Quick Pricer Estimate and Quotation
1.

Click new enquiry.

2.

The Commercial Enquiry window will open. If many templates are present, the scroll bar at the bottom
can be used to move left and right through the selections.

3.

Select the chosen product format.

4.

Select a product style from the available options. The options available are entered in Estimating
Maintenance > Miscellaneous > Finishing Styles > Product Template > Product Styles.

5.

In addition to the template option selection is a site selection. This will default to your user profile site
location. However, it can be changed if required.

6.

Select Limit routing to site, if you only want pricing to be calculated based on the resources located at
the site location entered. If application Setting id 19 for MIS Console is entered as 1 (On), then you will
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only be able to use resources located at the Site entered.
7.

Select Price from contract check box if it isn’t already selected by default.

8.

Click Continue.

9.

You will now have to make a selection regarding, company, contract and title.
Field Name

Description

Show Standard
Contracts

If selected, you have the option to select from those contracts entered
as Standard.

Show Company
Contracts

Enables you to select a customer who has a contract entered.

List of Contracts

Based on the parameters of the Enquiry Template chosen, the possible
contract title options for selection will be available.

Thumbnail of contract
title

Enables you to select the contract title upon which the enquiry is to be
made.

10. If the pricing is specific to a particular company, then you need to clear the Show Standard Contracts
check box.
11. Enter the Company name if it is not already entered. The contracts that are available for that company
will appear on the left hand side and the titles for each of the contracts will appear on the right.

Contracts for the
company entered
Titles available for the
contract selected

12. Select the Contract and then the Title for the Contract you wish to base the pricing on.
Note

The finishing style of the chosen title must match the main style of the RFE template/BOR. If
not then a message will be displayed warning the user the title style does not match and that a
matching title must be chosen.

13. Upon choosing a valid title a check will be made to ensure all of the BOR finishing steps are covered in
the contract. If not a message will be displayed warning you that not all of the finishing steps exist in the
contract and that this must be resolved before the contract can be used.
Note

A warning message is to be displayed if the contract has expired. BoR Entries must exist in the
contract title.

14. The design and layout of the enquiry forms below are bespoke and may not match what you see in your
system. For further details on how to configure the template design see the System Admin for
Estimating 5.4 User Guide and how they can be manipulated to suit your organization.
15. For every component identified in the supporting BOR the system presents the selection window for you
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to match the contract print entries.
16. To open the component pagination selection window, click No. Pages.

17. In the example below the Cover component was selected.

Field Name
Include

Description
Select the required cover option. One option must be chosen but only one option
can be selected.

Description

This is the description of the component as entered in the contract.

pp

This is the pagination of the component as entered in the contract.

Setup/Schedule

This is the setup or schedule price of the component as entered in the contract.

Add’l set up

This is the additional set up price of the component as entered in the contract.

‘000/Run-on

This is the price per ‘000 or Run-On price of the component as entered in the
contract.

18. Repeat the process for the Text (Body) component and any other remaining components.
19. A window with the list of contract text print entries is opened so that you can choose the required option
or combination of options. The number of text entries can be mixed and matched to form the required
pagination. The chosen entries will control the pricing of the quotation.

20. The chosen pagination does not have to match the BOR template.
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21. If no contract text print entries exist then a message is displayed explaining the Enquiry BOR cannot be
matched and the enquiry input is cancelled. If this is true then you will be returned to the Enquiry
Selection form.
22. The pricing columns displayed are dependant on whether the chosen title is priced as a MR/’000 or
Schedule/Run-On. If MR/’000 then the Setup and per ‘000 values are shown. If Schedule/Run-On then
the Schedule and Run-On values are shown. If the title is flagged as Book Price then no values are
shown.
23. Enter the number of each text entry to be included to make up the required text pagination. For
example, if the component pagination is 96, then you may choose to can enter 3 in the No Of field for
the 32pp line entry.
24. As the No Of options are entered the overall pagination is shown at the bottom of the screen.
25. Enter any packing, delivery or ancillary requirements and include any notes as required.
26. To ensure a contract price can be calculated, a number of the options available in the enquiry form must
be either restricted to matching contract options or disabled to stop an invalid choice being made.
27. The options affected are as follows:
Field Name
Finishing
Style
Preferred Site

Depth/Width
Delivery Date

Description
The finishing style must equal the style of the chosen title and cannot be changed.
If Limit Routing to Preferred Site is entered against the enquiry selection window
then when calculating the Quick Price or Quote value press and finishing routing are
limited to the chosen preferred site.
The size is set as the size entered against the chosen title.
Caution should be exercised if the delivery date is after the expiry date on the
contract.
A warning message window is opened, advising you that the contract has expired.

28. All other header fields remain unaffected as follows:

Field Name
Pages
Supplied
Depth/Width
Define Pre Press
Cover

Description
Both the cover and text pagination values are unavailable and will be set based on
the pagination options chosen.
The Supplied check box is entered based on the relating BOR template.
This is the size as entered against the chosen contract title.
The list of options available is limited based on the pre-press options entered within
the contract.
This check box will be selected based on the relating BOR template.

Fold

This will be set according to the chosen contract print components.

Finishing Style

This will be set according to the chosen contract print components.
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Press Extras
Version Details
Ink

The list of options available to you is limited to the press extra options entered
within the contract.
This will only be available if plate change options have been entered in the selected
contract.
The options available to you are limited to the ink options entered within the
contract.

Paper Grade

The options available to you are limited to the paper grade options entered within
the contract.

Paper Brand

The list of options available to you is limited to the paper brand options for the
chosen grade entered within the contract.

Paper GSM
Paper Supplied

Note

The list of options available to you is limited to the paper GSM range for the chosen
grade/brand as entered within the contract.
This will be set according to the chosen print component.

Custom paper options is not permitted for contract quotes.

29. When you have completed your entries, click Quick Price from the toolbar.
30. The application will work through all possible routes for producing the product and after a few seconds
will display the cheapest available total price on screen. At any point, you can change the specification
of the enquiry, for example, change the size, paper, pagination etc., and then click Quick Price to
calculate and offer a new price.
Note

If, initially, the BOR and Contract finishing matches but upon calculation the finishing is
invalidated then no Quick Price estimate can be calculated. It will be up to the administrator to
ensure BoR/Contract options are covered.

31. If multiple quantities have been entered, after calculation has completed, the details for each quantity
will be displayed as shown below. The panel is optimized for displaying up to three quantities and price.
32. Click Show All to view prices for all quantities.
33. If no pricing is displayed, this could be due to a variety of reasons. It may be that the enquiry
specification you have entered is not available for quoting using Quick Pricer, or that the content of the
enquiry does not fall within the parameters configured in your system. On these occasions, click Submit
to send the enquiry request through to the Estimating team for review and calculation in the Estimating
application.
34. If the Quick Price estimate is acceptable, and you want to generate a formal quotation letter click
Quote.

35. By default the Contract Title name be entered, however you can change this as required, but if you
leave this blank, you will not be able to proceed to the quotation window.
36. Upon submission or quoting of the enquiry the customer and contact fields will be populated to the
values entered in the Contract Title and are unavailable for change.
37. If the contract is entered as a standard contract (in other words, the pricing is relevant for any company
record) then the customer and contact entries are not automatically populated and you will need to
enter them in the usual manner. If the Contact has more than one salesperson linked to it, as entered in
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Company Management you may need to select the appropriate salesperson.
38. Click Quote. This will start the process of generating the document on screen.
39. The Document Viewer window will open.
40. The remaining process and options are the same as for a Commercial Quick Pricer estimate but for
reference are included here.
41. Even though a Style Sheet had previously been selected, it can still be changed and a different
template selected from the toolbar. Options can also be added allow the cost and prices calculated in
the estimate to be output on you own internal workings documents.

42. Click Design to amend the pricing or text content as required. This is the same process as detailed in
the chapter Viewing and Changing the Quotation Letter in MIS Console earlier in this guide.
Note

You cannot re-price the quotation that has been created from a contract.

43. To email the quotation letter, click Email.

44. A new window will open with the email address of the contact populated as well as the subject title and
the Quote attachment.

45. The To address field will default to the email address for the contact entered in the enquiry and their
email address as entered in Company Management. The value entered in application setting id 44 for
Estimating will populate the Subject by default. The value entered in application setting id 13 for
Estimating will populate the From field by default. You can change these values or add to them as
required within this window.
You can enter your own personal message to the recipient in the Message field. Click Send for the
email to be processed and sent to your recipient.
It is possible to customize email templates per language and per site. For this to be available, you will
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need to install and configure email templates so that when the appropriate template is selected, the
application will use this template to populate the HTML format of the email to be sent.
Note

The price generated is based on the values entered in the Contract. Once the quotation document is
generated on screen, an Estimate record will be available within the Estimating application. This will
contain fully calculated prices and resource routes that can be amended or re-calculated from within
Estimating if required. If a discount percentage has been entered in the company record selected, then
the discount will be included in the calculation in the normal manner after the contract price has been
calculated.

Revising a Quick Price Estimate in MIS Console
If you wish to revise an enquiry that was originally created and priced using the Quick Pricer module, click
Revise from the toolbar and the Enquiry template will open for you to make the necessary changes before
proceeding to calculate the enquiry. The application will automatically assign the Revision number as
appropriate.

Sales Commission
Sales Commission is a licensed module and is used in conjunction with Application Setting 110 for Estimating
and provides the ability to define commission values for sales persons, agencies etc.
The module allows for multiple commission profiles to be entered that determine how a sales person or agency’s
commission is calculated. Numerous options are available.
•

You can enter if the value is a fixed amount.

•

You can enter if it’s variable and on what value within the quote/order the amount is calculated.

•

Options to calculate the commission based on Sales Value, Added Value, Contribution and Profit are all
possible within the module.

Further details on how to configure Sales Commission see the System Admin for Estimating 5.4 User Guide.
If a commission profile has been entered against a sales person and an estimate is created for them, you have
the ability to review the commission information from the Reprice Estimate window. The information is quantity
specific so that the commission can be reviewed on a quantity-by-quantity basis.
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Click Commission to open the Review Commission window. Using the Commission Profile assigned to the
sales person, the values that the sales person will earn are displayed in the Total Comm fields.
Essentially, the windows breaks down the commission in to the same elements entered against the commission
profile along with indicators for the cost, price, sales value, commission % and fixed rate commission value for
each area.
The majority of fields are unavailable for editing. However, you can change the Commission % and Fixed Value
fields to influence the amount of commission that the salesperson will earn.
Agency Commission can also be entered against a company record that will then automatically be included in
any quotation raised for the company.
Where an agency commission profile is entered against a company record, within the Reprice Estimate window,
the Agency button will become available. Click Agency to open the Review Commission window as detailed
above.

Note

Salesperson Commission and Agency Commission can be used together in the same estimate.

Calculations
Press Calculation Process
The following process and examples are design to help understand how the estimating press calculation engine
works based on the product specification and configuration data entered.

Route Generation
This routine takes the print component specification and using the Site and Press configuration data determines
which presses are capable of producing the product. For each valid configuration found the application writes
out a route.
For every valid route written the number of routes generated will be incremented.
In this determination the following calculations/filters are undertaken:
Step
Step 1
RSB

Process
Check pagination against Reasonable Section Breakdown (RSB).
If an RSB option is found then each RSB element will be processed. All valid RSB options
are processed.
Example a : 16pp may have RSB options of 1 x 16pp, 2 x 8pp and 4 x 4pp.
Example b: 56pp may have options of 1 x 56pp, 1 x32pp + 1 x 24pp and 2 x 28pp.
If no RSB options found then the component cannot be calculated and the process ends.
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Step
Step 2 Press and
Configuration

Process
For each RSB element the Press Configurations are filtered and extracted. The filters
applied are:
For Press
•
Press is Live.
•

Press has required number of press units to support the number of colors.

For Press Configuration
•
Configuration is Live.
•

Pagination match .

•

Finishing Style match.

•

Product Depth and Width (Open sheet size if specified for sheet work) are
within range.

•

Product weight or calliper (based on application setting) are within range.

•

Total of colors are within range.

•

Bleed/Non Bleed.

•

Support of In-line press extras.

•

Quantity is greater than minimum quantity.

•

Only if all the checks are valid is a route written for calculation.

•

If no routes are written the process will end.
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Route Calculation
For every route generated, the Estimating application will attempt to calculate material, cost and price data.
During the process further checks are made to ensure the validity of the route. If it fails the route will be
removed.
For every valid route calculated the number of Routes Calculated will be incremented.
For demonstration purposes every calculation aspect of the following sample has been worked:
Scenario: 775,000 Saddle Stitch 16pp A4 (297 x 210) 6/6 (4 process/2 special) color book. 1 set of 16
Page Proofs and UV to Page 1.
Element

Process

Pre Press

Step 1

Calculation

Formula

Net Impressions and Extra Plate Sets
Net Impressions

Net Quantity / Number Up
775,000 / 1
775,000

Extra Plate Sets

Net Impressions / Maximum Plate Impressions
775,000 / 250,000 = 3 (rounded down to a whole number)

Entries from
Press tab
Entries from
Press
Configuration
Step 2

Pre Press Labour, Cost and Price
Pre Press Labor
Hours

Pagination * Imposition Time 1 Page
16 * 0.08 = 1.28 Hours

Pre Press Labor
Cost

Pre Press Labor Hours * Pre Press Cost Rate
1.28 * 85 = £108.80

Pre Press Labor
Price

Pre Press Labor Cost * (100 + Pre Press Mark Up %) / 100
108.80 * (100 + 5) / 100 = £114.24

Entries from Site
tab

Step 3

Plate Labor, Cost and Price
Number of
Plates

(Colors Front + Colors Back) * (1 + Extra Plate Sets)
(6 + 6) * (1 + 3) = 48 Plates

Plate Labor
Hours

Number of Plates * Plate Labour Hours
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Element

Process

Calculation

Formula
48 * 0.25 = 12 Hours

Plate Labor Cost

Plate Labor Hours * Plate Labor Cost
12 * 50 = £600

Plate Labor
Price

Plate Labour Cost * (100 + Pre Press Mark Up %) / 100
600 * (100 + 5) / 100 = £630

Entries from Site
tab

Entries from
Press tab
Step 4

Plate Cost and Price
Plate Cost

Number of Plates * Cost of Plate
48 * 25 = £1,200

Plate Price

Plate Cost * (100 + Plate Mark Up %) / 100
600 * (100 + 10) / 100 = £1,320

Entries from
Press tab

Step 5

Pre Press Proofs (if entered against the component). Repeated for each proof
entered.
Proof Labor
Cost

(Proof Make Ready Hours + (Proof Per Page Hours * Proof
Quantity * Proof No Pages)) * Proof Labour Cost Rate
(0 + (0.25 * 1 * 16)) * 45 = £180

Proof Labor
Price

Proof Labour Cost * (100 + Proof Mark Up %) / 100
180 * (100 + 20) / 100 = £216

Proof Material
Cost

Proof Quantity * Proof No Pages * Proof Material Cost
1 * 16 * 5 = £80

Proof Material
Price

Proof Material Cost * (100 + Proof Mark Up %) / 100
80 * (100 + 20) / 100 = £96

Entries from Pre
Press costs (for
the site)
Press

Step 1

Number of Printed Sheets and Make Ready Sheets
Net Sheets

Net Quantity / No Up
775,000 / 1 = 775,000
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Element

Process

Calculation
Binders Overs

Formula
Net Sheets / 100 * Binders Overs %
(775,000 / 1) / 100 * 2 = 15,500 Binders Overs Sheets

Running Waste

(Net Sheets + Binders Overs) /100 * (Running Waste % + Press
Extra Running Waste %)
(775,000 + 15,500) / 100 * (5 + 1) = 47,430 Running Waste
Sheets

MR Sheets

(MR Sheets + No Plates MR Sheets + (Follow On MR Sheets +
No Plates MR Sheets) * Extra Plate Sets) + Press Extra MR
Sheets
(500 + 500 + (250 + 500) * 3) + 1,000 = 4,250 MR Sheets

Paper Waste

(Net Sheets + Binders Overs + Running Waste + MR Sheets) /
100 * Paper Waste %
(775,000 + 15,500 + 47,430 + 4,250) / 100 * 0 = 0 Paper Waste
Sheets

Number of
Printed Sheets

Net Sheets + Binders Overs + Running Waste
If application setting id 39 for Estimating is entered as 1 (True),
when calculating the number of printed sheets the application will
calculate running waste based on NLT for a section. For example,
if 3 x 32pp sections are calculated for 50,000 copies, the running
waste can be calculated on a run of 150,000 instead of each 32pp
for 50,000 calculated individually.
775,000 + 15,500 + 47,430 = 837,930 Number of Printed Sheets

Entries from Site
Binders Overs

Entries from
Press tab

Entries from
Plate Set Up
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Element

Process

Calculation

Formula

Entries from
Press
Configuration

Entries from
Config Press
Running Waste
(Only used if selected against the Press Configuration. If not then
the basic running waste against the Press Header is used.)
Entries From
Press Extras

Step 2

Repeated for each press extra specified against the component or
automatically incurred against the configuration.

Make Ready
Hours
Basic Make
Ready Hours

Web 1 MR Hours + No Plates MR Hours + (Web 1 Follow On MR
Hours + No Plates MR Hours) * Extra Plate Sets
1 + 1.75 + (0.5 + 1.75) * 3 = 9.5 Hours

Process Wash
Up

No Process Colors * Process Unit Wash Up Hours
4 * 0.15 = 0.60 hours

Special Color
Wash Up (only if
special colors
entered)

(Number of Special Colors + (No of Units – 4 – Number of Special
Colors)) * Special Color MR Hours

(2 + (5 – 4 – 2)) * 0.5 = 0.5 hours
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Element

Process

Calculation
Process to
Special Color
Wash Up (Only
if special colors
specified)

Formula
(Number of Special Colors - (No of Units – 4)) * Process to Special
Unit Wash Up Hours

(2 – (5 – 4)) * 0.5 = 0.5 hours
Press Extra
Make Ready
Hours

Extra MR Hours + (Extra Follow On MR Hours * Extra Plate Sets)

1 + (0.50 * 3) = 2.5 hours
Total Make
Ready Hours

13.6 hours

Entries from
Press tab

Entries from
Plate Set Up
Entries from
Press Extras

Step 3

Repeated for each press extra specified against the component or
automatically incurred against the configuration.

Note

The Additional Web MR Hours and Additional Web
Follow On MR Hours will be incurred for each
additional web identified against the configuration.

Note

The Reel width over Extra MR will only be incurred if
a value is specified and the calculated web/sheet
width is over the defined value.

Run Hours
Number of
Press Passes /
Sheet Fed Only
(Not Perfecting)

ROUNDUP(No Colors Front / No Units) + ROUNDUP(No Colors
Back / No Units)

ROUNDUP(6 / 5) + ROUNDUP(6 / 5) = 2 + 2 = 4 Passes
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Element

Process

Calculation

Formula

Number of
Press Passes
(Perfecting
Press)

ROUNDUP(No Colors Front + No Colors Back/ No Units)

Press Speed
(graduated)

Number of Printed Sheets / Total of Graduated Hours
Speed Breaks

Speeds

< 5,000

5,000

<10,000

6,500

<50,000

8,500

>50,000

10,000

Impressions

Speed

Hours

5,000

5,000

1.00

5,000

6,500

0.77

40,000

8,500

4.71

787,930

10,000

78.79

Total Graduated
Hours
Sheets per Hour
Run Hours

85.27
837,930 / 85.27 = 9,827 sheets per hour

Graduate Hours * Number of press passes
85.27 * 4 = 341.08 hours
Note

For non graduated speed calculation the matching
line from the Press speed table is used.

Entries from
Press tab
Entries from
Press Speed

Step 4 Make Ready and Run Cost and Price
Make Ready
Cost

Total Make Ready Hours * Press Cost Rate
13.6 * 230 = £3,128

Make Ready
Price (Cost
Plus)

Make Ready Cost * (1 + Cost Make Up %)

3,128 * (1 + .10) = £3,440.80
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Element

Process

Calculation
Run Cost

Formula
Run Hours * Press Cost Rate
341.08 * 230 = £78,446.68

Run Price

Run Price * (1 + Cost Make Up %)
78,446.68 * (1 + .10) = £86,291.35
Note

For non cost plus the hours are multiplied by the
Press Sell Rate.

Note

If no rate entry is found for the press, the route will
fail and be deleted.

Note

Selection of the rate entry is based on the delivery
date of the enquiry.

Entries from
Press Rate

Step 5 Ink Quantity, Cost and Price
Ink coverage
square meter
(sq m) per book

((Page Depth + Head Trim + Foot Trim) * (Page Width + Foredge
Trim + Spine Trim (PB Only)) * (Pages Across Web * Pages Down
Web) * (Color on Front + Color on Back) * Ink Coverage) /
1,000,000
((297 + 4 + 4) * (210 + 7.5 + 0) * (4 * 2) *(1 + 1) * 45%) / 1,000,000
= 0.47763 sq m per book

Total Coverage
sq m

Ink Coverage sq m per Book * (Number of Printed Sheets + MR
Sheets)
0.47763 * (837,930 + 4,250) = 402,250.4334 sq m

Number of
kilograms

Total Coverage sq M / Consumption Rate
402,250.4334 / 3,250 = 123.77 Kilo’s

Ink Cost

Number of Kilo’s * Cost Per UOP
123.77 * 9 = £1,113.93

Ink Price

Ink Cost + MU%
£1,113.93 + 5% = £1,169.63

Entries from the
Site Trim Table

Note

The consumption rate used is dependant on the
paper type – Coated or Un-coated.

Note

The ink calculation process is repeated for every
ink specified – in this example the 4 process and 2
special colors.
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Element

Process

Calculation

Formula

Entries from
Press
Configuration

Entries from
Material

Step 6 Press Extra Materials (Only if entered, in this example UV varnish
UV Coverage
square meters
(sq m)

(Extra Depth * Extra Width) / 1,000,000

(297 * 210) / 1,000,000 = 0.06237 sq m per book
Total Coverage
sq m

UV Coverage sq m per Book * (Number of Printed Sheets + MR
Sheets)
0.06237 * (837,930 + 4,250) = 52,526.7666 sq m

Number of
kilograms

Total Coverage sq M / Consumption Rate
52,526.7666 / 2,500 = 21.01 kilos

UV Cost

Number of Kilo’s * Cost Per UOP
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Element

Process

Calculation

Formula
21.01 * 20 = £420.20

UV Price

UV Cost + MU%
£420.20 + 5% = £441.21

Entries from
Material

Step 7 Determine the sheet size.
Sheet Depth

((Page Depth + Head Trim + Foot Trim) * Pages Down Web) +
Gripper Trim
((297 + 4 + 4) * 2) + 10 = 620mm

Sheet Width

((Page Width + Foredge) * Pages Across Web) + Additional Trim
((210 + 7.5) * 4) + 0 = 870mm
Note

For web presses the sheet depth is check against
the Cut Off of the press. If the Cut-off is exceeded
then the route will fail.

Note

For all presses the sheet width is checked against
the press minimum and maximum web/sheet width.
If outside the parameters then the route will fail.

Sheet Size Web Sheet depth is set to the Cut-off.
Presses
Sheet Depth = 630mm
Sheet Size = 630mm * 870mm
Sheet Size
Sheet Fed
presses

Lookup the sheet size.

Next matching entry is 640 x 900 sheet.
Sheet Size = 640 x 900mm.
Note

If the sheet size is specified against the component
or configuration then this will be used irrespective of
whether the product fits or not.

Note

If the sheet size is not specified then the
application will lookup the sheet size within the Sheet
Stock Sizes table. If no entry is found then the route
will fail.

Step 8 Paper Weight, Sheets, Cost and Price (Non US)
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Element

Process

Calculation
Total Sheets

Formula
Number of Printed Sheets + Paper Waste + MR Sheets
837,930 + 0 + 4,250 = 842,180 Total Sheets

Total Weight
(kilograms)

((Sheet Depth * Sheets Width) / 1,000,000) * (Paper Weight /
1,000) * Total Sheets
((640 * 900) / 1,000,000) * (90 / 1,000) * 842,180 = 43,659 Kilo’s

Paper Cost

(Total Weight / 1,000) * Paper Cost Per Tonne
(43,659 / 1,000) * 600 = £26,195.40

Paper Price

(Total Weight / 1,000) * Paper Price Per Tonne
(43,659 / 1,000) * 630 = £27,505.17

Paper Weight, Cost and Price (US)
(Sheet Size 25” x 34” – on 60lb Book Stock (25” x 38”) – Cost $55 per cwt – Mark Up
5% - Price = Cost + Mark Up)
Total Weight
(lb’s)

(Sheet Width * Sheets Depth * Paper Weight * Total Sheets) / (500
* Basic Area)
(25 * 34 * 60 * 842,180) / (500 * 25 * 38) = 90,424 lb’s

Paper Cost

(Total Weight / 100) * Paper Cost Per CWT
(90,424 / 100) * 55 = $49,733.20

Paper Price

(Paper Cost + Mark Up%)
(43,733.20 + 5%) = $52,219.86

Entries from
Material Type
(US only)

Entries from
Material Item

Step 9 Total Cost, Sell, Margin and Added Value (AV)
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Element

Process

Calculation
Total Cost

Formula
Pre Press Labour Cost + Plate Labour Cost + Plate Cost + Proof
Labour Cost + Proof Material Cost + Make Ready Cost + Run Cost
+ Press Extra Material Cost + Ink Cost + Paper Cost
108.80 + 600.00 + 1,200.00 + 180.00 + 80.00 + 3,128 + 78,446.68
+ 417.63 + 5,501.65 + 26,195.17 = £115,857.93

Total Sell

Pre Press Labour Price + Plate Labour Price + Plate Price + Proof
Labour Price + Proof Material Price + Make Ready Price + Run
Price + Press Extra Material Price + Ink Price + Paper Price
114.24 + 630.00 + 1,320.00 + 216.00 + 96.00 + 3,440.80 +
86,291.35 + 438.51 + 6,033.89+ 27,504.92 = £126,085.72

Total Margin

Total Sell – Total Cost
126,085.72 – 115,857.93 = £10,227.79

Total Added
Value (AV)

Total Sell – Plate Cost – Proof Material Cost – Press Extra Material
Cost - Ink Cost – Paper Cost
126,085.72 – 1,200 – 80.00 – 417.63 - 5501.65 – 26,195.17 =
£92,691.27

Wide Format Calculation
The calculation process for Wide Format press types is divided into three separate steps; Press Time and Cost
Calculation, Paper Calculation and Ink Calculation.

Press Time and Cost Calculation
First the total area of print, in square meters, is calculated using the following formula:
(Open Depth x Open Width) /1,000,000) x (Quantity + Running Waste % + Running Waste Quantity)
Note

The printable area will include the product trims as entered for each finishing style.

Note

Quality speed factors will be applied by using Press Extra’s using standard Press Extras functionality.

Example:
Product Size: 594mm x 420mm
Trims: 3mm Head and Foot, 6mm Foredge and 6mm Spine edge
Open Size: 600mm x 426mm
Quantity 500
Running Waste % = 5%
Running Waste Quantity = 0
Mode = Standard
(600 x 426) /1,000,000) * (500 + 5% + 0) = 134.19 square meters of print.
The speed for the Wide Format press is referenced based on the mode of printing and square meters,
therefore, in this example the print rate will be 21 square meters per hour based on the mode of operation
(standard) and the total square area to print (134.19).
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Using these values the application will also ensure that any speed reductions or extra make ready time etc.,
that have been included as press extras are also included, plus any make ready time entered against the
press on the Press tab.
The speed calculation is as follows:
(Total Square Meters of Print / Square Meters Per Hour) + MR Time
(134.19 / 21) + 0 = 6.39 Hours
The press cost is then calculated by multiplying the time by the cost rate, (in this example £75 per hour):
Print Cost = Total Hours * Cost Rate
Print Cost = 6.39 * 75 = £479.25

Paper Calculation
If supported the both sheet fed and roll fed paper option will be calculated.
For roll fed the system will start by identifying wide format roll widths that have been entered in Estimating
Maintenance > Miscellaneous > Stock Webs. For sheet fed the system will work in the same manner as for a
Sheet Fed press.
In this example the roll stock is configured as follows:
Roll
Sizes

Roll Length

Sqr M Per Roll

Cost per Sqr M (£)

Cost per Roll (£)

500

100,000

50

0.160

8.00

1,000

100000

100

0.155

15.50

1,600

100000

160

0.150

24.00

2,500

100000

250

0.145

36.25

The application will orientate the product across each roll width to calculate, based on the product open size, the
number up. Then based on the number of products to be printed, the application will calculate the length of roll
required, how much paper waste will be incurred and the cost of the paper.
Portrait:
Roll

No Up

500

1

315.0

157.5

14.80

25.200

1,000

2

157.8

157.8

14.96

24.459

168.0

20.13

25.200

1,600

3

Meters Required

105.0

Total Paper Sq M

Total Waste (%)

Paper Cost
(£)
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Roll
2,500

No Up

Meters Required

5

Total Paper Sq M

63.0

157.5

Total Waste (%)
14.80

Paper Cost
(£)
22.838

Landscape:
Roll

No Up

500

0

1,000

Meters Required

Total Paper Sq M

223.650

Paper Cost
(£)

-

-

-

223.650

40.00

34.666
26.889
20.384

-

1

Total Waste (%)

1,600

2

112.038

179.261

25.14

2,500

4

56.232

140.580

4.55

The calculation is as follows:
Example 2500mm roll based on the portrait orientation (open width across the roll):
No Up = (Roll Width / Open Width or Open Depth) rounded down to the nearest whole number.
No Up = (2500 / 426) = 5.869, when rounded down = 5.
Meters Required = (Gross Qty / No Up * Open Depth or Open Width)
Meters Required = (525 / 5 * 600) / 1000 = 63.000 Meters.
Total Paper Sqr Mtr = (Roll Width * Meters Required)
Total Paper Sqr Mtr = (2.500 * 63.000) = 157.500 Sqr Mtrs
Total Waste % = 1 – (Total Square Meters of Print / Total Paper Square Meters) * 100
Total Waste % = 1 – (134.190 / 157.500) * 100 = 14.8%
Paper Cost = (Total Paper Square Meters * Cost Per Square Meter)
Paper Cost = (157.500 * 0.145) = £22.8375

Ink Calculation
Ink will be calculated in the standard manner based on total print area and % coverage.
In this example the ink cost has been entered as follows:
Color

Cost Per Litre (£)

Coverage Per Litre (Sq
M)

Cost per Sq M
(£)

C

25.00

500

0.0500

M

25.00

500

0.0500

Y

25.00

500

0.0500

K

17.50

625

0.0280

The calculation is: Ink Cost Per Color = Total Square Meters of Print * % Coverage * Cost Per Square Meter
Therefore total ink cost is calculated as follows:
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Color

Total Square Meters

Coverage (%)

Cost (£)

C

134.19

50

3.35

M

134.19

50

3.35

Y

134.19

50

3.35

K

134.19

50

1.88

Therefore the Total Cost = £11.94.

Post Press (Finishing) Calculation Process
The following process and examples are designed to help understand how the estimating post press calculation
process works based on the product specification and configuration data entered.
The post press calculation process goes through 5 stages:
•

Press component re-calculation to enable the correct number of binders overs to be accounted for.

•

Finishing operations.

•

Packing.

•

Delivery.

•

Ancillary items.

Press Component Re-Calculation
Now that the final product has been defined the system is now able to determine the number of press
components included. This number is used to refer back to the Site Binders Overs to obtain the % to apply when
re-calculating the routes.
When re-calculating the routes the same rules are applied as described in the Press Calculation Process.

Finishing Route Generation
This routine works through each specified finishing operation and using the Site and Finishing configuration data
determines which finishing resources are capable of producing the product. For each valid configuration
calculated the application writes out a route.
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Step

Process

Step 1 Resource is Live.
Binding Has the resource the required number hoppers (feeds) to support the number of assigned
Resource components and additional operations.
Can support the product dimension.
Can support the product weight.
Operation quantity is greater than or equal to the minimum quantity.

Modes and The finishing style matches
Speeds Can support the product dimension.
Can support the product weight.
Speed entry exists for the required number of hoppers.
Modes:

Speeds:
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Step

Process

Folding The finishing style is folding.
Supports the fold type.
Can support the product dimension.
Can support the product weight.
Can support the fold number up.
Can support the number of folds.
Folder:

Configurations:

Cutting The finishing style is folding.
Supports the required number of cuts.

Route Calculation
For every route selected estimating will attempt to calculate cost and price data.
During the process further checks are made to ensure the validity of the route. If it fails the route will be
removed.
For demonstration purposes every calculation aspect of the following sample has been worked:
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Scenario: 775,000 Saddle Stitch 16pp A4 (297 x 210) 6/6 (4 process/2 special) color books. 1 set of 16
Page Proofs and UV to Page 1. Here folding and saddle stitching have been applied to the 16pp section
Element

Process

Folding

Step 1

Calculation

Formula

MR Hours and Run Hours
Gross
Impressions

Net Quantity + (Net Quantity * Site Binders Overs %)
775,000 + (775,000 * 2%) = 790,500

MR Hours

2 Hours

Run Hours

Gross Impressions / Cycle Speed
790,500 / 4,500 = 175.67 Hours

Entries from
Site Binders
Overs

Entries from
Folder Speed

Step 2

MR Cost and Price
MR Cost

MR Hours * Cost Rate
2 * £70.00 = £140.00

MR Price

MR Hours * Price
2 * £90.00 = £180.00

Step 3

Run Cost & Price
Run Cost

Run Hours * Cost Rate
175.67 * £70.00 = £12,296.90

Run Price

Run Hours * Price
175.67 * £90.00 = £15,810.30

Entries from
Folder
Resource Rates

Saddle
Stitching

If no rate entry is found for the press, the route will fail and be
deleted.

Step 1 MR Hours and Run Hours
Gross
Impressions

Net Quantity + (Net Quantity * Site Binders Overs %)
775,000 + (775,000 * 2%) = 790,500
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Element

Process

Calculation

Formula

MR Hours

2 Hours

Run Hours

Gross Impressions / Cycle Speed
790,500 / 10,000 = 79.05 Hours

Entries from
Site Binding
Overs

Entries from
Bindery Modes

Entries from
Bindery Speeds

Step 2 MR Cost and Price
MR Cost

MR Hours * Cost Rate
2 * £120.00 = £240.00

MR Price

MR Hours * Price
2 * £180.00 = £360.00

Step 3 Run Cost and Price
Run Cost

Run Hours * Cost Rate
79.05 * £120.00 = £9,486.00

Run Price

Run Hours * Price
79.05 * £180.00 = £14,229.00

Entries from
Resource Rates
If no rate entry is found for the press, the route will fail and be
deleted.

Advanced Guillotine Calculation
Example – 8pp printing 4up on SRA1 paper (640 x 900mm), 40,000 copies
Process
Sheet Size

Calculation
=

640 x 900 = 576,000 sq mm

Source
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Process

Calculation

Source

Caliper

=

0.0038

(from
Materials)

Paper weight

=

90gsm

(from
Materials)

Sheets

=

(40,000 / 4up) + 150 MR sheets = 10,150

Max lift height

=

4

Sheets per lift

=

4 / 0.0038 = 1,053

Total number of lifts

=

10,150 / 1,053 = 10

Lifts per hour

=

30

Time

=

10 / 30 = 0.33 hours

Number of cuts per
sheet

=

2

Total cuts

=

10 piles x 2 = 20 cuts

Cuts per hour

=

40

Time

=

20 / 40 = 0.5 hours

Total Time

=

lift time + cut time + Make ready time

=

0.33 + 0.5 + 0.5 = 1.33 hours

(from Lift
Height)

(from
Resource tab)
(from Cutting
Defaults)
(from
Advanced
Speed)
(MR from
Make Ready)

Advanced Folding Calculation
In the following example, a 4pp, 297mm x 210mm portrait, with a section fold, on 130gsm paper, 0.13 caliper,
printed sheetfed 2up on a 640mm x 900mm sheet size, the Fold Catalog has been entered as 1 fold and 0 turns.
When the estimate version is created
Process

Calculation

Advanced
Folding
Parameters

Folding speed
reduction

(Number of folds * Speed Per Plate / 100) + If No of Turns > 0,then number of turns *
Speed Per Turn / 100,0) = 5%
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Process

Calculation

Millimeters per
minute

In-Feed speed x speed reduction (larger of caliper speed reduction or folding speed
reduction)
203200 x 5% = 193040

Pieces per hour

Millimeters per hour / (Feed Length + Gap)/ Fold No Up) * 60
193040 / 475 * 60 = 24384

Make Ready
Time

(MR First plate + MR additional plates + MR first turn + MR additional turns)
(1 / 60) * 3 = 0.05 hours

Run Time

Quantity / Pieces per Hour = 100,000 / = 4.10 Hours

Advanced Bindery Assistants Calculation
The following scenario is provided to explain the calculation method when the advanced assistants check box is
selected for a resource.
A4 Perfect Bound book consisting of a 4pp Cover + 480pp Text (on 2 different stocks) + 3 Loose inserts.
250,000 copies.
4pp Cover is printed sheetfed and is delivered to the binder as a flat section, on 130gsm (0.13 caliper).
320pp Text (1) is printed web. Produced as 5 x 64pp, 1 x 32pp and 1 x 8pp, on 60gsm (0.081 caliper).
120pp Text (2) is printed web. Produced as 3 x 32pp and 1 x 24pp, on 70gsm (0.095 caliper).
The Inserts are entered as follows:
First 100,000 copies contain 3 Inserts.
Second 100,000 copies contain 2 Inserts.
Third 50,000 copies contain 1 Insert.
Each profile is calculated in-turn, as the diminishing number of inserts running will affect the number of assistants
required.
The binding requirement is as follows:
1 x Cover Feeder, 11x Log/Pile fed hoppers, 3 x insert hoppers for 100,000 copies, 2 x insert hoppers for
100,000 copies, 1 x insert hopper for 50,000 copies.
Base Number of assistants entered for the resource is 2.
The resource speed is entered as follows:
13 Hoppers

-

6,000 per hour

14 Hoppers

-

5,750 per hour

15 Hoppers

-

5,500 per hour

The calculation process is split down in to the following steps:
Step 1
Calculate the average log/pile size and number of log hoppers and bind-in hoppers.
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The calculation is based on a log length of 1200mm (application setting id 129) and web delivered section spine
width.
Sheeted sections for calculation purposes are treated as a bind-ins as the hopper loading process is the same as
an insert.
Section

Bind-Ins

Process

GSM

Caliper

4pp

Sheet

130

0.15

-

64pp

Web

60

0.081

2.592

462

64pp

Web

60

0.081

2.592

462

64pp

Web

60

0.081

2.592

462

64pp

Web

60

0.081

2.592

462

64pp

Web

60

0.081

2.592

462

32pp

Web

60

0.081

1.296

925

8pp

Web

60

0.081

0.324

3703

32pp

Web

70

0.95

1.520

789

32pp

Web

70

0.95

1.520

789

32pp

Web

70

0.95

1.520

789

Web

70

0.95

1.140

1052

24pp

No
Hoppers

Spine

A

-

B

-

C

-

4

11

Average

Copy per Log

941

Note

The number of bind-in hoppers includes the sheeted sections.

Note

The Copy Per Log for each web section is calculated using the following formula:
Spine = (Section Pagination / 2) * Caliper
Copy Per Log = Log length / Spine.
Average = Sum of Copy Per log / No of Process Web Sections.

Step 2
Calculate the number of signatures per hour that an assistant can manage.
The calculation uses the value entered in application setting id 128, in this scenario 35, and average copy per
log.
Signatures Per Hour = Logs per hour * Average Copy Per Log
Signatures Per Hour = 35 * 941
Signatures Per Hour = 32,935
Step 3
Calculate the number of hoppers to be managed.
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The calculation is based on the Signature Per Hour divided by the speed of the resource. The resource speed
included in the calculation is based on the total number of hoppers required. Therefore, in this example when 3
inserts are included in the binding operation this equate to 15 hoppers and a speed of 5,500 copies per hour.
Hoppers to Handle = Signature Per Hour / Resource Speed
Hoppers to Handle = 32,936 / 5,500
Hoppers to Handle = 5.988
The Hoppers to Handle is re-calculated for each profile split caused by the diminishing number of inserts. For
example, when the number of inserts included in the binding operation changes from 3 to 2, the speed increases
to 5,750 and likewise when the number of inserts reduces to 1 the speed increases to 6,000.
Note

Any speed reduction factors based on quantity, pagination, paper grammage and additional operations
are applied in the normal manner before the speed is used in the calculation.

Step 4
Calculate the number of assistants required to handle the log/pile signatures.
In this scenario application setting id 124 has been entered as 6.
The calculation is based on the following comparison:
IF

Hoppers to handle is greater than the value entered in application setting id 124,

THEN

No of Logs Signatures / maximum logs per assistant (application setting id 124)

ELSE

No of Logs Signatures / Hoppers to Handle

In this case Hoppers to Handle is calculated as 5.988 and is therefore less than the value entered for maximum
number of logs per assistant
Therefore,
Log Assistants = No of Logs Signatures / Hoppers to Handle
Log Assistants = 11 / 5.988
Log Assistants = 1.83
The calculated Log Assistants is then rounded according to the value entered for application setting id 126, in
this example this has been entered as 0.2.
If the decimal of the calculated Log Assistants is less than or equal to the value entered in application setting id
126, rounding factor, then the number of Log Assistants is rounded down to the nearest whole number.
If the decimal of the calculated Log Assistants is greater than the rounding factor then the number of Log
Assistants is rounded up to the nearest whole number.
Therefore, in this example 1.83 is rounded up to 2, therefore the number of Log Assistants is 2.
Step 5
Calculate the number of assistants required to handle the bind-ins and sheeted sections.
In this scenario the value entered in application setting id 125 is 3.
The calculation is based on the number of bind-in and sheeted sections divided by the maximum bind-ins per
assistant value.
As each insert profile split is calculated the number of Bind-In Assistants may vary. The insert profile is as
follows:
First 100,000 copies contain 3 Inserts.
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Second 100,000 copies contain 2 Inserts.
Third 50,000 copies contain 1 Insert.
Therefore for 3 Inserts:
Bind-in Assistants = (No of Bind-Ins + No of Sheeted Sections) / maximum bind-ins per assistant
Bind-in Assistants = 4 / 3
Bind-in Assistants = 1.333
The calculated Bind-In Assistants is then rounded according to the value entered in application setting id 127, in
this scenario = 0.33.
If the decimal of the calculated Bind-In Assistants is less than or equal to the rounding factor then Bind-In
Assistants is rounded down to the nearest whole number.
If the decimal of the calculated Bind-In Assistants is greater than the rounding factor, then Bind-In Assistants is
rounded up to the nearest whole number.
Therefore, in this example 1.333 is rounded up to 2, therefore the number of Bind-In assistants is 2.
Therefore for 2 Inserts:
Bind-in Assistants = 3 / 3
Bind-in Assistants = 1 (rounded)
Therefore for 1 Insert:
Bind-in Assistants = 2 / 3
Bind-in Assistants = 1 (0.667 rounded)
Step 6
The final step is to calculate the total number of assistants required.
When 3 Inserts are included in the binding operation:
Total Assistants = Log Assistants + Bind-In Assistants + Base Assistants
Total Assistants = 2 + 2 + 2
Total Assistants = 6
When 2 and 2 Inserts are included in the binding operation:
Total Assistants = 2 + 1 + 2
Total Assistants = 5

Calculating Packing
There are two methods for entering and subsequently calculating packing within an estimate.
•
•

Standard
Advanced

Standard
Example scenario: 250,000 copies, 4pp cover on 130gsm + 96pp text on 70gsm, 297 x 210mm portrait. Packing
in A4 Cartons and Standard Pallets, Delivery to 1 address Leicester (from Leeds).
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Process

Calculation

Source

Weight of product
Weight of each
component

=

(Trim size / 1000) * grammage *
(pagination / 2)

Cover

(297 x 210 / 1000) * 130 * (4 / 2) =
16.2162 grams

Text

(297 x 210 / 1000) * 70 * (96 / 2) =
209.5632 grams

Weight of book
plus product

Weight of book + product weight uplift
%

(from Site tab)

16.2162 + 209.5632 * 5% = 237.07
grams
Pallets
Number of
copies per
pallet

=

Maximum weight of pallet / Product
Weight

(from Materials)

1000 / 0.237070 = 4,218
Packing
Quantities

=

4,000

Total number of
Pallets

=

Quantity / Copies per pack

=

250,000 / 4,000 = 62.5, rounded up to
full pallets = 63

Cost per UOP

=

£7.00

Cost of pallets

=

Number of pallets x Cost per pallets

Price of pallets

=

(from Materials)

63 x £7.00 = £441.00
Cost of packing * Mark Up %

(from Materials)

£441 * 5% = £463.05
Carton Packing
Number of
copies per pack

=

Maximum weight of pack / Product
Weight

(from Materials)

12.5 / 0.237070 = 52.7 copies
Packing
Quantities

=

50

Total number of
Packs

=

Quantity / Copies per pack

Cost per UOP

=

£0.25

Cost of packing

=

Number of packs * Cost per pack

250,000 / 50 = 5,000
(from Materials)

5,000 * £0.25 = £1,250.00
Price of
packing

=

Cost of packing * Mark Up %

(from Materials)
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Process

Calculation

Source

£1,250 * 5% = £1,312.50

Advanced
For details of calculations for Advanced Packing, see the Order Management 5.4 User Guide, Advanced Packing
chapter.

Calculating Delivery
There are two methods for entering and subsequently calculating delivery within an estimate.
•
•

Standard
Freight Rates

Standard
Example scenario: 250,000 copies, 4pp cover on 130gsm + 96pp text on 70gsm, 297 x 210mm portrait. Packing
in A4 Cartons and Standard Pallets, Delivery to 1 address Leicester (from Leeds).
Process

Calculation

Source

Weight of product
Weight of each
component

=

Cover

(Trim size / 1000) * grammage * (pagination /
2)
(297 x 210 / 1000) * 130 * (4 / 2) = 16.2162
grams

Text

(297 x 210 / 1000) * 70 * (96 / 2) = 209.5632
grams

Weight of book
plus product

Weight of book + Product Freight Uplift (%)

16.2162 + 209.5632 * 5% = 237.07 grams
Overall weight
of product

=

(Product weight / 1,000) * Net Quantity
0.23707 * 250,000 copies = 59,267 kilograms

Distance
between
locations

=

99 miles

Maximum
weight per load

=

25,000 kilograms

Number of
Loads

=

Overall weight of product / Maximum weight
per load
59,267 / 25,000 = 2.37, rounded up to full
wagon = 3

Cost for
distance range
and weight

=

£180

(from Application Settings)

252 l EFI Technique 5.4 | Estimating User Guide

Process

Calculation

Source

Cost for distance range x Number of Loads
£180 * 3 = £540
Delivery price

=

Cost * Mark Up %
£540 * 25% = £675

Freight Rates
Example scenario: 250,000 copies, 4pp cover on 130gsm + 96pp text on 70gsm, 297 x 210mm portrait. Packing
in A4 Cartons and Standard Pallets, Delivery to 1 address Leicester (from Leeds).
Process

Calculation

Weight of product
Weight of each
component

=

Cover

(Trim size / 1000) * grammage * (pagination /
2)
(297 x 210 / 1000) * 130 * (4 / 2) = 16.2162
grams

Text

(297 x 210 / 1000) * 70 * (96 / 2) = 209.5632
grams

Weight of book
plus product

Weight of book + Product Freight Uplift (%)

16.2162 + 209.5632 * 5% = 237.07 grams
Overall weight
of product

=

(Product weight / 1,000) * Net Quantity
0.23707 * 250,000 copies = 59,2675
kilograms = 59.2675 Tonnes

Freight Cost

(((Ship Weight/Drops)*Cost per tonne of 1
drop)*Drops) + Setup + (number of drops *
Drop Cost) * (1 + Fuel Levy)
(((59.2675/1) * 30) * + 50 + (1 * 40) * (1 +
0.02)
1,778.025 + 50 + 40 * 1.02 = £1,905.37

Freight Price

Freight Cost * Mark Up %
1905.37 * 10% = £2,095.91

Source

